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Preface

This guide describes how to install and configure Oracle Utilities Extractors and Schema, and 
Oracle Utilities Analytics Dashboards version 2.5.0, including:

• Audience

• Prerequisite Knowledge

• Related Documents

• Conventions

• Acronyms

Audience
This guide is intended for anyone interested in the process of installing, upgrading or configuring 
Oracle Utilities Extractors and Schema and Oracle Utilities Analytics Dashboards v2.5.0.

Prerequisite Knowledge
Oracle Utilities Extractors and Schema and Oracle Utilities Analytics Dashboards use several 
technologies. You should have knowledge of the following before configuring and administering 
Oracle Utilities Analytics for Oracle Utilities Extractors and Schema and Oracle Utilities Analytics 
Dashboards:

• Oracle Data Warehouse concepts:

http://docs.oracle.com/cd/E11882_01/server.112/e25554/toc.htm

• Oracle Warehouse Builder:

http://docs.oracle.com/cd/E11882_01/owb.112/e10581/toc.htm

• Oracle Data Integrator:

http://docs.oracle.com/cd/E21764_01/integrate.1111/e12641/overview.htm

• Oracle GoldenGate:

http://docs.oracle.com/cd/E35209_01/doc.1121/e29397.pdf

• Oracle WebLogic Server:

http://docs.oracle.com/cd/E15051_01/wls/docs103/pdf.html

• Oracle Business Intelligence Enterprise Edition:

http://docs.oracle.com/cd/E28280_01/bi.1111/e10544/toc.htm
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Related Documents
For more information, refer to the following documents in the Oracle Utilities Analytics 
documentation library:

• Oracle Utilities Analytics for Oracle Utilities Extractors and Schema and Oracle Utilities Analytics 
Dashboards User's Guide

• Oracle Utilities Analytics for Oracle Utilities Extractors and Schema and Oracle Utilities Analytics 
Dashboards Administration Guide

• Oracle Utilities Analytics for Oracle Utilities Extractors and Schema and Oracle Utilities Analytics 
Dashboards Installation Guide

• Oracle Utilities Analytics for Oracle Utilities Extractors and Schema and Oracle Utilities Analytics 
Dashboards Quick Install Guide

• Oracle Utilities Analytics for Oracle Utilities Extractors and Schema and Oracle Utilities Analytics 
Dashboards Release Notes

• Oracle Utilities Analytics Dashboards for Oracle Utilities Meter Data Analytics Metric Reference Guide

• Oracle Utilities Analytics Dashboards for Oracle Utilities Customer Analytics, Revenue Analytics, and 
Credit & Collections Analytics Metric Reference Guide

• Oracle Utilities Analytics Dashboards for Oracle Utilities Exception Analytics Metric Reference Guide

• Oracle Utilities Analytics Dashboards for Oracle Utilities Mobile Workforce Analytics Metric Reference 
Guide

• Oracle Utilities Analytics Dashboards for Oracle Utilities Distribution Analytics and Outage Analytics 
Metric Reference Guide

• Oracle Utilities Analytics Dashboards for Oracle Utilities Work and Asset Analytics Metric Reference 
Guide

• Oracle Utilities Analytics Dashboards for Oracle Utilities Operational Device Analytics Metric Reference 
Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Customer Care and Billing Data Mapping 
Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Meter Data Management Data Mapping Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Mobile Workforce Management Data Mapping 
Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Network Management System Data Mapping 
Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Operational Device Management Data Mapping 
Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Work & Asset Management Data Mapping 
Guide

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.
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Acronyms
The list of acronyms used in this guide is as explained below: 

• APEX: Oracle Application Express

• CC&B: Oracle Utilities Customer Care and Billing

• CDC: Changed Data Capture 

• ELT: Extraction, Loading and Transformation

• ETL: Extraction, Transformation, and Loading

• MDM: Oracle Utilities Meter Data Management

• MWM: Oracle Utilities Mobile Workforce Management

• NMS: Oracle Utilities Network Management System

• OBIEE: Oracle Business Intelligence Enterprise Edition

• ODI: Oracle Data Integrator

• ODM: Oracle Utilities Operational Device Management

• OGG: Oracle GoldenGate

• OUA: Oracle Utilities Analytics

• OWB: Oracle Warehouse Builder

• WAM: Oracle Utilities Work and Asset Management

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.

Convention Meaning
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Chapter 1 
 Introduction 

This chapter provides an overview of the installation of Oracle Utilities Analytics. This includes: 

• About Oracle Utilities Extractors and Schema and Oracle Utilities Analytics 
Dashboards

• About Oracle Utilities Analytics Installation

• What’s New in Oracle Utilities Analytics v2.5.0?

About Oracle Utilities Extractors and Schema and Oracle Utilities 
Analytics Dashboards

Oracle Utilities Extractors and Schema provides the out of the box extraction and transformation, 
and loads data from the source application to data warehouse. Oracle Warehouse Builder is used 
to validate and load the data to the data warehouse. 

With Oracle Utilities Analytics release 2.5.0, the extraction, transformation and load processes 
have started to move to Oracle GoldenGate (OGG) and Oracle Data Integrator (ODI). Over next 
few releases, all the old extractors will move from Oracle Warehouse Builder to Oracle Data 
Integrator.

In release 2.5.0, the following products support Oracle GoldenGate and Oracle Data Integrator 
based Extract, Load and Transform (ELT):

• Oracle Utilities Customer Care & Billing (CCB)

• Oracle Utilities Operational Device Management (ODM)

The following products will continue to use Oracle Warehouse Builder based Extract, Transform 
and Load (ETL) in the release 2.5.0:

• Oracle Utilities Network Management System (NMS)

• Oracle Utilities Work and Asset Management (WAM)

• Oracle Utilities Meter Data Management (MDM)

• Oracle Utilities Mobile Workforce Management (MWM)

Oracle Utilities Analytics Dashboards provides the out of the box reports based on Oracle 
Business Intelligence Enterprise Edition.

Note: Refer to Oracle Utilities Analytics Metric Reference Guides for comprehensive 
list of all the reports.

This guide helps you install, upgrade, configure Oracle Utilities Extractors and Schema version 
2.5.0 and Oracle Utilities Analytics Dashboards version 2.5.0. Unless otherwise stated, this guide 
Introduction 1-1 
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would refer to these two products together as Oracle Utilities Analytics. If any topic is specific to 
only one of the products, then it would be specifically mentioned.

About Oracle Utilities Analytics Installation
Oracle Utilities Analytics (OUA) version 2.5.0 installation consists of the following components, 
each of which needs to be installed for a successful installation:

• Star schema definitions

• Extract, Load and Transform (ELT) process built on Oracle Data Integrator (ODI)

Note 1: In this release of Oracle Utilities Analytics v2.5.0, Oracle Data 
Integrator based ELT component is only supported for Oracle Utilities 
Operational Device Management (ODM) and Oracle Utilities Customer Care 
and Billing (CC&B) source applications.

Note 2: Oracle GoldenGate (OGG) is utilized to capture the data and this is 
required only for Oracle Data Integrator based ELT.

• Extract, Transform and Load (ETL) process built on Oracle Warehouse Builder (OWB)

Note: In this release of Oracle Utilities Analytics v2.5.0, Oracle Warehouse 
Builder based ETL component is supported for Oracle Utilities Network 
Management System (NMS), Oracle Utilities Work and Asset Management 
(WAM), Oracle Utilities Meter Data Management (MDM) and Oracle Utilities 
Mobile Workforce Management (MWM) source applications.

• Pre-built analytics' dashboards based on Oracle Business Intelligence Enterprise Edition 
(OBIEE)

• Admin tool

What’s New in Oracle Utilities Analytics v2.5.0?
Oracle Utilities Analytics is a set of star schemas, graphic templates, and data processing programs 
that allows you to build a Business Intelligence (BI) solution to meet your organization's analytic 
requirements.

With this new release of Oracle Utilities Analytics v2.5.0, the product has started the process of 
migrating from Oracle Warehouse Builder (OWB) based ETL to Oracle Data Integrator (ODI) 
based ELT. This migration is planned in a phased manner, spanning across several releases over a 
period of time. During this migration cycle, ETL for some of the source applications will continue 
to use Oracle Warehouse Builder, while others will use Oracle Data Integrator.

Note: For information about the new and enhanced products, see Oracle 
Utilities Analytics for Oracle Utilities Extractors and Schema and Oracle Utilities 
Analytics Dashboards Release Notes.

Visit My Oracle Support (http://support.oracle.com) for the most recent 
service packs and patches for this release to ensure you have the most current 
version of this product.
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Chapter 2 
 Installation Overview

This chapter gives a detailed overview of Oracle Utilities Analytics installation. It includes the 
following sections:

• Application Architecture

• Installation Types

• Installation Components

• Installation Scenarios

• Media Pack Components

• Supported Source Application Versions
Installation Overview 2-3 
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Application Architecture
The following diagram shows the architecture of the Oracle Utilities Analytics product when using 
Extract, Transform and Load (ETL) based on Oracle Warehouse Builder.

Note: Applicable only if you have installed any one of the edge applications 
such as, Oracle Utilities Network Management System, Oracle Utilities Work 
and Asset Management, Oracle Utilities Mobile Workforce Management, or 
Oracle Utilities Meter Data Management).

The following diagram shows the architecture of the Oracle Utilities Analytics product when using 
Extract, Load and Transform (ELT) based on Oracle Data Integrator.

Note: Applicable only if you have installed Oracle Utilities Operational Device 
Management, or Oracle Utilities Customer Care and Billing).
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Installation Types
The first step in the installation procedure is to determine the installation type based on the 
installation scenario. The following are the possible installation types:

• Initial Installation, an installation from scratch

• Upgrade, an upgrade from an earlier version to Oracle Utilities Analytics v2.5.0

• Demo Installation, an installation with pre-populated demo data

The following sections describe each of these installations in detail: 

Initial Installation
This installation type is applicable when installing Oracle Utilities Analytics for the first time, or 
from scratch. Each of the following components should be installed during an initial installation: 

• Oracle Utilities Analytics Database component.

• Oracle Utilities Analytics ELT component based on Oracle Data Integrator  
(applicable only if you have installed Oracle Utilities Operational Device Management, or 
Oracle Utilities Customer Care and Billing).

• Oracle Utilities Analytics ETL component based on Oracle Warehouse Builder  
(applicable only if you have installed any one of the edge applications such as, Oracle Utilities 
Network Management System, Oracle Utilities Work and Asset Management, Oracle Utilities 
Mobile Workforce Management, or Oracle Utilities Meter Data Management).

• Oracle Utilities Analytics Dashboard component

• Oracle Utilities Analytics Admin tool component 
(applicable only if you use Oracle Data Integrator based ELT).

Note: Refer to the chapter 5 “Oracle Utilities Analytics Initial Installation” 
for the steps involved in installing each of the above components.

Upgrade
This installation type is applicable when upgrading to Oracle Utilities Analytics v2.5.0 from an 
earlier version.

Note: Refer to the section Supported Upgrade Paths of the Chapter 6: 
Upgrading Oracle Utilities Analytics for Oracle Utilities Extractors and 
Schema and Oracle Utilities Analytics Dashboards to find out how 
upgrade of your particular version is supported.

Each of the following components should be installed during an upgrade installation.

• Oracle Utilities Analytics Database component.

• Oracle Utilities Analytics ELT component based on Oracle Data Integrator  
(applicable only if you have installed Oracle Utilities Operational Device Management, or 
Oracle Utilities Customer Care and Billing).

• Oracle Utilities Analytics ETL component based on Oracle Warehouse Builder 
(applicable only if you have installed any one of the edge applications such as, Oracle Utilities 
Network Management System, Oracle Utilities Work and Asset Management, Oracle Utilities 
Mobile Workforce Management, or Oracle Utilities Meter Data Management).

• Oracle Utilities Analytics Dashboard component

• Oracle Utilities Analytics Admin tool component 
(applicable only if you use Oracle Data Integrator based ELT).
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Note: Refer to the Chapter 6: Upgrading Oracle Utilities Analytics for 
Oracle Utilities Extractors and Schema and Oracle Utilities Analytics 
Dashboards for the steps involved in upgrading each of the required 
components.

Demo Installation
This installation type is applicable when installing the demo database component of Oracle 
Utilities Analytics Dashboards for demonstration, or training purposes. The following 
components should be installed for a demo installation:

• Oracle Utilities Analytics Demo database component

• Oracle Utilities Analytics Dashboard components

Note: Refer to the Chapter 7: Demo Installation Procedure for the steps 
involved in installing each of the required components.

Installation Components
The Oracle Utilities Extractors and Schema v 2.5.0 product installation consists of the following 
components:

Note: Each of the components listed below has to be installed to complete the 
Oracle Utilities Analytics installation.

• Oracle Utilities Analytics Database component containing star schemas and product 
metadata

• Oracle Utilities Analytics ELT component based on Oracle Data Integrator (ODI)

Note: Oracle Utilities Analytics ELT component based on Oracle Data 
Integrator should be installed on a database server. This installation is required 
only if you are installing Oracle Utilities Operational Device Extractor and 
Schema, or Oracle Utilities Customer Care and Billing Extractor and Schema.

• Oracle Utilities Analytics ETL components based on Oracle Warehouse Builder

Note: Oracle Utilities Analytics ETL component based on Oracle Warehouse 
Builder should be installed on a database server. This is applicable if you have 
installed extractor and schema for edge application products other than Oracle 
Utilities Operational Device Management (ODM) and Oracle Utilities 
Customer Care and Billing (CC&B).

• Oracle Utilities Analytics Admin tool component installation

The Oracle Utilities Analytics Dashboards version 2.5.0 product installation consists of the 
following components:

Note: Each of the components listed below has to be installed to complete the 
Oracle Utilities Analytics installation.

• Oracle Utilities Analytics Dashboards components and answers based on Oracle Business 
Intelligence Enterprise Edition

Note: Oracle Utilities Analytics Dashboard components should be installed 
where Oracle Business Intelligence Enterprise Edition is installed on the server.

Oracle Utilities Analytics Dashboards also include the demo database with the pre-populated data 
that can be used for training or demonstration purposes. Refer to the Chapter 7: Demo 
Installation Procedure for the details. 
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Installation Scenarios 
The following installation scenarios are discussed with the respective flow chart diagrams:

• Installation Scenario 1: Oracle Warehouse Builder based on ETL

In this scenario, initial installation of ETL component is based on Oracle Warehouse Builder. 
This is supported for the following source applications:

•  Oracle Utilities Network Management System (NMS)

• Oracle Utilities Work and Asset Management (WAM)

• Oracle Utilities Meter Data Management (MDM)

• Oracle Utilities Mobile Workforce Management (MWM)

• Installation Scenario 2: Oracle Data Integrator based on ELT

In this scenario, initial installation of ELT component is based on Oracle Data Integrator and 
Oracle GoldenGate. This is supported for the following source applications:

• Oracle Utilities Operational Device Management (ODM)

• Oracle Utilities Customer Care and Billing (CC&B)

• Installation Scenario 3: ETL based on Oracle Warehouse Builder and Oracle Data 
Integrator: 

Both Oracle Warehouse Builder based ETL and Oracle Data Integrator based ELT are 
needed. This scenario is applicable when you have edge applications from both the scenarios 
mentioned above. 

• Installation Scenario 4: Upgrade

This scenario is applicable to the users who are upgrading to Oracle Utilities Analytics version 
2.5.0 from an earlier released version. 

Note 1: See Media Pack Components for the list of components comprising 
the Oracle Utilities Analytics product. Certain prerequisite software may need 
to be installed before installing each of these components. 

Note 2: See Supported Source Application Versions for the supported 
source application versions. 

Note 3: See the section Prerequisite Software of the chapter 4 “Installation 
Overview” for the list of prerequisite software necessary for installing each 
component.

Installation Scenario 1: Oracle Warehouse Builder based on ETL
This scenario provides an overview of the installation steps required if you are installing products 
those use Oracle Warehouse Builder based ETL: 

• Oracle Utilities Network Management System (NMS)

• Oracle Utilities Work and Asset Management (WAM)

• Oracle Utilities Meter Data Management (MDM)

• Oracle Utilities Mobile Workforce Management (MWM)

If you are using any other edge applications, refer to the installation scenario 2 or 3, as the case 
may be.
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The following diagram shows the workflow for the initial installation for ETL components based 
on Oracle Warehouse Builder:
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Installation Scenario 2: Oracle Data Integrator based on ELT
This scenario provides an overview of the installation steps required if you are installing products 
those use Oracle Data Integrator based ELT: 

• Oracle Utilities Operational Device Management (ODM)

• Oracle Utilities Customer Care and Billing (CC&B)

If you are using any other edge applications, refer to installation scenario 1 or 3, as the case may 
be.

The following diagram shows the workflow for the initial installation process for the ELT 
component based on Oracle Data Integrator:
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Installation Scenario 3: ETL based on Oracle Warehouse Builder 
and Oracle Data Integrator
This scenario provides an overview of the installation steps required if you are installing ETL for 
the combination of edge applications mentioned in installation scenario 1 and 2, i.e., one or more 
edge applications from: 

• Oracle Utilities Network Management System (NMS)

• Oracle Utilities Work and Asset Management (WAM)

• Oracle Utilities Meter Data Management (MDM)

• Oracle Utilities Mobile Workforce Management (MWM)

As well as one or more from:

• Oracle Utilities Operational Device Management (ODM)

• Oracle Utilities Customer Care and Billing (CC&B)
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The following diagram shows workflow for the initial installation process for the ETL 
components based on Oracle Warehouse Builder as well as Oracle Data Integrator:

:
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Installation Scenario 4: Upgrade 
This installation type is for the users who are upgrading from an earlier version of Oracle Utilities 
Analytics to Oracle Utilities Analytics v2.5.0. 

The following figure shows the workflow for the upgrade process:

Media Pack Components
Oracle Utilities Analytics version 2.5.0 media pack consists of the following documentation and 
installation packages:

Documentation Packages
• Oracle Utilities Analytics v2.5.0 Release Notes

• Oracle Utilities Analytics v2.5.0 Quick Install Guide

• Oracle Utilities Analytics v2.5.0 Installation Guide and Configuration Guide

• Oracle Utilities Analytics v2.5.0 User's Guide
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Installation Packages
• Oracle Utilities Analytics V2.5.0 Dashboard Component Multiplatform

• Oracle Utilities Analytics V2.5.0 ETL Component Based on OWB Multiplatform

• Oracle Utilities Analytics V2.5.0 ETL Component Based on ODI Multiplatform

• Oracle Utilities Analytics V2.5.0 Oracle Database Multiplatform

• Oracle Utilities Analytics V2.5.0 Demo Data

Supported Source Application Versions
The following are the supported source application versions: 

Source Application Version

Oracle Utilities Customer Care and Billing 2.4.0.1 

Oracle Utilities Network Management 
System

1.9.1
1.10.0.3.1
1.11.0.1
1.12

Oracle Utilities Work and Asset 
Management

1.9.1

Oracle Utilities Meter Data Management 2.0.1 SP8 + Single fix patches  14741869, 
15983267 + Framework patch 14741833

2.0.1 SP9

2.1.0

Oracle Utilities Mobile Workforce 
Management

2.1.0 SP 4 +Single Fix patch 14791886 + 
Framework patch 14741833

Oracle Utilities Operational Device 
Management 

2.0.1.1
Installation Overview 2-13 
Oracle Utilities Analytics Installation Guide



Chapter 3
System Requirements and Supported Platforms

This section gives an overview of the tiers on which the product is implemented and shows each 
of the operating system/server combinations that the product is certified for. It includes:

• Operating Systems and Application Servers

• Additional Notes on Supported Platforms

Operating Systems and Application Servers
Oracle Utilities Analytics v2.5.0 installation is certified to operate on many operating system, 
application server, and database server combinations.
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The following table details the minimum versions of the browser, operating system, and 
application server combinations on which Oracle Utilities Analytics version 2.5.0 has been tested 
and certified

Browser
Operating 

System 
(Client)

Operating 
System
(Server)

Chipset
Applicati
on Server

Oracle 
Busine

ss 
Intellig
ence 

Enterpr
ise 

Edition 
(OBIEE

)

Oracle 
Data 

Integra
tor 

(ODI)

Oracle 
GoldenGa

te
Database

IE 9.x 

Firefox 17+
Windows 7

(64 bit)

AIX 7.1 (64-bit) Power  
64-bit

WebLogic 
10.3.6

11.1.1.7.1 11.1.1.6 11.2.1.0.5_2 Oracle 
11.2.0.3

Oracle Linux 6.3 (64-
bit) / Red Hat
Enterprise Linux 6.3
(64-bit)

x86_64 WebLogic 
10.3.6

11.1.1.7.1 11.1.1.6 11.2.1.0.5_2 Oracle 
11.2.0.3

Oracle Linux 6.4 (64-
bit) / Red Hat
Enterprise Linux 6.4
(64-bit)

x86_64 WebLogic 
10.3.6

11.1.1.7.1 11.1.1.6 11.2.1.0.5_2 Oracle 
11.2.0.3

Oracle Solaris 11
 (64-bit)

SPARC WebLogic 
10.3.6

11.1.1.7.1 11.1.1.6 11.2.1.0.5_2 Oracle 
11.2.0.3

Windows 2008 
Server R2 (64-bit)

x86_64 WebLogic 
10.3.6

11.1.1.7.1 11.1.1.6 11.2.1.0.5_2 Oracle 
11.2.0.3

: 

Note: Every new release of Oracle Utilities Analytics is certified against the 
latest versions of the required software, such as Oracle Business Intelligence 
Enterprise Edition, Oracle Data Integrator, Oracle GoldenGate, etc. However, 
any fourth digit change in these software versions is generally backward 
compatible, and is supported by the product.

You must have the following software listed out below: 

Note: Oracle Warehouse Builder is installed as a part of Oracle Database 
Enterprise Edition Server 11.2.0.3.

• Oracle Business Intelligence Enterprise Edition (OBIEE) is required for Oracle Utilities 
Analytics Dashboard. 

• Oracle Data Integrator, Oracle GoldenGate, Oracle WebLogic and Oracle Application 
Express are required for Oracle Utilities Analytics ELT component based on Oracle Data 
Integrator. 
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Additional Notes on Supported Platforms
The following topics are discussed in this section: 

• Oracle Unbreakable Enterprise Kernel

• Oracle Database Server

• Oracle VM Support

• Oracle Support Policy on VMWare

Oracle Unbreakable Enterprise Kernel
Oracle Utilities Analytics version 2.5.0 is supported on Oracle Unbreakable Enterprise Kernel.

Oracle Database Server 
Oracle Utilities Analytics version 2.5.0 is supported on Oracle Database Enterprise Edition Server 
11.2.0.3 on any of the operating systems listed above.

Note: Oracle Utilities Analytics version 2.5.0 is supported on Oracle 
Database Server Standard Edition 11.2.0.3 only when using ELT 
component based on Oracle Data Integrator.

Oracle VM Support
Oracle Utilities Analytics version 2.5.0 is supported on Oracle VM 2.2.2 for supported releases of 
Oracle Linux and Microsoft Windows operating systems.

Oracle Support Policy on VMWare
Refer to the knowledge base article ID 249212.1 on My Oracle Support for Oracle's support 
policy on VMWare.

https://support.oracle.com
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Chapter 4 
Planning the Oracle Utilities Analytics 

Installation

This chapter provides information about planning Oracle Utilities Analytics (OUA) installation 
version 2.5.0, including:

• Prerequisite Software

• Installation Checklist

Note: In order to perform successful installation of the product, you must have 
experience of working on, or installing the following products:

• Oracle Database Server

• Oracle Business Intelligence Enterprise Edition

• Oracle Warehouse Builder

• Oracle Data Integrator

• Oracle GoldenGate

• Oracle Application Express feature of Oracle database

Note: Refer to the corresponding installation guide of these products before 
installing Oracle Utilities Analytics.

Prerequisite Software
For installing Oracle Utilities Analytics version 2.5.0, a few prerequisite software products need to 
be downloaded and installed. Download and install these software products as per the instructions 
provided in the respective installation documents.

Note: Ensure that the same Operating System (OS) user is used to install all 
software prerequisites and Oracle Utilities Analytics components.

The following sections describe the prerequisite software requirement Oracle Utilities Analytics:

• Prerequisite Software for Oracle Utilities Analytics Database Component

• Prerequisite Software for Oracle Utilities Analytics ELT Component based on Oracle 
Data Integrator

• Prerequisite Software for Oracle Utilities Analytics ETL Component based on Oracle 
Warehouse Builder

• Prerequisite Software for Oracle Utilities Analytics Dashboard Component

• Prerequisite Software for Oracle Utilities Analytics Admin Tool Component
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Prerequisite Software for Oracle Utilities Analytics Database Component
The prerequisite software for Oracle Utilities Analytics database component is as described below:

• Oracle Database Server Enterprise Edition 11.2.0.3: This is required for installing the 
database component of the Oracle Utilities Analytics product.

Note: Oracle Utilities Analytics version 2.5.0 is supported on Oracle 
Database Server Standard Edition 11.2.0.3 only when using ELT 
component based on Oracle Data Integrator.

Prerequisite Software for Oracle Utilities Analytics ELT Component based on 
Oracle Data Integrator

Note: Applicable only if you have installed Oracle Utilities Operational Device 
Management or Oracle Utilities Customer Care and Billing.

The prerequisite software products for Oracle Utilities Analytics ELT component based on Oracle 
Data Integrator (ODI) are listed below. These software products should be installed on the 
database server:

•  JDK 1.6.0 (20 or above)

• Oracle Database Server Enterprise Edition 11.2.0.3, or Oracle Database Server Standard 
Edition 11.2.0.3

• Oracle WebLogic 10.3.6

• Oracle Data Integrator 11.1.1.6 with Java EE

Note: While installing Oracle Data Integrator, do not create any repositories. 
Select Skip Repository Configuration option.

• Oracle GoldenGate 11.2.1.0.5_2 on the source application database server and the target 
database server  
This can be downloaded from My Oracle Support (https://support.oracle.com/).

Prerequisite Software for Oracle Utilities Analytics ETL Component based on 
Oracle Warehouse Builder

Note: Applicable only if you have installed any one of the edge applications 
such as, Oracle Utilities Network Management System, Oracle Utilities Work 
and Asset Management, Oracle Utilities Mobile Workforce Management, or 
Oracle Utilities Meter Data Management.

The prerequisite software products for Oracle Utilities Analytics ETL based on Oracle Warehouse 
Builder component are as follows:

• JDK 1.6.0 (20 or above) is required for running the File Processor daemon

• Oracle Database Server Enterprise Edition 11.2.0.3 with Oracle Warehouse Builder 11.2.0.3

Prerequisite Software for Oracle Utilities Analytics Dashboard Component
The prerequisite software for Oracle Utilities Analytics Dashboard component is as follows:

• Oracle Business Intelligence Enterprise Edition 11.1.1.7.1 with Enterprise Install option

Note: Install the Oracle 11.2.0.3 client if Oracle Business Intelligence 
Enterprise Edition software is not installed on database server. If Oracle 
Business Intelligence Enterprise Edition software is installed, then there 
is no need to install Oracle client.
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Note: After Oracle Business Intelligence Enterprise Edition installation, save a 
snapshot of the last page of Oracle Business Intelligence Enterprise Edition 
installation having details of BI Oracle Home, Instance Home, etc. These 
values will be used during the Oracle Utilities Analytics installation.

Prerequisite Software for Oracle Utilities Analytics Admin Tool Component
Note: Applicable only if you use Oracle Data Integrator based ELT.

The prerequisite software products for the Oracle Utilities Analytics Admin tool component are 
as follows:

• Oracle Database Server Enterprise Edition 11.2.0.3, or Oracle Database Server Standard 
Edition 11.2.0.3

• Oracle Apex 4.2

Installation Checklist
The following checklist guides you through the installation process for Oracle Utilities Analytics 
version 2.5.0:

The details are provided in subsequent chapters for each of the below-listed step: 

1. Determine the installation type and the installation scenario. See Media Pack Components 
to determine the installation type for your scenario. Perform the installation steps as 
applicable to your installation type.

2. Install the prerequisite software.  
See Prerequisite Software for more details.

3. Ensure that you have downloaded the Oracle Utilities Analytics components.

Note: Refer to the chapter Oracle Utilities Analytics Initial Installation for 
instructions regarding initial installation.

Note: For upgrading from an earlier version of Oracle Utilities Analytics to 
Oracle Utilities Analytics v2.5.0, refer to the chapter Upgrading Oracle 
Utilities Analytics for Oracle Utilities Extractors and Schema and Oracle 
Utilities Analytics Dashboards.

Note: Refer to Demo Installation Procedure for instructions about demo 
installation. 

4. Perform the post-installation tasks and configure the application. 

Note: The out-of-the-box Oracle GoldenGate scripts are utilized to do the 
initial sync for tables having more than 10 million records. For more 
information about this process, refer to the section Appendix C: Install and 
Upgrade Process of Oracle Utilities Analytics for Oracle Utilities Extractors and 
Schema and Oracle Utilities Analytics Dashboards Administration Guide.
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Chapter 5 
Oracle Utilities Analytics Initial Installation

This chapter provides instructions for installing Oracle Utilities Analytics version 2.5.0. It includes 
the following topics: 

• Initial Installation Procedure

• Checklist After the Installation

Note: In order to perform successful installation of the product, you must have 
experience of working on, or installing the following products:

• Oracle Database Server

• Oracle Business Intelligence Enterprise Edition

• Oracle Warehouse Builder

• Oracle Data Integrator

• Oracle GoldenGate

• Application Express feature of Oracle database

Note: Refer to the corresponding installation guide of these products before 
installing Oracle Utilities Analytics.

Initial Installation Procedure
The following topics are discussed in this section: 

• Oracle Utilities Analytics Database Component Installation

• Oracle Utilities Analytics ELT Component Installation based on Oracle Data 
Integrator Installation  
(applicable only if you have installed Oracle Utilities Operational Device Management, or 
Oracle Utilities Customer Care and Billing).

• Oracle Utilities Analytics ETL Component based on Oracle Warehouse Builder 
Installation 
(applicable only if you have installed any one of the edge applications such as, Oracle Utilities 
Network Management System, Oracle Utilities Work and Asset Management, Oracle Utilities 
Mobile Workforce Management, or Oracle Utilities Meter Data Management).

• Oracle Utilities Analytics Dashboard Component Installation

• Oracle Utilities Analytics Admin Tool Component 
(applicable only if you use Oracle Data Integrator based ELT).
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Oracle Utilities Analytics Database Component Installation
This section describes how to install the database component of Oracle Utilities Analytics version 
2.5.0. It includes the following topics:

• Copying and Decompressing Install Media

• Database Creation

• RELADM Schema Installation

• MDADM Schema Installation

• DWADM Schema Installation

• Spatial Configuration

Copying and Decompressing Install Media
To copy and decompress the install media, perform these steps:

1. Download Oracle Utilities Analytics version 2.5.0 Oracle Database part (Oracle Utilities 
Analytics V2.5.0 Oracle Database Multiplatform.zip) from the Oracle Software Delivery 
Cloud (https:// edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred to below as 
<TEMPDIR>). This directory must be located outside any current working Oracle Utilities 
application environment. All files that are placed in this directory as a part of the installation, 
can be deleted after completing a successful installation.

3. Unzip Oracle Utilities Analytics V2.5.0 Oracle Database Multiplatform.zip to 
<TEMPDIR> using any zip utility.

4. Unzip the zip file <TEMPDIR>/OUA-V2.5.0-Database-Multiplatform.zip using any zip 
utility.

Database Creation
Ensure that Oracle Database Server Enterprise Edition 11.2.0.3 is already installed on the machine 
in order to create the database. Use the Database Configuration Assistant (DBCA) utility to 
create the database. 

Database Creation Using DBCA
Note: Refer to Oracle database documentation to know more about the 
Database Configuration Assistant (DBCA).

For an initial installation database creation, it is recommended that you use the Database 
Configuration Assistant (DBCA) to create a data warehouse database with below-mentioned 
specifications:

1. Create a database with the AL32UTF8 character set. Set the open cursor limit to 3000 and 
processes to 1000 at the time of database creation. 

2. Ensure to create users in the database with the following names: DWADM, DWUSER, 
DWREAD, MDADM, RELADM, SPLADM, SPLUSER, SPLREAD, MASTER_REPO, 
WORK_REPO and DWSTAGE if these do not exist already, without giving specific roles.

3. Ensure to create roles with the following names: DW_USER, DW_READ, 
DW_REPLICATE, SPL_USER and SPL_READ roles if these do not exist already.

4. Connect to the sys user, execute the Usersgrants.sql in BI250/Scripts/Usersgrants.sql. 
This SQL will provide required grants to the users created above.
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RELADM Schema Installation
The RELADM schema is a metadata schema that consists of the database objects used for storing 
product version and component installation information.

This section describes the initial installation of the RELADM schema. The process prompts you 
for the names of three database users:

• A user that owns the application schema. Provide the value: RELADM.

• A user that has the read-write (select/update/insert/delete) privileges to the objects in the 
application schema. There is no need to provide any value here, just press Enter to proceed.

• A user with the read-only privileges to the objects in the application schema. There is no need 
to provide any value here, just press Enter to proceed.

The process also prompts you for the following:

• A database role that has the read-write (select/update/insert/delete) privileges to the objects 
in the application schema. There is no need to provide any value here, just press Enter to 
proceed.

• A database role with the read-only privileges to the objects in the application schema. There is 
no need to provide any value here, just press Enter to proceed.

• Location for jar files (the Jar files are bundled with the database package).

• Java Home. For example: C:\Java\jdk1.6.0_18.

Review Storage.par
The storage.par file (that comes with the product and is in location ..\BI250\RELADM\Install-
Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. If you 
decide to allocate some tables or indexes outside of the default tablespace, then this has to be 
reflected in the storage.par file by changing the tablespace name from the default value to a 
custom value, according to the format shown below:

Object Type:Object Name:Tablespace name:Parallel:Comments

Where Parallel defines the number of threads that the Oracle database server uses to access a 
table, or to create an index. The default value is 1.

Note: If database does not have CISTS_01 tablespace, or RELADM user 
does not have quota on CISTS_01 tablespace, you must edit the 
tablespace name in Storage.par to tablespace name on which RELADM 
has quota.

Installing the RELADM Schema
Perform the following steps to install the RELADM schema:

Note: Ensure to run CDXDBI.exe (in step below) from a Window desktop 
that has the Oracle 11.2.0.3 32 bit client and Java Development Kit Version 6.0 
Update 20 or later. Ensure that tnsnames.ora file of the Oracle client is updated 
with the entry for the target database to connect to the target database.

1. Run CDXDBI.exe from ..\BI250\RELADM\Install-Upgrade. Run the utility from 
command prompt. The utility prompts you to enter values for the following parameters:

• Name of the target database: <DB NAME>

• Password for the system user account in the database (in silent mode)

• Name of the owner of the Database Schema: RELADM

• Location of Java Home: <..\jdk1.6.0_20>

• Location of TUGBU Jar files: <..\BI250\RELADM\Jarfiles>

• Password for the user (in silent mode): <RELADM user password>
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• Oracle user with the read-write privileges to the database schema: No input needed. 
Press Enter and continue.

• Oracle user with the read-only privileges to the database schema: No input needed. Press 
Enter and continue.

• Oracle database role with the read-write privileges to the database schema: No input 
needed. Press Enter and continue.

• Oracle database role with the read-only privileges to the database schema: No input 
needed. Press Enter and continue.

2. The utility creates schema and system data definitions.

If an error occurs while executing an SQL or another utility, it logs and displays the error 
message and allows you to re-execute the current step.

Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before 
using the database, generate the statistics for these new objects:

Connect to the sys user, and execute the command: 

execute DBMS_STATS.GATHER_SCHEMA_STATS('RELADM');

MDADM Schema Installation
The MDADM schema is a metadata schema that consists of database objects used for storing 
metadata of Oracle Utilities Analytics. For example, ETL job execution status, target tables for 
ETL, Oracle GoldenGate configuration details, etc.

This section describes the initial installation of MDADM schema. The process prompts you for 
the names of three database users:

• A user that owns the application schema. Provide value: MDADM.

• A user that has the read-write (select/update/insert/delete) privileges to the objects in the 
application schema. There is no need to provide any value here, just press Enter to proceed.

• A user with the read-only privileges to the objects in the application schema. There is no need 
to provide any value here, just press Enter to proceed.

The process also prompts you for the following:

• A database role that has the read-write (select/update/insert/delete) privileges to the objects 
in the application schema. There is no need to provide any value here, just press Enter to 
proceed.

• A database role with the read-only privileges to the objects in the application schema. There is 
no need to provide any value here, just press Enter to proceed.

• Location for jar files (the Jar files are bundled with the database package).

• Java Home. For example: C:\Java\jdk1.6.0_18.

Review Storage.par
The storage.par file (that comes with the product and is in location ..\BI250\MDADM\Install-
Upgrade) allocates all base tables and indexes to the default tablespace CISTS_01. If you decide to 
allocate some tables or indexes outside of the default tablespace, then this has to be reflected in 
the storage.par file by changing the tablespace name from the default value to a custom value, 
according to the format shown below:

Object Type:Object Name:Tablespace name:Parallel:Comments

Where Parallel defines the number of threads that the Oracle database server uses to access a 
table, or to create an index. The default value is 1.
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Note: If the database does not have CISTS_01 tablespace, or MDADM 
user does not have quota on CISTS_01 tablespace, you must edit the 
tablespace name in Storage.par to the tablespace name on which the 
MDADM has quota.

Installing the MDADM Schema
Perform the following steps to install the MDADM schema:

Note: Ensure to run the CDXDBI.exe (in step below) from a Window 
desktop that has the Oracle 11.2.0.3 32 bit client and Java Development Kit 
Version 6.0 Update 20 or later. Ensure that tnsnames.ora file of the Oracle 
client is updated with the entry for the target database to connect to the target 
database.

1. Run CDXDBI.exe from ..\BI250\MDADM\Install-Upgrade. Run the utility from the 
Command Prompt. The utility prompts you to enter values for the following parameters:

• Name of the target database:<DB NAME>

• Password for the system user account in the database (in silent mode)

• Name of the owner of the Database Schema: MDADM

• Location of Java Home: <..\jdk1.6.0_20>

• Location of TUGBU Jar files: <..\BI250\MDADM\Jarfiles>

• Password for the user (in silent mode)

• Oracle user with the read-write privileges to the database schema: No input needed. 
Press Enter and continue.

• Oracle user with the read-only privileges to the database schema: No input needed. Press 
Enter and continue.

• Oracle database role with the read-write privileges to the database schema: No input 
needed. Press Enter and continue.

• Oracle database role with the read-only privileges to the database schema: No input 
needed. Press Enter and continue.

2. The utility creates schema and system data definitions.

If an error occurs while executing an SQL or another utility, it logs and displays the error 
message and allows you to re-execute the current step.

Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before 
using the database, generate the statistics for these new objects:

Connect to the sys user, and execute the command: 

execute DBMS_STATS.GATHER_SCHEMA_STATS('MDADM');

DWADM Schema Installation
The DWADM schema contains the star schema objects, such as facts and dimensions that contain 
all the data of the data warehouse.

This section describes the initial installation of DWADM schema. The process prompts you for 
the names of three database users:

• A user that owns the application schema. For example, DWADM.

• A user that has the read-write (select/update/insert/delete) privileges to the objects in the 
application schema. The application will access the database as this user. For example, 
DWUSER.
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• A user with the read-only privileges to the objects in the application schema. For example, 
DWREAD.

The process also prompts you for the following:

• A database role that has the read-write (select/update/insert/delete) privileges to the objects 
in the application schema. For example: DW_USER. The application will access the database 
as DW_USER.

• A database role with the read-only privileges to the objects in the application schema. For 
example, DW_READ.

• Location for jar files (the Jar files are bundled with the database package).

• Java Home. For example: C:\Java\jdk1.6.0_18.

Review Storage.par
The storage.par file (that comes with the product and is in location ..\BI250\DWADM\Install-
Upgrade) allocates all base tables and indexes to the default tablespace CISTS_01. If you decide to 
allocate some tables, or indexes outside of the default tablespace, then this has to be reflected in 
the storage.par file by changing the tablespace name from the default value to a custom value, 
according to the format shown below:

Object Type:Object Name:Tablespace name:Parallel:Comments

Where Parallel defines the number of threads that the Oracle database server uses to access a 
table, or to create an index. The default value is 1.

Note: If database does not have CISTS_01 tablespace, or DWADM user 
does not have quota on CISTS_01 tablespace, you must edit the 
tablespace name in Storage.par to tablespace name on which the 
DWADM has quota.

Installing the DWADM Schema
Perform the following steps to install the DWADM schema:

Note: Ensure to run CDXDBI.exe (in step below) from a Window desktop 
that has the Oracle 11.2.0.3 32 bit client and Java Development Kit Version 6.0 
Update 20 or later. Ensure that tnsnames.ora file of the Oracle client is updated 
with the entry for the target database to connect to the target database.

1. Run CDXDBI.exe from ..\BI250\DWADM\Install-Upgrade. Run the utility from the 
Command Prompt. The utility prompts you to enter values for the following parameters:

• Name of the target database: <DB NAME>

• Password for the system user account in the database (in silent mode)

• Name of the owner of the Database Schema: DWADM

• Location of Java Home: <..\jdk1.6.0_20>

• Location of TUGBU Jar files: <..\BI250\DWADM\Jarfiles>

• Password for the user (in silent mode)

• Oracle user with read-write privileges to the database schema: DWUSER

• Oracle user with read-only privileges to the database schema: DWREAD

• Oracle database role with read-write privileges to the database schema: DW_USER

• Oracle database role with read-only privileges to the database schema: DW_READ

2. If you choose to continue, CDXDBI first checks for the existence of each of the users 
specified and prompts for their password, default tablespace, and temporary tablespace if 
they do not exist.
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3. After setting up roles and users, the utility continues upgrading schema and system data 
definitions.  
If an error occurs while executing an SQL or another utility, it logs and displays the error 
message and allows you to re-execute the current step.

Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before 
using the database, generate the statistics for these new objects:

Connect to sys user and execute the command: 

execute DBMS_STATS.GATHER_SCHEMA_STATS('DWADM');

Spatial Configuration
Refer to section Spatial Configuration for details regarding configuring spatial data.

Oracle Utilities Analytics ELT Component Installation based on Oracle Data 
Integrator Installation

Note 1: Ensure that the same Operating System (OS) user is used to install the 
Oracle Utilities Analytics ELT component that is used to install all the related 
software. Refer to the section Prerequisite Software.

Note2: You must install the Oracle Utilities Analytics ELT component based 
on Oracle Data Integrator (ODI) only if you are using Oracle Utilities 
Operational Device Management or Oracle Utilities Customer Care and Billing 
as the source applications.

Note 3: Oracle Utilities Operational Device Management (ODM) or Oracle 
Utilities Customer Care and Billing (CC&B) application set up is a prerequisite 
in order to install Oracle Data Integrator based ELT component. The source 
applications should be setup with the required configurations before 
proceeding with the Oracle Data Integrator based ELT component installation 
in order to successfully extract data from them, to Oracle Utilities Analytics.

Refer to the chapter Configuring Oracle Utilities Operational Device 
Management for Business Intelligence in Oracle Utilities Extractors and 
Schema for Oracle Utilities Operational Device Management Data Mapping Guide. 

Refer to the chapter Configuring Oracle Utilities Customer Care and 
Billing for Business Intelligence in Oracle Utilities Extractors and Schema for 
Oracle Utilities Customer Care and Billing Data Mapping Guide.

This section describes how to install the ELT component of Oracle Utilities Analytics. The section 
includes the following:

• Oracle GoldenGate Setup

• Copying and Decompressing Install Media

• Setting Permissions for cistab File in UNIX

• Oracle Utilities Analytics ELT Component based on Oracle Data Integrator Package 
Installation Steps

• Post-installation Tasks

• Generating Security and Starting Oracle Data Integrator Scheduler

Oracle GoldenGate Setup
Note 1: This section describes what setup is required in Oracle GoldenGate to 
work with Oracle Utilities Analytics. For installing Oracle GoldenGate, refer to 
its installation document.
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Note 2: You should install the Oracle Utilities Analytics ELT component based 
on Oracle Data Integrator (ODI) only if you are using Oracle Utilities 
Operational Device Management, or Oracle Utilities Customer Care and Billing 
as the source application.

Download Oracle GoldenGate 11.2.1.0.5_2 from the My Oracle Support (https://
support.oracle.com).

Set up Oracle GoldenGate on the source and the target database servers. 

This section describes the following: 

• Source Database Server Oracle GoldenGate Setup

• Target Database Server GoldenGate Setup

Source Database Server Oracle GoldenGate Setup
Perform the following steps for each source instance: 

1. Create a directory on the source database server. For example, ../Golden Gate Home.  
This will be Oracle Golden Gate home (OGG_Home) on the source database Server.

Important Note: Make a note of this directory location; it will be used during 
the Oracle Utilities Analytics installation.

2. Copy the Oracle GoldenGate software in the above created directory. 

3. Unzip it. It will extract into a tar file:

tar -xvof <tar file>

4. Open a command terminal/window, and set the source ORACLE_SID and 
ORACLE_HOME variables.

Set LD_LIBRARY_PATH using the following commands:

For Unix:

export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH

For Windows:

set  LD_LIBRARY_PATH=%ORACLE_HOME%\lib:%LD_LIBRARY_PATH%

5. In the Command window, change directory to the Oracle GoldenGate home directory, and 
execute the command shown below:

For Unix:

./ggsci

For Windows:

ggsci

This opens the GoldenGate prompt.

6. On the GoldenGate prompt, execute the create SUBDIRS command.

7. On the GoldenGate prompt, execute the EDIT PARAMS mgr command. 
This command opens an editor.

8. Copy the below contents:

• PORT 7830

• DYNAMICPORTLIST 7830-7880

Note 1: Make sure the mentioned port range (7830-7880) is not in use. If they 
are in use, provide another available port range.
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Note 2: Make a note of the range start and end ports numbers; it will be used 
during Oracle Utilities Analytics installation.

Note 3: Refer to Oracle GoldenGate documentation if you would like to 
configure other settings, such as Purge.

9. On the GoldenGate prompt, execute the start mgr command to start the Oracle 
GoldenGate manager process.

10. On the GoldenGate prompt, execute the info all command to view the manager process is 
running. Exit GoldenGate by executing the Exit command.

11. Ensure that the source database is in the archivelog mode.

12. Connect to the source database as the sys user and execute the alter database add 
supplemental log data (primary key) columns command.

13. Go to the Oracle GoldenGate home (OGG_Home) directory.

14. Connect to the database as the sys user using the SQL*Plus (OGG_Home should be the 
current directory while invoking SQL*Plus). 

15. Create a new user, for example: ODM01SRC (this user is the Oracle GoldenGate owner) and 
make sure to assign a tablespace to this user that is not assigned to any other user. 

Important Note: Make a note of the GoldenGate Owner Username; it will be 
used during Oracle Utilities Analytics installation.

16. Execute Grant connect,resource,dba to <GoldenGate owner user created in above step>.

17. Connect to the source application ADM schema, such as, CISADM, and execute the below 
commands:

For Oracle Utilities Customer Care and Billing source database, execute the following 
grants:

Grant select on F1_MST_CONFIG to < GoldenGate owner user created in above 
step>

Grant select on F1_EXT_LOOKUP_VAL to < GoldenGate owner user created in 
above step>

Grant select on F1_BKT_CONFIG to < GoldenGate owner user created in above 
step>

Grant select on F1_BKT_CONFIG_VAL to < GoldenGate owner user created in 
above step>

For Oracle Utilities Operational Device Management source database, execute the 
following grants:

Grant select on F1_MST_CONFIG to < GoldenGate owner user created in above 
step>

Grant select on F1_EXT_LOOKUP_VAL to < GoldenGate owner user created in 
above step>

Note: While executing the SQL commands in the steps 18, 19 and 20, provide 
the GoldenGate owner user if prompted for. All below scripts and located in 
GoldenGate Home directory and must be executed after connecting to the sys 
user.

18. Run the command:  
@marker_setup.sql

19. Run the command:  
@ddl_setup.sql
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20. Run the command:  
@role_setup.sql

21. Exit the SQL*Plus login and create a directory named diroby inside OGG_Home directory.

Target Database Server GoldenGate Setup
Perform the following steps: 

1. Create a directory on target database server. e.g  ../GoldenGateHome.  
This will be Oracle GoldenGate home (OGG_Home) on the target Oracle Utilities Analytics 
database server.

Important Note: Make a note of this directory location; it will be used during 
the Oracle Utilities Analytics installation.

2. Copy the Oracle GoldenGate (OGG) software in the directory created above.

3. Unzip it. It will extract into a tar file.

tar -xvof <tar file>

4. Open a Command window and set the target ORACLE_SID and ORACLE_HOME 
variables.

Set LD_LIBRARY_PATH using the following commands:

For Unix:

export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH

For Windows:

set LD_LIBRARY_PATH=%ORACLE_HOME%/lib:%LD_LIBRARY_PATH%

5. In the Command window, change the directory to the GoldenGate home directory and 
execute the command shown below:

For Unix:

./ggsci

For Windows:

ggsci

This opens the GoldenGate prompt.

6. On the GoldenGate prompt, execute the create SUBDIRS command.

7. On the GoldenGate prompt, execute the EDIT PARAMS mgr command. This opens an 
editor.

8. Copy the below contents:

• PORT 7830

• DYNAMICPORTLIST 7830-7880

Note 1: Make sure the mentioned port range (7830-7880) is not in use. If they 
are in use, provide another available port range.

Note 2: Make a note of the range start and end ports numbers; it will be used 
during Oracle Utilities Analytics installation.

Note 3: Refer to Oracle GoldenGate documentation if you would like to 
configure other settings, such as Purge. 

9. On the GoldenGate prompt, execute the start mgr command to start the Oracle 
GoldenGate manager process.
Oracle Utilities Analytics Initial Installation 5-29 
Oracle Utilities Analytics Installation Guide



10. On the GoldenGate prompt, execute the info all command to view the manager process is 
running.

11. Exit GoldenGate login by executing exit command and create a directory named diroby 
inside the OGG_Home directory.

Copying and Decompressing Install Media
The Oracle Utilities Analytics ETL component based on Oracle Utilities Analytics installation file 
is delivered in zip format for both UNIX and Windows platforms. If you plan to install multiple 
Oracle Utilities Analytics environments operated by different Oracle Utilities administrator user 
IDs, you must complete each of the following installation steps for each administrator user ID.

1. Download the Oracle Utilities Analytics version 2.5.0 ELT component based on Oracle Data 
Integrator part (Oracle Utilities Analytics V2.5.0 ETL component based on ODI 
Multiplatform.zip) from the Oracle Software Delivery Cloud (https://edelivery.oracle.com).

2. Log into the database server host as the Oracle Utilities Analytics administrator user ID.

3. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred to below as 
<TEMPDIR>). This directory must be located outside any current working Oracle Utilities 
application environment. All files that are placed in this directory as a part of the installation 
can be deleted after completing a successful installation. 

4. Unzip Oracle Utilities Analytics V2.5.0 ETL component based on ODI 
Multiplatform.zip to <TEMPDIR>.

5. Decompress the file BI.ODI.V2.5.0-MultiPlatform.jar as follows:

• cd <TEMPDIR>

• jar -xvf BI.ODI.V2.5.0-MultiPlatform.jar 

Note: You should have Java JDK installed on the machine used to (un)jar the 
Oracle Utilities Analytics ELT component based on Oracle Data Integrator 
installation package. Install the JDK that is supported for the install on your 
platform to be able to use the jar command.

The Java packages are located at: http://java.sun.com/products/archive/index.html. A sub-
directory named “BI.ODI.V2.5.0” is created. It contains the installation software for the Oracle 
Utilities Analytics ELT component based on Oracle Data Integrator.

Setting Permissions for cistab File in UNIX
Every Oracle Utilities Analytics environment installed on a server must be registered in the /etc/
cistab file located on that server. On UNIX servers, generally only the root user ID has write 
permissions to the /etc directory. Since the installation process is run by the Oracle administrator 
user ID, this user ID may not be able to write to /etc/cistab table.

The install utility checks permissions and if it identifies a lack of necessary permissions, it 
generates a script in the <TEMPDIR>/BI.ODI.V2.5.0 directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
Oracle Utilities Analytics application environment on the server) and registers a new environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Analytics 
administrator user ID, so that the next time a new environment is created by the same Oracle 
Utilities Analytics administrator user ID, you do not need to run the generated script with the root 
user ID. Instead, the install utility itself proceeds with the registration.

If you are re-installing an existing environment, only the validation of /etc/cistab entry is done by 
the install utility, no new registration occurs. The install utility interactively instructs you about 
every step that needs to occur in each specific case.
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If you plan to upgrade an existing environment, you must ensure to take a backup prior to the 
installation process. The installation utility does not create a backup of the existing environment.

Oracle Utilities Analytics ELT Component based on Oracle Data Integrator 
Package Installation Steps

Follow these steps to install the Oracle Utilities Analytics package applications after performing 
the steps to deploy the ELT component objects as described in the section above:

• Prerequisite Software

• Installation Steps

Prerequisite Software
Before installing the Oracle Data Integrator package, ensure that you have already installed the 
below-mentioned software products. These software products should be installed on the database 
server. Also, note the locations of these software products:

• JDK 1.6.0_20 (JAVA_HOME) on the database server

• Oracle Database Home (ORACLE _HOME)

• Oracle WebLogic 10.3.6 (WL_HOME)

• Oracle Data Integrator 11.1.1.6 with Java EE Installation (ODI_HOME)

• Oracle GoldenGate 11.2.1.0.5_2 software on the source database server and the target 
database server (OGG_HOME)

Installation Steps
Then follow the below instructions to install the Oracle Utilities Analytics ELT component based 
on Oracle Data Integrator: 

1. Change to the <TEMPDIR>/ BI.ODI.V2.5.0 directory.

2. Set the ORACLE_CLIENT_HOME and PATH variables as Oracle Client Perl is required to 
run the installer (sample commands listed in the point 4 below).

3. Make sure that the user with which Oracle Database Enterprise Edition (or Standard Edition) 
11.2.0.3 and all other prerequisite software products were installed, is used to install the 
Oracle Utilities Analytics ELT component based on Oracle Data Integrator package.

4. Execute the following script for UNIX/Windows: 
For UNIX:

Run the following commands: 

export ORACLE_CLIENT_HOME=<ORACLE_HOME> 
export PERL_HOME=$ORACLE_CLIENT_HOME/perl 
export PATH=$PATH:$PERL_HOME/bin
ksh ./install.sh

Note: On UNIX, ensure that you have the required the execute permission on 
install.sh.

For Windows: 

Run the following commands: 

set ORACLE_CLIENT_HOME=<ORACLE_HOME> 
set  PERL_HOME=%ORACLE_CLIENT_HOME%\perl
set  PATH=%PERL_HOME%\bin;%PATH% 
install.cmd

5. The Oracle Utilities Analytics specific menu appears.
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6. Select each menu item to configure the values.  
For the detailed description of the values, refer to the Configuration Worksheet for ELT 
Component based on Oracle Data Integrator Installation.

Note: For the parameter 'Target GoldenGate Shared Secret', follow the below 
instructions.

a. Go to the GoldenGate prompt and run the command:

encrypt password <password of MDADM user>, encryptkey DEFAULT

b. Copy the encrypted password returned by the above command and provide it as the 
value for the Target GoldenGate Shared Secret.

Environment Installation Options: 

1. Oracle Client Home Directory:

2. Environment Mount Point: 
Log Files Mount Point: 
Environment Name: 
Web Java Home Directory: 
Each item in the above list should be configured for a successful install.  
Choose the following options from the menu item (1, 2 <P> Process, <X> Exit).

Environment Configuration: 

1. Environment Description 
Environment Description:

2. ODI Environment Configuration 
WEBLOGIC HOME: 
ODI HOME: 
ODI SUPERVISOR USER: SUPERVISOR 
ODI SUPERVISOR Password:  
Target Database Name: 
Target Database Host:  
Target Database Port:1521 
DWADM Schema Name: DWADM 
DWADM Schema Password: <DWADM Password> 
ODI Master Schema Name: MASTER REPO 
ODI Master Schema Password:  
ODI Work Schema Name: 
ODI Work Schema Password: 
ODI Master Repository ID: 601 
ODI Work Repository ID: 602 
MDADM Schema Name: MDADM 
MDADM Schema Password: <MDADM Password>

3. ODI Agent Configuration 
ODI Weblogic Agent Host: 
ODI Weblogic Agent Port:

4. Target GoldenGate Configuration 
Target GoldenGate Manager Port 
Target GoldenGate Dynamic Mininum Port: 
Target GoldenGate Dynamic Maximum Port: 
Target GoldenGate Algorithm: 
Target GoldenGate Encryptkey: 
Target GoldenGate Shared Secret: 
Target Database Home: 
Target GoldenGate Home: 
Oracle Utilities Analytics Initial Installation 5-32
Oracle Utilities Analytics Installation Guide



Each item in the above list should be configured for a successful install.  
Choose the option (1, 2, 3, 4<P> Process, <X> Exit).

Once the parameter setup is completed, proceed with the option P. 

Once installation is finished successfully, execute the post-installation steps as described in Post-
installation Tasks.

Post-installation Tasks
The following post-installation tasks are discussed in this section:

• Deploying ELT Component based on Oracle Data Integrator

• RunviewGenerator (Global)

• Configure Source

• InitiateSetup

• RunviewGenerator (For Source Instance)

• WebLogic Domain Creation for Oracle Data Integrator Agent

Deploying ELT Component based on Oracle Data Integrator
Follow the sequence for the steps shown below for successful deployment: 

For the Oracle Data Integrator deployment, the script creates the master and work repositories, 
and imports the Oracle Data Integrator metadata.

For UNIX:

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run the ksh ./deployodi.sh.

For Windows: 

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run the deployodi.cmd.

Verify the log at the location: <SPLEBASE>/logs/system/deployodi.log file.

RunviewGenerator (Global)
This step creates global views based on the Oracle Data Integrator metadata.

For UNIX:

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run the ksh ./runviewGenerator.sh.
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For Windows:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run the runviewGenerator.cmd.

Verify the log at the location: <SPLEBASE>/logs/system/deployodi.log file.

Configure Source
Important Note: This step inserts each source instance and instance 
name into b1_prod_instance table. This step has to be repeated for each 
source instance that will be used. 

This step also creates the replication schema in the target database 
corresponding to each source application. $SPLEBASE/bin/obiu.properties 
file is read to assign the default tablespace to the replication user.

By default, this file has obiu.repository.default.tablespace = CISTS_01 entry where CISTS_01 is 
tablespace name. If you want to assign this tablespace as default tablespace to replication schema, 
make sure to create CISTS_01 tablespace in the target database if it does not exist.

Make sure to edit obiu.repository.default.tablespace parameter in $SPLEBASE/bin /
obiu.properties file to another tablespace name, which exists in database and would be considered 
the default tablespace to the replication schema.

This entry should be changed as follows:

obiu.repository.default.tablespace = <Name of tablespace to use>

For UNIX:

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run ksh ./configureSourceDB.sh -c <Source instance> -u <Source Golden gate owner 
schema name> -p < Source Golden gate owner schema password > -s <Source Application 
Schema> -r <Source Application Drill Back URL>.

For Windows: 

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run configureSourceDB.cmd -c <Source instance> -u <Source Golden gate owner schema 
name> -p <Source Golden gate owner schema password> -s <Source Application Schema> 
-r <Source Application Drill Back URL>.

Where, 

• Source instance = Name for the source instance being added

• For Oracle Utilities Operational Device Management source application, the valid values 
are ODM1,ODM2……..ODM9. Provide any of these values, which is already not 
configured. Make a note of these parameters it will be used in next deployment steps.
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• For Oracle Utilities Customer Care and Billing application, the valid values are 
CCB1,CCB2…….CCB9. Provide any of these values, which are already not configured.

• Source _Schema User = <GoldenGate Owner created in Source database> For 
example: ODM01SRC

• Source _Schema User _Password = GoldenGate Owner password

• Source Application Schema = Source Application Schema (For example, CISADM)

• Source Application Drill Back URL = Source Application URL (http://
<Host>:<Port>/ouaf/)

This opens a source configuration menu shown as below. Select each menu item to configure the 
values.

For detailed description of the values, refer to the Configuration Worksheet 
for ELT Component based on Oracle Data Integrator Installation.

Note: For the parameter 'Source GoldenGate Shared Secret', follow the below 
instructions.

a. Go to GoldenGate prompt and run the command:

encrypt password <password of source GoldenGate owner user>, 
encryptkey DEFAULT.

b. Copy the encrypted password returned by the above command and provide it as the 
value for the Source GoldenGate Shared Secret.

Environment Configuration: 

1. Source GoldenGate Configuration 
Source Instance Name: 
Source GoldenGate Manager Port: 
Source GoldenGate Dynamic Mininum Port:  
Source GoldenGate Dynamic Maximum Port:  
Source GoldenGate Algorithm: 
Source GoldenGate Encryptkey:  
Source GoldenGate Shared Secret:  
Source Database Name: 
Source Database Host:  
Source Database Port:  
Source Database Home:  
Source GoldenGate Home: 
Each item in the above list should be configured for a successful install. 
Choose the option (1, <P> Process, <X> Exit).

Once the parameter setup is completed, proceed with the option P. 

Verify the log at the location: <SPLEBASE>/logs/system/deployodi.log file.

InitiateSetup
This step is run to reverse engineer source tables, Journalizing Setup, and to create the 
GoldenGate scripts. This step has to be repeated for each source instance that will be 
used.

For Unix: 

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.
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4. Run the ksh ./initiateSetup.sh -c <Source Instance>.

Where Source instance = Instance name given to the source in the step Configure Source 
above. For example: ODM1.

5. The initial load process can be started now to copy data from the source database into the 
replication schema in the data warehouse. There are two options for this.

Proceed with the option 1, only if all of the tables being replicated are expected to have a 
volume of less than 10 million records. The list of the source tables being replicated can be 
found in the Data Mapping Guide.

Note: For the source tables list, refer to Oracle Utilities Extractors and Schema 
Data Mapping Guide for Oracle Utilities Operational Device Management or Oracle 
Utilities Extractors and Schema Data Mapping Guide for Oracle Utilities Customer Care 
and Billing.

Option 1: Using GoldenGate

In $SPLEBASE/GGScriptsGen directory, you will find a folder starting with the instance 
name.

Go to the folder that has name starting with the instance name.

For example: $SPLEBASE/GGScriptsGen/ODM1AA

Refer to the ReadMe.txt generated in the above-mentioned directory for 
detailed instructions on how to run the GoldenGate scripts.

Note 1: Ensure that ORACLE_SID, ORACLE_HOME and 
LD_LIBRARY_PATH are set before running the GoldenGate scripts on both 
source and target database servers. 

Note 2: During GoldenGate script execution, you might get error message 
(ERROR: OCI Error ORA-00955: name is already used by an existing object 
(status = 955) related to the B1_CHECKPOINT table. It should be ignored.

Option 2: Using Database Import/Export Process

If any of the source tables to be replicated is expected to be in excess of 10 million records, 
the GoldenGate process may not scale up well when dealing with such higher volumes. The 
primary reason being the GoldenGate scripts will work on individual records on a single 
threaded basis.

In such cases, it is recommended to perform the initial sync utilizing Oracle database's export 
and import process.

Note: Refer to the steps mentioned in the section “Performing Initial Load” 
in the Appendix C of Oracle Utilities Analytics for Oracle Utilities Extractors and 
Schema and Oracle Utilities Analytics Dashboards Administration Guide.

Once the initial load is completed via the export and import process, the GoldenGate 
incremental sync process can be started to capture incremental changes.

In $SPLEBASE/GGScriptsGen directory, you will find a folder starting with the instance 
name.

Go to the folder that has name starting with the instance name.

For example: $SPLEBASE/GGScriptsGen/ODM1AA

Note 1: Refer to the ReadMe.txt generated in the above-mentioned directory 
for detailed instructions on how to run the GoldenGate scripts. Since the initial 
load has already been done by export/import process, skip the commands 
below the header "##### FOR INITIAL LOAD ONLY #####".
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Note 2: Ensure that ORACLE_SID, ORACLE_HOME and 
LD_LIBRARY_PATH are set before running the GoldenGate scripts on both 
the source and the target database servers. 

Note 3: During GoldenGate script execution, you might get error message 
(ERROR: OCI Error ORA-00955: name is already used by an existing object 
(status = 955) related to the B1_CHECKPOINT table. It should be ignored.

For Windows: 

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run the initiateSetup.cmd -c <Source instance>.

Where Source instance = Instance name given to the source in the step Configure Source 
above. For example: ODM1

5. The initial load process can be started now to copy data from the source database into the 
replication schema in the data warehouse. There are two options for this.

Proceed with the option 1, only if all of the tables being replicated are expected to have a 
volume of less than 10 million records. The list of the source tables being replicated can be 
found in the Data Mapping Guide.

Note: For the source tables list, refer to Oracle Utilities Extractors and Schema 
Data Mapping Guide for Oracle Utilities Operational Device Management or Oracle 
Utilities Extractors and Schema Data Mapping Guide for Oracle Utilities Customer Care 
and Billing.

Option 1: Using GoldenGate

In %SPLEBASE%/GGScriptsGen directory, you will find a folder starting with the instance 
name.

Go to the folder that has name starting with the instance name.

For example: %SPLEBASE%/GGScriptsGen/ODM1AA

Note: Refer to the ReadMe.txt generated in the above -mentioned directory 
for detailed instructions on how to run the GoldenGate scripts.

Note: Ensure that ORACLE_SID, ORACLE_HOME and 
LD_LIBRARY_PATH are set before running the GoldenGate scripts on both 
source and target database servers.

Option 2: Using Database Import/Export Process

If any of the source table to be replicated is expected to be in excess of 10 million records, the 
GoldenGate process may not scale up well when dealing with such higher volumes. The 
primary reason being the GoldenGate scripts will work on the individual records on a single 
threaded basis.

In such cases, it is recommended to perform the initial sync utilizing Oracle database's export 
and import process.

Note: Refer to the steps mentioned in the section “Performing Initial Load” 
in the Appendix C of the Oracle Utilities Analytics for Oracle Utilities Extractors and 
Schema and Oracle Utilities Analytics Dashboards Administration Guide.

Once the initial load is completed via the export and import process, the GoldenGate 
incremental sync process can be started to capture incremental changes.
Oracle Utilities Analytics Initial Installation 5-37 
Oracle Utilities Analytics Installation Guide



In %SPLEBASE%/GGScriptsGen directory, you will find a folder starting with the instance 
name.

Go to the folder that has name starting with the instance name.

For example: %SPLEBASE%/GGScriptsGen/ODM1AA

Note: Refer to the ReadMe.txt generated in the above mentioned directory 
for detailed instructions on how to run the Oracle GoldenGate scripts. Since 
the initial load has already been done by export/import process, skip the 
commands below the header "##### FOR INITIAL LOAD ONLY 
#####".

Note: Ensure that ORACLE_SID and, ORACLE_HOME and 
LD_LIBRARY_PATH are set before running the Oracle GoldenGate scripts 
on both the source and target database servers.

Note: During GoldenGate script execution, you might get error message 
(ERROR: OCI Error ORA-00955: name is already used by an existing object 
(status = 955) related to the B1_CHECKPOINT table. It should be ignored.

RunviewGenerator (For Source Instance)
This step creates the views for a given source instance. These views are used for replication. This 
step needs to be executed once for each source configured.

For Unix: 

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run the runviewGenerator.sh -c <Source Instance>.

For Windows: 

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run the runviewGenerator.cmd -c <Source instance>.

Where Source instance = Instance name given to the source in configure Source step above. 
For example: ODM1

WebLogic Domain Creation for Oracle Data Integrator Agent
The WebLogic Domain should be created for bringing up the WebLogic Agent (ODI Agent) to 
complete the steps. 

Perform the following steps to bring up WebLogic ODI Agent, which is created in the step 
Deploying ELT Component based on Oracle Data Integrator.

1. Navigate to the Oracle Data Integrator (ODI) installed location <MW_HOME>/
Oracle_ODI1\common\bin, run the below command and follow the steps to provide the 
masterschema and workschema provided in the configuration.

For Unix: 

• Run ./Config.sh

For Windows: 
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• Run Config.cmd

2. Create a new WebLogic domain.  

Click Next.

3. Generate a domain configured automatically to support the following products. Select the 
checkboxes for the below mentioned plugins. When these plugins are selected, some 
automatic plugins also get selected.

• Oracle Enterprise Manager Plugin for Oracle Data Integrator -11.1.1.0

• Oracle Data Integrator - Console - 11.1.1.0

• Oracle Data Integrator Agent - 11.1.1.0

• Oracle Data Integrator - SDK Web Services - 11.1.1.0

Then, click Next to proceed. 

4. On the Specify Domain Name and Location page, complete the following: 

• Provide the name: odi_domain 
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• Location will be default

Click Next to proceed.

5. Configure the Administrator User Name and Password for WebLogic. 
Provide the WebLogic password.

Click Next. 

6. Configure the Server StartUp Mode and JDK:

• Select Production Mode

• Provide the JDK 1.6.0_20 
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7. Configure the JDBC Component Schema. 

Select only the ODI Master Schema checkbox. Provide the below details:

• DBMS/Service: Target Database Name

• Host Name: Database Serverhost

• Port: Database Port

• Schema Owner: MASTER_REPO

• Schema Password: MASTER_REPO Password

8. Deselect the ODI Master Schema checkbox.

9. Select the ODI Work Schema checkbox. Provide the below details: 

• DBMS/Service: Target Database Name

• Host Name: Database Serverhost

• Port: Database Port

• Schema Owner: WORK_REPO

• Schema Password: WORK _REPO Password
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Click Next to proceed. 

10. Test the JDBC Component Schema by selecting the Select All and the Test Connections. 

Select Next to proceed. 

11. Select the Optional Configuration:

• Select the checkboxes: 

• Administration Server

• Managed Server, Clusters and Machines
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Select Next to proceed.

12. Configure the Administration Server:

• Provide the Listening Port, which is not in use.

Click Next to proceed. 

13. Configure the Managed Servers by providing the following: 

• Name: odi_server1

• Listen Address: All Local Addresses

• Port: <Provide the port, which is configured in the menu configuration of installation 
step (ODI Agent Configuration > ODI WebLogic Agent Port>)
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14. Configure the Cluster.  
Click Next. 

15. Configure the Machines.  
Click Next. 

16. Assign the Servers to Machines.  
Click Next.

17. On the Configuration Summary page, click Create to create the domain odi_domain. 

18.  After the domain is created, go to Domain Location, create boot.properties file for 
WebLogic login. Create the <MW_HOME>/user_projects/domains/odi_domain/servers/
AdminServer/security folder if not present. 

19. Go to <MW_HOME>/user_projects/domains/odi_domain/servers/AdminServer/
security, then create boot.properties with the below values:

• username=weblogic

• password=Weblogic password

20. Create the <MW_HOME>/user_projects/domains/odi_domain/servers/odi_server1/
security folder if not present.

21. Go to <MW_HOME>/user_projects/domains/odi_domain/servers/odi_server1/security, 
then create boot.properties with the below values:

• username=weblogic

• password=Weblogic password

Starting the WebLogic Admin Server 

Perform the following steps: 

1. In the command shell, change the directory to the directory of the WLS Home -
<MW_HOME>/user_projects/domains/odi_domain/bin.

2. Execute the startweblogic command for UNIX and Windows:
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For Unix:

nohup ./startWebLogic.sh > startWebLogic.log &

For Windows: 

startWebLogic.cmd

Authenticating the Oracle Data Integrator Supervisor User in WebLogic and Starting 
Managed Server

Perform the following steps:

1. Go to <MW_HOME>/oracle_common/common/bin.

2. Execute the following command:

For Unix:

./wlst.sh

For Windows: 

wlst.cmd

3. To connect to the running Admin server, execute the following command:

connect('<Weblogic User>','<Weblogic password>','t3://
<WEBLOGICHOST>:<WEBLOGIC ADMIN PORT')

For example: connect('weblogic','weblogic123','t3://localhost:7001')

4. Execute the following command to add the correct credential store for the ODI Supervisor:

createCred (map="oracle.odi.credmap", key="SUPERVISOR", 
user="SUPERVISOR", password="<SUPERVISOR Password>", desc="ODI 
SUPERVISOR Credential")

5. To exit WebLogic Scripting Tool (WLST), execute the exit () command. 

6. To start managed server odi_server1, change the directory to WLS Home: 

<MW_HOME>/user_projects/domains/odi_domain/bin

Execute the below commands: 

For Unix: 

nohup ./ startManagedWeblogic.sh  odi_server1 > 
StartManagedWeblogic.log &

For Windows: 

StartManagedWeblogic.cmd odi_server1

7. From the Oracle Warehouse Builder Designer, click Test icon to test connectivity of the 
configured Oracle Warehouse Builder Java EE agent. Click OK. 

8. Close the OracleDIAgent tab.

Generating Security and Starting Oracle Data Integrator Scheduler
Perform the following steps: 

1. Edit the database name with the name of your database in OraGenSec.bat and run it from 
BI250/DWADM/Security folder.

2. Log into Oracle Data Integrator Studio and navigate to Designer > Projects > Oracle 
Utilities BI > Configuration > Scheduler > Packages.
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3. Right-click the BI_INITIAL_SETUP_PKG and execute. 

4. Select global as context and WLS_AGENT as logical agent and then click OK.

5. Go to the Operator and view the logs for successful execution of package.

6. In Oracle Data Integrator Studio, navigate to Designer > Projects >Oracle Utilities BI 
> Configuration > Scheduler > Packages > B1_RUN_ALL > Scenarios > 
B1_RUN_ALL Version 001 > Scheduling.

7. Right-click scheduling and select New Scheduling option.

8. Select the source context as global, agent as WLS_AGENT and the log level as 1.

9. To specify how often the scheduler should run, navigate to the Execution Cycle tab of the 
Scheduler and select the 'Many Times' radio button. Set the interval between repetitions.

10. Navigate to Topology > Agents > OracleDIAgent.

11. Right-click on OracleDIAgent, and click Update Schedule.

Oracle Utilities Analytics ETL Component based on Oracle Warehouse Builder 
Installation

This section describes how to install the Oracle Warehouse Builder based ETL 
component of Oracle Utilities Analytics.

 Note 1: Ensure that the same Operating System (OS) user is used to install the 
Oracle Utilities Analytics ETL component that is used to install all the related 
software. Refer to the section Prerequisite Software for Oracle Utilities 
Analytics ETL Component based on Oracle Warehouse Builder.

Note 2: You should install the Oracle Utilities Analytics ETL component based 
on Oracle Warehouse Builder (OWB) only if you are using Oracle Utilities 
Network Management System, Oracle Utilities Work and Asset Management, 
Oracle Utilities Meter Data Management, or Oracle Utilities Mobile Workforce 
Management as the source application.

This section includes the following:

• Copying and Decompressing Install Media

• Setting Permissions for cistab File in UNIX

• Creating and Configuring Oracle Warehouse Builder Workspace

• Oracle Utilities Analytics ETL Component based on Oracle Warehouse Builder 
Package Installation Steps

• Post-Installation Tasks

Copying and Decompressing Install Media
The Oracle Utilities Analytics ETL component based on Oracle Warehouse Builder installation 
file is delivered in a zip format for both UNIX and Windows platforms. If you plan to install 
multiple Oracle Utilities Analytics environments operated by different Oracle Utilities 
Administrator User IDs, you must complete each of the following installation steps for each 
Administrator User ID.

1. Download the Oracle Utilities Analytics V2.5.0 ETL Component based on Oracle Warehouse 
Builder part (Oracle Utilities Analytics V2.5.0 ETL Component Based on OWB 
Multiplatform.zip) from the Oracle Software Delivery Cloud (https://edelivery.oracle.com).

2. Log into the database server host as the Oracle Utilities Analytics Administrator User ID 
(default cases).
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3. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred to below as 
<TEMPDIR>). This directory must be located outside any current working Oracle Utilities 
application environment. All files that are placed in this directory as a part of the installation 
can be deleted after completing a successful installation.

4. Unzip the zip file Oracle Utilities Analytics V2.5.0 ETL Component Based on OWB 
Multiplatform.zip to <TEMPDIR>.

5. Decompress the file BI.OWB.V2.5.0-MultiPlatform.jar as follows:

• cd <TEMPDIR>

• jar -xvf BI.OWB.V2.5.0-MultiPlatform.jar

Note: You should have Java JDK installed on the machine used to (un)jar the 
Oracle Utilities Analytics ETL component based on Oracle Warehouse Builder 
installation package. Install the JDK that is supported for the install on your 
platform to be able to use the jar command. 

The Java packages are located at: http://java.sun.com/products/archive/index.html. A sub-
directory named "BI.OWB.V2.5.0" is created. It contains the installation software for the Oracle 
Utilities Analytics ETL component based on Oracle Warehouse Builder.

Setting Permissions for cistab File in UNIX
Every Oracle Utilities Analytics environment installed on a server must be registered in the /etc/
cistab file located on that server. On UNIX servers, generally only the root user ID has write 
permissions to the /etc directory. Since the installation process is run by the Oracle Administrator 
User ID, this user ID may not be able to write to /etc/ cistab file.

The install utility checks permissions and if it identifies a lack of necessary permissions, it 
generates a script in the <TEMPDIR>/BI.OWB.V2.5.0 directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
Oracle Utilities Analytics application environment on the server) and registers a new environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Analytics 
Administrator User ID, so that the next time a new environment is created by the same Oracle 
Utilities Analytics Administrator User ID, you do not need to run the generated script with the 
root user ID. Instead, the install utility itself proceeds with the registration.

If you are re-installing an existing environment, only the validation of /etc/cistab entry is done by 
the install utility, no new registration occurs. The install utility interactively instructs you about 
every step that needs to occur in each specific case.

If you plan to upgrade an existing environment, you must ensure to take a backup prior to the 
installation process. The installation utility does not create a backup of the existing environment.

Creating and Configuring Oracle Warehouse Builder Workspace
This section describes how to create and configure the Oracle Warehouse Builder workspace. It 
also includes details about the following:

• Pre-deployment Steps for Initial Installation

• Creating and Configuring Oracle Warehouse Builder Workspace for an Initial 
Installation

Pre-deployment Steps for Initial Installation
Before creating/configuring workspace, perform the following steps: 

1. Execute the following command to configure the workflow in the database.

For Unix:

$ORACLE_HOME/owb/wf/install/wfinstall.csh 
Oracle Utilities Analytics Initial Installation 5-47 
Oracle Utilities Analytics Installation Guide



For Windows:

%ORACLE_HOME%/owb/wf/install/wfinstall.bat

2. This launches a configuration dialog in which you are asked to enter the user name and 
password. Enter OWFMGR as a user and a password for OWFMGR user.

3. Specify the TNS connect string of the database, in the following format.

hostname:port:sid

Creating and Configuring Oracle Warehouse Builder Workspace for an Initial Installation
To configure Oracle Warehouse Builder (OWB), perform the following steps: 

1. Run the $ORACLE_HOME/owb/bin/unix/reposinst.sh command for UNIX from the 
database server. 
 
OR 
 
Invoke the repository assistant from Warehouse Builder > Administrator for Windows 
from the database server or client.

2. Provide the following information:

• Database connection details and click Next.

• Select Manage Warehouse Builder Workspaces and click Next.

• Select Create a new Warehouse Builder Workspace and click Next.

• Select Workspace with a new user as the workspace owner.

• Provide the system user password.

3. Check only Data Integrator Enterprise Edition on Enable Optional features, and then 
specify the following details:

• Workspace Owner's User Name: BIREPOWN

• Workspace Owner's Password: BIREPOWN

• Workspace Name: SPLBIREP

• Provide OWBSYS Password:

Note: Workspace name should be SPLBIREP. Do not change the workspace 
name.

4. Execute cat_owb.sql as sysdba from <OWBHOME>/owb/UnifiedRepos directory if 
prompted.

5. Unlock the OWBSYS and OWBSYS _AUDIT accounts, if this has not already been done.

Connect to the Sys User and execute the following commands:

ALTER USER OWBSYS IDENTIFIED BY
OWBSYS ACCOUNT UNLOCK; ALTER USER
OWBSYS_AUDIT IDENTIFIED BY OWBSYS_AUDIT ACCOUNT UNLOCK;

6. Execute <OWBHOME>/owb/UnifiedRepos /remote_owb_install.sql after logging in to 
sys user. When prompted for Oracle Home for Remote Oracle Warehouse Builder software, 
provide the location of Oracle Warehouse Builder Oracle Home.

7. Provide the tablespace info for the Oracle Warehouse Builder workspace schema.

8. Select the Language (American Language).
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9. Select the Target Schema (DWADM) and the Workflow Schema (OWFMGR) from the 
available Repository Users List and move them to Selected. This will register the DWADM 
and OWFMGR schemas with the workspace.

10. On the same page, click Create New User to create a new workspace user. Specify the 
following details:

• User Name: BIREPO 

• Password: BIREPO

11. Review the information, and then click Finish to complete the workspace configuration.

12. Modify the contents of <owb-home>/owb/bin/admin/Runtime.properties file from the 
following to the contents mentioned later.

property.RuntimePlatform.0.NativeExecution.FTP.security_constraint 
= DISABLED 
property.RuntimePlatform.0.NativeExecution.Shell.security_constraint = 
DISABLED 
property.RuntimePlatform.0.NativeExecution.SQLPlus.security_constraint 
=DISABLED

To

property.RuntimePlatform.0.NativeExecution.FTP.security_constraint 
= NATIVE_JAVA

property.RuntimePlatform.0.NativeExecution.Shell.security_constrai
nt = NATIVE_JAVA

property.RuntimePlatform.0.NativeExecution.SQLPlus.security_constr
aint = NATIVE_JAVA

13. Connect to the OWBSYS user, and execute <owb-home>/owb/rtp/sql/stop_service.sql.

14. Connect to the OWBSYS user, and execute <owb-home>/owb/rtp/sql/start_service.sql.

15. Connect to the database with the sys user, and execute the following procedures:

Note: Before executing these procedures, modify <SMTP SERVER> and 
<SMTP PORT> to appropriate values.

EXECUTE 
DBMS_NETWORK_ACL_ADMIN.CREATE_ACL('acl_for_owb_cc.xml','ACL for 
Control Center','OWBSYS', TRUE, 'connect'); 

EXECUTE 
DBMS_NETWORK_ACL_ADMIN.ASSIGN_ACL('acl_for_owb_cc.xml',<SMPT SERVER>, 
<SMPT PORT>); 
COMMIT;

16. Execute the following: 

SELECT
acl,host, 

DECODE(DBMS_NETWORK_ACL_ADMIN.check_privilege_aclid(aclid,'OWBSYS', 
'connect'),1, 'GRANTED', 0, 'DENIED', NULL) privilege

FROM dba_network_acls ;

You will see the following:

/sys/acls/acl_for_owb_cc.xml
<SMPT SERVER> GRANTED

17. Connect to the BIREPOWN user, and run the spl_exec_wf_prc.sql located in../BI250/
Scripts.
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18. Connect to the DWADM schema, and execute the spl_oms_snapshot_pkg.sql.located in../
BI250/Scripts.

19. Connect to the database with the sys user, and execute owb_grants_synonyms.sql located 
in../BI250/Scripts.

Note: Ignore errors that are caused when trying to drop synonyms that these 
do not exist.

Oracle Utilities Analytics ETL Component based on Oracle Warehouse Builder 
Package Installation Steps

 After performing the above outlined steps, follow these steps to install the Oracle Utilities 
Analytics ETL Component based on the Oracle Warehouse Builder package:

1. Change to the <TEMPDIR>/BI.OWB.V2.5.0 directory.

2. Set the ORACLE_CLIENT_HOME and PATH variables as Oracle Client Perl is required to 
run the installer (steps mentioned in point 4 below).

3. Make sure the user with which Oracle Database Enterprise Edition 11.2.0.3 was installed, is 
used to install the Oracle Utilities Analytics ETL component based on Oracle Warehouse 
Builder package.

4. Execute the following script: 

For Unix: 

Perform the following steps: 

• export ORACLE_CLIENT_HOME=<ORACLE_HOME> 

• export PERL_HOME=$ORACLE_CLIENT_HOME/perl

• export PATH=$PATH:$PERL_HOME/bin

• Run the ksh ./install.sh

Note: Ensure that you have the required execute permission on install.sh.

For Windows: 

Perform the following steps: 

• set ORACLE_CLIENT_HOME=<ORACLE_HOME> 

• set PERL_HOMEb=%ORACLE_CLIENT_HOME%\perl 

• set PATH=%PERL_HOME%\bin;%PATH% 

• Run install.cmd

5. The Oracle Utilities Analytics specific menu appears.

6. Select each menu item to configure the values. For detailed description of the values, see 
Configuration Worksheet for ETL Component based on Oracle Warehouse Builder 
Installation.

Environment Installation Options: 

1. Oracle Client Home Directory: 

2. Environment Mount Point:  
Log Files Mount Point: 
Environment Name: 
Web Java Home Directory: 

For successful installation, each item in the above list should be configured. Choose the following 
menu options (1, 2 <P> Process, <X> Exit).
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Environment Configurations:

1. Environment Description 
Environment Description:

2. Database Configuration 
OWB WorkSpace Owner: 
OWB WorkSpace Owner Password: Database Name: 
Database Server: Database Port:

3. Design Repository Configuration 
OWB WorkSpace User: 
OWB Workspace user Password:  
OWB WorkSpace Name: 
DWADM SCHEMA NAME: 
DWADM SCHEMA Password:  
WORKFLOW MANAGER SCHEMA NAME: 
WORKFLOW MANAGER SCHEMA Password:

4. Database character set configuration 
Database Character set: AL32UTF8

5. Editing process flow configuration 
Repository Operating System:  
Perl Compiler location: 
Data and control files location:  
Separator to be used: 
File Manager location:

6. Email Configuration 
Email ID of Sender: 
Email ID for Reply-To address: 
Email ID of Receiver:  
SMTP server: 
SMTP server port:

7. Control Centre Configuration 
Repository Control Center Name:

8. External Data Source Configuration  
Path of the External Datasource: 
Path of the External Datasource LOG: 
File Processor Daemon Execution Switch: 1 
File Processor Extract Max Load: 5 
File Processor Scheduler Poll Duration: 60

For successful installation, each item in the above list should be configured. Choose the 
following menu options (1, 2, 3, 4, 5, 6, 7, 8 <P> Process, <X> Exit).

After completing the parameter setup, proceed with the option P. Write to the configure file.

Once installation is successful, execute the post-installation steps as described in Post-
Installation Tasks.
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Post-Installation Tasks
The following post-installation tasks are discussed in this section:

• Deploying ETL Workflows on Oracle Warehouse Builder

• Deploying Materialized Views

• Start File Processor

• Generating Security

• Generating Database Statistics

Deploying ETL Workflows on Oracle Warehouse Builder
Deploy the ETL workflows to the target BI database configured in Oracle Utilities Analytics 
package installation. In UNIX, you may get a Java heap space error while importing the MDL file. 

To resolve this error, you are required to make changes in OMBPlus.sh file, located at: 
$ORACLE_HOME/owb/bin/ unix/OMBPlus.sh.

In the following code, change the value -Xmx768M to -Xmx1024M, and then the -Dlimit value 
768M to 1024M.

$JAVAPATH/bin/java $JAVA64FLAG -Xms64M -Xmx768M $OPTS -Dlimit=768M 
- DORACLE_HOME=$ORACLE_HOME -DOWBCC_HOME=$ORACLE_HOME - 
DTCLLIBPATH="$TCLLIBPATH" - 
DMARATHON_RETRY_COUNT="$MARATHON_RETRY_COUNT" - 
DMARATHON_RETRY_INTERVAL="$MARATHON_RETRY_INTERVAL"

$CLASSPATH_LAUNCHER oracle.owb.scripting.OMBShell $*

You may need to make this value larger than 1024MB (1GB) depending on the size of the import. 

Perform the following task:

Review the parallel-* .txt files located under the $SPLEBASE/etc folder to set the degree of 
parallelism. The files are in the parallel*.txt format to change the <Degree> of parallelism.

parallel-tables.txt file format: <Object_name>:<Degree> 
parallel-mvs.txt file format: : <MV_Name>:<Fact_Table>:<Degree>  
parallel-maps.txt file format:<Object_name>:<Table_Name>:<Degree> 

For UNIX:

Perform the following: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run the ksh ./Owbdeploy.sh.

For Windows:

Perform the following:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run the Owbdeploy.cmd.

Deploying Materialized Views
Perform the following: 

For UNIX: 
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1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE\bin.

4. Run the ksh ./installViews.sh.

5. Once the deployment is complete, remove the content inside this directory $SPLEBASE/
tmp to ensure that all files are removed.

For Windows:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run the installViews.cmd.

5. Once the deployment is complete, remove the content inside this directory 
%SPLEBASE%\tmp to ensure that all files are removed.

Start File Processor
Perform the following:

For UNIX: 

cd $SPLEBASE/bin 
nohup ksh ./startFileprocessordaemon.sh >&1 &

For Windows:

startFileprocessordaemon.cmd

Note: Go to <SPLEBASE>/logs/system to view the file processor log.

Generating Security
Edit the database name with the name of your database in OraGenSec.bat after completing the 
Oracle Warehouse Builder deployment and run it from BI250/DWADM/Security folder.

Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before 
starting to use the database, generate the statistics for these new objects.

Oracle Utilities Analytics Dashboard Component Installation
This section describes how to install the database component of Oracle Utilities Analytics. The 
section includes the following:

• Copying and Decompressing Install Media

• Setting Permissions for cistab File in UNIX

• Oracle Utilities Analytics Dashboard Package Installation Steps

• Post-installation Tasks

Copying and Decompressing Install Media
The Oracle Utilities Analytics Dashboard Component installation file is delivered in zip format for 
both UNIX and Windows platforms. If you plan to install multiple Oracle Utilities Analytics 
environments operated by different Oracle Utilities Administrator User IDs, you must complete 
each of the following installation steps for each Administrator User ID.
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1. Download the Oracle Utilities Analytics V2.5.0 Dashboard Component part (Oracle 
Utilities Analytics V2.5.0 Dashboard Component Multiplatform.zip) from the Oracle 
Software Delivery Cloud (https://edelivery.oracle.com).

2. Log into the application server host (where Oracle Business Intelligence Enterprise 
Edition11.1.1.7.1 software is installed) as the Oracle Utilities Analytics Administrator User ID 
(default cases).

3. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred in step 3 
below as <TEMPDIR>). This directory must be located outside any current working Oracle 
Utilities application environment. All files placed in this directory as a part of the installation 
procedure can be deleted after completing a successful installation.

4. Copy the file BI.OBIEE.V2.5.0-MultiPlatform.jar from the delivered package to the 
<TEMPDIR>. If you are using FTP to transfer this file, remember to use the BINARY 
option for the FTP transfer.

5. Decompress the file:

cd <TEMPDIR>

jar -xvf BI.OBIEE.V2.5.0-MultiPlatform.jar

Note: You should have Java JDK installed on the machine used to (un)jar the 
application server installation package. Install the JDK that is supported for the 
install on your platform to be able to use the jar command.

The Java packages are located at: http://java.sun.com/products/archive/
index.html

A sub-directory named “BI.OBIEE.V2.5.0” is created. It contains the 
installation software for the Oracle Utilities Analytics Dashboard component.

Setting Permissions for cistab File in UNIX
Every Oracle Utilities Analytics environment installed on a server must be registered in the /etc/
cistab file located on that server. On the UNIX servers, generally only the root user ID has write 
permissions to the /etc directory. Since the installation process is run by the Oracle administrator 
user ID, this user ID may not be able to write to /etc/cistab table.

The install utility checks permissions and if it identifies a lack of the necessary permissions, it 
generates a script in the <TEMPDIR>/BI.OBIEE.V2.5.0 directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
Oracle Utilities Analytics application environment on the server) and registers a new environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Analytics 
Administrator User ID, so that the next time a new environment is created by the same Oracle 
Utilities Analytics Administrator User ID, you do not need to run the generated script with the 
root user ID. Instead, the install utility itself proceeds with the registration.

If you are reinstalling an existing environment, only the validation of /etc/cistab entry is done by 
the install utility, no new registration occurs. The install utility interactively instructs you about 
every step that needs to occur in each specific case.

If you plan to upgrade an existing environment, it is recommended that you take a backup prior to 
the installation process. The installation utility does not create a backup of existing environment.

Oracle Utilities Analytics Dashboard Package Installation Steps
Note: Before installing verify that the steps in Prerequisite Software for 
Oracle Utilities Analytics Dashboard Component are followed.

To install the Oracle Utilities Analytics Dashboard package, follow these steps. 

1. Change to the <TEMPDIR>/BI.OBIEE.V2.5.0 directory.
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2. Set the ORACLE_CLIENT_HOME and PATH variables as Oracle Client Perl is required to 
run the installer.

For UNIX:

Perform the following steps: 

• export ORACLE_CLIENT_HOME=<ORACLE_HOME>

• export PERL_HOME=$ORACLE_CLIENT_HOME/perl

• export PATH=$PATH:$PERL_HOME/bin

• Run the ksh ./install.sh

Note: Ensure that you have the proper execute permission on install.sh.|

For Windows:

Perform the following: 

• set ORACLE_CLIENT_HOME=<oracle_client_home>

• set  PERL_HOME=%ORACLE_CLIENT_HOME%\perl

• set  PATH=%PERL_HOME%\bin;%PATH%

• Run the Install.cmd

3. The Oracle Utilities Analytics specific menu appears.

4. Select each menu item to configure the values. For detailed description of the values, see 
Configuration Worksheet for Dashboard Component Installation.

Environment Installation Options 

1. Oracle Client Home Directory:                                                   

2. Environment Mount Point: 
Log Files Mount Point:  
Environment Name:  
Web Java Home Directory:                           

For successful installation, each item in the above list should be configured. Choose the following 
menu options (1, 2, <P> Process, <X> Exit).

For detailed description of the values, see Configuration Worksheet for Dashboard 
Component Installation.

Environment Configuration 

1. Environment Description 
Environment Description:

2. OBIEE Environment Configuration 
Oracle BI Instance Home 
Oracle BI Home 
Oracle BI Domain Home 
Weblogic Domain Console User Name 
Weblogic Domain Console Host: 
Weblogic Domain Console Port  
Number:

3. Target Database Details 
Target Database Name:   
Target Database Host:  
Target Database Port: 1521 
DWADM Schema Name: DWADM 
DWADM Schema Password: 
Oracle Utilities Analytics Initial Installation 5-55 
Oracle Utilities Analytics Installation Guide



For a successful installation, each item in the above list should be configured. Choose the 
following menu options (1, 2, 3 <P> Process, <X> Exit).

After completing the parameter setup, proceed with option P. 

Once installation is completed successfully, execute the post-installation steps outlined in Post-
installation Tasks.

Post-installation Tasks
The following post-installation tasks are discussed in this section:

• Deploying Repository (RPD) File

• Deploying Web Catalog

• Configuring and Deploying MapViewer

• Deploying Write Back

• Enabling Analytics Help

• Enabling Auto Complete Feature on Oracle Business Intelligence Enterprise Edition 
11.1.1.7.1

Deploying Repository (RPD) File
The RPD file is located at: <install_dir>/Reports/rpd/UtilitiesBusinessAnalytics.rpd, where 
<install_dir> is the Oracle Utilities Analytics Dashboard Package installation directory. This RPD 
file should be copied to the Windows machine on which Oracle Business Intelligence Enterprise 
Edition 11.1.1.7.1 is installed.

Deploying the RPD file

To deploy the repository (RPD) file, follow these steps:

1. Oracle Business Intelligence Enterprise Edition 11.1.1.7.1 should have been installed on the 
Windows machine before proceeding with the steps below.

2. Launch the Administration Tool from the Start menu from the Windows machine. This is 
only available in Windows.

Start > Programs > Oracle Business Intelligence > BI Administration

3. Open the RPD in offline mode by selecting File > Open > Offline...

4. Provide the RPD password. The default password is “oracle123”.
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5. Edit the connection pools as shown below by double-clicking on them.

6. In the Init Block Connection Pool group, enter the following:

Datasource name = BI Database name

User name = DWREAD

Password = DWREAD User password

7. In the Init Block Pool - MDM group, provide the following, only for MDM:

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

8. In the Materialized Views Connection group, enter the following:

Datasource name = BI Database name
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User name =DWREAD

Password = DWREAD User password

9. In the MDM Database Connection group, provide the following, only for MDM:

Data source name = MDM database name

User name = CISUSER

Password = CISUSER User password

10. In the ODIDEV Connection Pool group, provide the following:

Data source name = BI database name

User name = DWUSER

Password = DWUSER User password

11. In the OUBI Database Connection group, provide the following:

Data source name = BI database name

User name = DWREAD

Password = DWREAD User password

12. Click Save.
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Note: Click Yes when you see the prompt 'Do you wish to check global consistency?' 
and ignore any warnings that appear after consistency check is complete.

13. Log into the OBIEE Enterprise Manager.

14. Navigate to BI Instance > Coreapplication > Deployment.

15. Lock and edit.

The repository text box is enabled.

16. Browse to the modified rpd file and submit. 

17. Provide the RPD password as “oracle123”. Click Apply.

18. Activate the changes and then restart the Oracle Utilities Analytics services.

Note: All the above databases set in the connection pool should be updated in 
tnsnames.ora file in <OBIEE_INSTALL_DIR>/Oracle_BI1/network/
admin.

Deploying Web Catalog
To deploy the web catalog, follow these steps:

1. Go to <Catalog location>/root/shared and delete all contents except any customized catalog 
files.

2. Go to <Catalog location>/root/system, and remove spatial metadata and spatialmetadata.atr 
contents.

Note: Login to the Enterprise Manager, navigate to Coreapplication > 
Deployment >Repository for viewing the catalog location. At the bottom, 
you will see the catalog location.

For UNIX:

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the command:

 ./splenviron.sh -e <envname> 

3. cd $SPLEBASE/bin.

4. Run ksh ./deploycatalog.sh.

5. Enter the location of the physical catalogs configured in Enterprise Manager.

Note: Login to the Enterprise Manager, navigate to Coreapplication > 
Deployment >Repository for viewing the catalog location. At the bottom, 
you will see the catalog location.

For Windows:

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run the deploycatalog.cmd.

5. Enter the location of the physical catalogs configured in Enterprise Manager. 

Note: Login to the Enterprise Manager, navigate to Coreapplication > Deployment 
>Repository for viewing the catalog location. At the bottom, you will see the catalog 
location.
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Configuring and Deploying MapViewer
To configure and deploy the MapViewer, follow these steps:

• Configuring MapViewer

• Modifying instanceconfig.xml

• Deploying Custom MapViewer

Configuring MapViewer
To configure the MapViewer, follow these steps:

1. Login to WebLogic console.

2. In the WebLogic console, create the 'MAP_DS' datasource.

3. Lock and edit.

4. Navigate to Services > Data Sources.

5. Select New > Generic Data Source, and provide the following details:

Name = MAP_DS

JNDI Name = MAP_DS

Database Type = oracle

6. Click Next.

7. Enter the following:

Database Driver = XA thin database driver

8. Click Next.

9. Enter the following connection properties:

• Database Name: BI Database Name

• Host Name: Database host

• Port: Database port

• Database User Name: dwadm

• Password: dwadm password

10. Click Next, and then click Finish.

11. Click Activate Changes.

12. Update the mapViewerConfig file with below mentioned tags:

File location: < OBIEE_INSTALL_DIR >/Oracle_BI1/bifoundation/jee/mapviewer.ear/

web.war/WEB-INF/conf/

File: mapViewerConfig.xml

13. If there is proxy used, insert the list of host names for all the third-party service providers in 
the security_config node.

<proxy_enabled_hosts>

elocation.oracle.com,maps.weatherbug.com,direct.weatherbug.com,api.wxbug.net,de.tiles.wea
therbug.com

</proxy_enabled_hosts>

14. Add the following ns_data_provider node:

<ns_data_providerid="obieeNsdp"
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class="com.oracle.utilities.birdseye.BirdseyeNSDP" />

15. Add the current map_tile_server with the following map_tile_server node.

<map_tile_server>
<tile_storage default_root_path="/mytilecache/"/>
</map_tile_server>

Modifying instanceconfig.xml
Update the instanceconfig.xml file after taking a backup.

The following are the examples of location of instanceconfig.xml file.

For UNIX:

<OBIEE_INSTALL_DIR>/instances/instance1/config/ 
OracleBIPresentationServicesComponent/coreapplication_obips1

For Windows:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentatio
nServicesCo mponent\coreapplication_obips1

Perform the following changes to instanceconfig.xml file:

1. Update the security node with the following values. If the security node is not present, add 
the following code before </Serverinstance>:

<Security>
<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
<HttpOnlyCookies>false</HttpOnlyCookies>
<CookieDomain />
<CookiePath>/</CookiePath>
</Security>

2. Update the following <ServerInstance> element:

<LightWriteback>true</LightWriteback>

3. Add the following before the end tag </ServerInstance>:

<UI>
<DefaultStyle>oubi</DefaultStyle>
<DefaultSkin>oubi</DefaultSkin>
</UI>

4. Add the following lines in between the <ServerInstance> </ServerInstance> tags:

<Prompts> 
<MaxDropDownValues>256</MaxDropDownValues> 
<AutoApplyDashboardPromptValues>true</

AutoApplyDashboardPromptValues> 
<AutoSearchPromptDialogBox>true</AutoSearchPromptDialogBox> 
<AutoCompletePromptDropDowns> 
<SupportAutoComplete>true</SupportAutoComplete> 
<CaseInsensitive>true</CaseInsensitive> 
<MatchingLevel>MatchAll</MatchingLevel> 
<ResultsLimit>50</ResultsLimit> 
</AutoCompletePromptDropDowns> 
</Prompts>
Oracle Utilities Analytics Initial Installation 5-61 
Oracle Utilities Analytics Installation Guide



Deploying Custom MapViewer
To deploy the custom MapViewer, follow these steps:

For UNIX:

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run ksh ./deploymapviewer.sh.

5. Enter the WebLogic Domain Console Password. For example, weblogic123.

For Windows:

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run the deploymapviewer.cmd.

5. Enter the WebLogic Domain Console password. For example, weblogic123.

After Deploying Custom MapViewer

Perform the following steps after deploying the custom MapViewer:

1. Update MapViewer configuration by navigating to MapViewer > Administration > 
Configuration.

2. Add the below content in the mapViewerConfig.xml with appropriate parameters.

<DB_HOST>,<DBNAME>,<DB_PORT>,<USER>,<PASSWORD>
<map_data_source name="MAPCONN"
jdbc_host="<DB_HOST>"
jdbc_sid="<BI Database Name>"
jdbc_port="<DB_PORT>"
jdbc_user="DWADM"
jdbc_password="<DWADM>"
jdbc_mode="thin"
number_of_mappers="32"
allow_jdbc_theme_based_foi="true"
/>

3. Click Save, and then restart.

Note: The above step has to be performed each time after running the 
deploymapviewer command.

Deploying Write Back
The purpose of the write back templates is to allow the user to configure Administrative 
dashboards. This is mandatory for the Admin Dashboard functionality to work.

To deploy the write back feature, follow these steps:

For UNIX: 
Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.
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3. cd $SPLEBASE/bin.

4. Run the ksh ./deploywriteback.sh.

For Windows: 
Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%/bin.

4. Run the deploywriteback.cmd.

Enabling Analytics Help
To enable the Analytics' Help, follow these steps:

1. Download Oracle Utilities Analytics for Oracle Utilities Extractors and Schema and Oracle Utilities 
Analytics Dashboards User's Guide from the Oracle Software Delivery Cloud (https://
edelivery.oracle.com).

2. After downloading Oracle Utilities Analytics for Oracle Utilities Extractors and Schema and Oracle 
Utilities Analytics Dashboards User's Guide, change the name of the Help file to OUA Help.pdf. 
Now, place the Help file in the $SPLEBASE/Skin/res directory.

3. Run the following commands:

For UNIX: 
Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run the ksh ./deployanalyticsear.sh.

5. Enter the WebLogic Domain Console password. For example, weblogic123.

For Windows: 
Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%/bin.

4. Run the deployanalyticsear.cmd.

5. Enter the WebLogic Domain Console Password. For example, weblogic123

6. Restart the Analytics core services.

7. Restart the WebLogic and all Analytics services after the Oracle Business Intelligence 
Enterprise Edition deployment is completed.

8. Log into Analytics and navigate to Administration > Manage Privileges > Write 
Back > Write Back to Database. 

9. Click Denied:Authenticated User and select Granted.

Enabling Auto Complete Feature on Oracle Business Intelligence Enterprise Edition 
11.1.1.7.1

Perform the following steps: 

1. Restart the Oracle Business Intelligence Enterprise Edition admin server, managed server 
and opmn services.
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Note: Refer to Oracle Business Intelligence Enterprise Edition documentation 
for detailed instructions on how to start and stop the admin server, managed 
server and opmn services.

2. Log into the Analytics (http://<Server>:<port>/analytics).

3. Click on the Weblogic User (top-right of the page). 

4. From the drop-down menu, select My Account. 

5. Set Prompt Auto Complete to ON and click OK.

Oracle Utilities Analytics Admin Tool Component
This is only applicable for users installing the Oracle Data Integrator based ELT. Oracle Utilities 
Analytics Admin tool is based on Oracle Application Express. 

Note: For detailed instructions on how to set up the Admin tool, refer to the 
chapter Installing the Oracle Utilities Analytics Admin Tool. Also, refer to 
Oracle Utilities Analytics for Oracle Utilities Extractors and Schema and Oracle Utilities 
Analytics Dashboards Administration Guide for the details. 

Checklist After the Installation
Ensure that the following tasks are performed after installing Oracle Utilities Analytics version 
2.5.0:

1. For Oracle Utilities Analytics ETL related post-installation tasks, see Oracle Utilities 
Analytics ELT Component Installation based on Oracle Data Integrator Installation. 
Schedule the B1_run_ALL SCENARIO. 

2. For Oracle Utilities Analytics Dashboard related post-installation tasks, see Oracle Utilities 
Analytics Dashboard Component Installation.

3. For configuring the mapping and other parameters, refer to Oracle Utilities Analytics for Oracle 
Utilities Extractors and Schema and Oracle Utilities Analytics Dashboards Administration Guide.

4. Start the File Processor daemon. 

5. Verify install and deploy logs:

• MDL Import Logs: 
<INSTALL_DIR>/OWB/MetadataFiles/SPL-BI-Project_imp.log  
<INSTALL_DIR>/OWB/MetadataFiles/SPL-BI-Location_imp.log

• OWB deploy logs: 
<INSTALL_DIR>/logs/system/log_OWBDeployment_YYYYMMDD_####.txt 

• Custom Mapviewer deploy logs: 
<INSTALL_DIR>/logs/system/mapviewerdeploy.sh.log

• WriteBack logs: 
<INSTALL_DIR>/logs/system/Writeback.log

• FileProcessorDaemon logs: 
<INSTALL_DIR>/bin/FileProcessorDaemon.log

6. Log into the Oracle Business Intelligence Enterprise Edition Analytics link pointing to the 
demo database. The dashboard should display data with no errors.
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Chapter 6 
Upgrading Oracle Utilities Analytics for Oracle 

Utilities Extractors and Schema and Oracle 
Utilities Analytics Dashboards

This chapter provides instructions for upgrading to Oracle Utilities Analytics (OUA) installation 
version 2.5.0.

• Supported Upgrade Paths

• Upgrading Oracle Utilities Analytics for Oracle Utilities Customer Care and Billing

• Upgrade Procedure

• Checklist After the Installation

Supported Upgrade Paths
Direct upgrade to Oracle Utilities Analytics version 2.5.0 is supported from the following 
versions:

• Oracle Utilities Analytics version 2.4.0.4

Important Note: For upgrading from a version not supported by direct 
upgrade path, the product must be first upgraded to Oracle Utilities Analytics 
v2.4.0.4, and then upgraded to Oracle Utilities Analytics v2.5.0.

Upgrading Oracle Utilities Analytics for Oracle Utilities Customer 
Care and Billing

This section provides detailed steps to upgrade Oracle Utilities Analytics where Oracle Utilities 
Customer Care and Billing (CC&B) is one of the source systems. Users who do not have Oracle 
Utilities Customer Care and Billing as one of the source systems can skip this section completely 
and follow instructions in the next section for upgrading to Oracle Utilities Analytics 2.5.0.

As of the current 2.5.0 release, the ETL methodology for Oracle Utilities Customer Care and 
Billing is being moved from Oracle Warehouse Builder to Oracle Data Integrator. Following these 
steps will ensure minimal downtime for the source application and no data loss while moving 
from Oracle Warehouse Builder based Extract, Transform, and Load (ETL) to Oracle Data 
Integrator based Extract, Load and Transform (ELT).
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The following are the various phases of the upgrade process:

• Prerequisites for Upgrade

• Phase 1: Preparing the Source and the Target systems

• Phase 2: Last Load Using Oracle Warehouse Builder ETL Jobs and Oracle 
GoldenGate Sync Startup

• Phase 3: Data Warehouse Upgrade and Startup of Oracle Data Integrator ELT Jobs

• Phase 4: Upgrade the Oracle Business Intelligence Enterprise Edition Components

Prerequisites for Upgrade
The prerequisite are as follows:

1. Oracle Utilities Customer Care and Billing source application must be at version 2.4.0.1

2. Oracle Utilities Analytics must be at version 2.4.0.4.

3. Oracle Utilities Analytics database including Oracle Warehouse Builder must be upgraded to 
11.2.0.3 version of database, if not on 11.2.0.3. Do not delete the old Oracle home until and 
unless all upgrade steps have been executed. After upgrading Oracle Warehouse Builder to 
11.2.0.3, login to Oracle Warehouse Builder client and deploy all the workflows.

Note 1: Refer to the Oracle database documentation to upgrade the database 
and Oracle Warehouse Builder to 11.2.0.3 version.

Note 2: To deploy workflow, login to Oracle Warehouse Builder client with 
BIREPOWN/<BIREPOWN password> credentials. Expand the SPL_BI 
project and select the database.

To deploy workflow, perform the following steps:

1. Go to the tool, and click on Control Center Manager. 

2. Provide <BIREO user password>, and click OK.

3. Expand the SPL_BI_WF_LOC.

4. Expand the SPL_BI_WF.

5. Select each component, such as DIM. Right-click, and select Set Action 
>Replace.

6. Select component, such as DIM again. Right- click, and select Deploy.

7. Repeat the steps 5 and 6 for all remaining components, such as DIM2, etc.

Phase 1: Preparing the Source and the Target systems
This phase consists of tasks that can be carried out without requiring downtime of source Oracle 
Utilities Customer Care and Billing application. The following are the tasks: 

1. Install JDK 1.6.0 (20 or above), Oracle WebLogic 10.3.6, Oracle Data Integrator 11.1.1.6 with 
Java EE software products on Oracle Utilities Analytics database server.

2. Ensure to create users in the database with the following names: DWADM, DWUSER, 
DWREAD, MDADM, RELADM, SPLADM, SPLUSER, SPLREAD, MASTER_REPO, 
WORK_REPO and DWSTAGE if these do not exist already, without giving specific roles.

3. Ensure to create roles with the following names: DW_USER, DW_READ, 
DW_REPLICATE, SPL_USER and SPL_READ roles if these do not exist already.

4. Connect to the sys user, execute the Usersgrants.sql in BI250/Scripts/Usersgrants.sql. 
This SQL will provide required grants to the users created above.
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5. All the steps outlined in the RELADM Schema Installation and MDADM Schema 
Installation topics of the Oracle Utilities Analytics Database Component Upgrade 
section below in this chapter.

6. All the steps outlined in the Oracle GoldenGate Setup topic of the Oracle Utilities 
Analytics ELT Component based on Oracle Data Integrator Installation section below 
in this chapter.

7. Refer to the Oracle Utilities Analytics Admin Tool Component section below to install 
the Oracle Utilities Analytics Administrator tool.

8. All the steps outlined in the Setting Permissions for Cistab File in UNIX topic of the 
Oracle Utilities Analytics ELT Component based on Oracle Data Integrator 
Installation section below in this chapter.

9. All the steps outlined in the Oracle Utilities Analytics ELT Component based on Oracle 
Data Integrator Package Installation Steps topic of the Oracle Utilities Analytics ELT 
Component based on Oracle Data Integrator Installation section below in this chapter.

10. Execute the step till the InitiateSetup of the Post-installation Tasks topic of the Oracle 
Utilities Analytics ELT Component based on Oracle Data Integrator Installation 
below in this chapter.

Important Note: The InitiateSetup step generates the GoldenGate scripts. 
Do not execute the GoldenGate scripts at this point of time.

Phase 2: Last Load Using Oracle Warehouse Builder ETL Jobs and Oracle 
GoldenGate Sync Startup

This phase involves production down time on Oracle Utilities Customer Care and Billing source 
application. The production down time is required to stop any new transactions from being made 
on the source database. Once this is ensured, data will have to be extracted using the batch jobs 
and loaded into the data warehouse.

After this the Oracle Data Integrator based ELT will be setup to start loading the Oracle Utilities 
Customer Care and Billing data going forward.

Important Note: The production downtime in the source system is 
enforced to stop any data modifications on the database. Failure to do so, 
will result in data loss in the data warehouse. 

This phase involves the following steps:

1. Run all batch jobs on the source system to extract the last set of data changes. 

The list of the batch jobs for the various Oracle Utilities Customer Care and Billing facts and 
dimensions is provided below for reference.    

Star Schema
Fact/Dimension Name CCB Batch Control Name

CD_ACCT EXTACCT

CD_ADDR EXTADDR

CD_ADJ_TYPE EXTADJT

CD_CAMPAIGN C1-CMPGN

CD_CASETYPE_STATUS EXTCTS

CD_CASE_COND EXTLKUP

CD_CC_TYPE C1-CCTTY
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CD_COLLEVT_TYPE C1-CUTET

C1-ODET

EXTSET

C1-EXTCET

CD_COLLPROC_STATUS EXTLKUP

CD_COLLPROC_TMPL EXTCPT

C1-ODPT

CD_FISCAL_CAL EXTFIPD

CD_FT_TYPE EXTLKUP

CD_GL_ACCT C1-FTGL

CD_MSG C1-MSG

CD_ORDER_CAN_RSN C1-OCNRS

CD_ORDER_STATUS EXTLKUP

CD_PAY_CAN_RSN C1-PCNRS

CD_PER EXTPER

CD_PKG C1-PCKGE

CD_PREM EXTPREM

CD_RATE EXTRATE

CD_SA EXTSA

CD_SA_STATUS EXTLKUP

CD_SQI EXTSQI

CD_TD C1-TD

CD_TD_PRIORITY EXTLKUP

CD_TD_ROLE C1-TDROL

CD_TD_SKILL C1-TDSKL

CD_TD_STATUS EXTLKUP

CD_TD_TYPE C1-TDTYP

CD_TNDR_SRCE C1-TNDCT

CD_TNDR_STATUS EXTLKUP

CD_TNDR_TYPE C1-TNDTY

CD_TOU EXTTOU

CD_UCOLEVT_TYPE EXTUET

Star Schema
Fact/Dimension Name CCB Batch Control Name
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2. Once the batch jobs have completed and the flat files are ready, move them to the Analytics 
load directory as earlier. The File Processor daemon should schedule the Oracle Warehouse 
Builder workflows to load the data in flat files into the data warehouse. It is recommended 
to wait till all the extracts have been loaded to warehouse database successfully.

Note: Make sure that the file processor is running during extracts upload.

3. The triggers on the source application will have to be disabled. These triggers formed the 
CDC (Changed Data Capture) mechanism based on which incremental changes were 
identified as a part of the older Oracle Warehouse Builder based ETL methodology.

The script to disable Oracle Utilities Customer Care and Billing triggers on the source system 
is available in the below path. Navigate to the root folder where the database package was 
unzipped.

CD_UCOLPROC_STATUS EXTLKUP

CD_UCOLPROC_TMPL EXTUCPT

CD_UOM EXTUOM

CD_USER EXTUSER

CF_ARREARS EXTSAARS

CF_BILLED_USAGE EXTBLUSG

CF_CASE EXTCASE

CF_CASE_LOG EXTCLOG

CF_CC C1-CSCNT

CF_COLL_EVT C1-CUTEV

C1-ODEV

EXTCOLEV

EXTSEVEV

CF_COLL_PROC C1-ODPR

EXTCOLPR

CF_FT EXTFIN

CF_FT_GL C1-FTGL

CF_ORDER C1-ORDER

CF_PAY_TNDR C1-PYTND

CF_RECENT_TD_ENTRY C1-RECTD

CF_SA EXTSAACC

CF_TD_ENTRY C1-TDENT

CF_UCOL_EVT EXTUNCEV

CF_UCOL_PROC EXTUNCPR

Star Schema
Fact/Dimension Name CCB Batch Control Name
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BI250/DWADM/Post-Upgrade/disable_ccb_bi_triggers.sql

Note: Login to the ADM schema of Oracle Utilities Customer Care and Billing 
application, and execute this script. 

4. For the Oracle Data Integrator ELT jobs to successfully extract and load data, certain 
parameters are required to be configured by you on the source Oracle Utilities Customer Care 
and Billing system. You will have to perform this step first before proceeding to upgrade the 
target schema.

The Analytics Configuration portal in the source Oracle Utilities Customer Care and Billing 
system allows users to do this. Navigate to Menu > Admin Menu > B > BI Configuration.

The details of the various entities in this portal and their purposes have been described in the 
detail in the Chapter 3 of Oracle Utilities Analytics for Oracle Utilities Extractors and Schema and 
Oracle Utilities Analytics Dashboards Administration Guide.

5. Once parameters have been configured in Oracle Utilities Customer Care and Billing source 
application, the initial load process can be started to copy data from the source database into 
the replication schema in the data warehouse. There are two options for this.

Proceed with the option 1, only if all of the tables being replicated are expected to have a 
volume of less than 10 million records. The list of the source tables being replicated can be 
found in the Data Mapping Guide.

Note: For the source tables list, refer to Oracle Utilities Extractors and Schema 
Data Mapping Guide for Oracle Utilities Customer Care and Billing.

Option 1: Using GoldenGate

Execute the steps mentioned in Readme.txt generated as a part of the InitiateSetup 
execution as described in the phase 1.

Note: Refer to the InitiateSetup step of the Post-installation Tasks section 
to run the GoldenGate scripts. 

Option 2: Using Database Import/Export Process

If any of the source table to be replicated is expected to be in excess of 10 million records, the 
GoldenGate process may not scale up well when dealing with such higher volumes. The 
primary reason being the GoldenGate scripts will work on individual records on a single 
threaded basis.

In such cases, it is recommended to perform the initial sync utilizing the Oracle database's 
export and import process.

Note: Refer to the steps mentioned in the section “Performing Initial Load” in the 
Appendix C of Oracle Utilities Analytics for Oracle Utilities Extractors and Schema and Oracle 
Utilities Analytics Dashboards Administration Guide.

Once the initial load is completed via the export and import process, the GoldenGate 
incremental sync process can be started to capture incremental changes.

Execute the steps mentioned in ReadMe.txt generated as a part of InitiateSetup execution 
as described in the phase 1. Since the initial load has already been done by export/import 
process, skip the commands below the header "##### FOR INITIAL LOAD ONLY 
#####".

Note: Refer to the InitiateSetup step of Post-installation Tasks section to run the 
GoldenGate scripts.

6. After the GoldenGate initial sync is completed, the downtime enforced on Oracle Utilities 
Customer Care and Billing can be lifted to allow users to perform transactions.
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Note: Before executing all the steps mentioned in ReadMe.txt as stated below, 
read the below statement carefully.

There is step in ReadMe.txt to start the initial load on the source database after 
executing them you should wait till those steps get completed. To know initial load gets 
completed on the source database, execute the below query in the source database after 
connecting to the source application ADM schema such as, CISADM.

select * from CDC_SYNC_LOG;

If the COMPLETED_ON column is not null for the current model, then the initial data 
sync is complete.

The model name is the directory name, inside which ReadMe.txt is placed.

Refer to the ReadMe.txt generated in the above-mentioned directory for the detailed 
instructions on how to run the Oracle GoldenGate scripts.

7. Execute the remaining steps of the Post-installation Tasks topic of Oracle Utilities 
Analytics ELT Component based on Oracle Data Integrator Installation section below 
in this chapter.

Note: Execute the steps after InitiateSetup.

Phase 3: Data Warehouse Upgrade and Startup of Oracle Data Integrator ELT 
Jobs

This phase involves actual schema upgrade of the target database and starting up of Oracle Data 
Integrator ELT jobs.

Before the starting the Oracle Data Integrator ELT jobs, you will also have to complete the 
necessary configurations required on the source and the target systems.

This phase involves the following tasks:

1. Perform all steps outlined in DWADM Schema Upgrade section of Oracle Utilities 
Analytics Database Component Upgrade section in this chapter.

2. Data correction script should be executed. The script to be run is OWBtoODIUpgrade.sql 
and it is located in BI250/DWADM/Post-Upgrade Connect to the target database as the 
DWADM user and run this SQL script.

3. Perform all steps outlined in Upgrading the Oracle Utilities Analytics ETL Component 
based on Oracle Warehouse Builder Package section of this chapter.

4. Start the Target GoldenGate processes.

Note: To start GoldenGate processes, navigate to GoldenGate Home and 
login using ggsci command and start the relpcat processes. Do not run the 
GoldenGate process ending with 'I'.

5. If any customizations have been done previously on the Oracle Utilities Customer Care and 
Billing extractors to populate the UDx columns for any of the facts or dimensions, the same 
will have to be copied in the new Oracle Data Integrator based ELT methodology.

For details, refer to Chapter 5: Extending Oracle Utilities Analytics in 
Oracle Utilities Analytics for Oracle Utilities Extractors and Schema and Oracle Utilities 
Analytics Dashboards Administration Guide.

6. Any change to the Oracle Data Integrator ELT metadata configuration must be done before 
starting the ELT jobs. These metadata configurations can be maintained using the Oracle 
Utilities Analytics Administration tool installed earlier as part of the step 5 in the phase 1.

Specifically refer to the following pages in the Oracle Utilities Analytics Administration tool:

• Target Entity (for scheduling related configuration).
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• Global Configuration (for global settings of the Oracle Utilities Analytics product).

Details about these screens can be found in Appendix B of the Oracle Utilities 
Analytics for Oracle Utilities Extractors and Schema and Oracle Utilities Analytics 
Dashboards Administration Guide. The chapter 3 in the same guide has detailed 
information on how to configure the Oracle Utilities Analytics product 
completely.

7. Note the last sync timestamp when the data was synced up from the source Oracle Utilities 
Customer Care and Billing system using the below query on the target database:

select max(COMPLETED_ON) from ccb1rep.CDC_SYNC_LOG;
8. The ELT jobs for the existing Oracle Utilities Customer Care and Billing facts and dimension 

should be updated to start the data load after the timestamp of the last set of data loaded via 
the Oracle Warehouse Builder based ETL in the phase 2.

Use the below query on the target database to update the timestamp on the ETL jobs. Use 
the timestamp from the previous step.

update MDADM.B1_JOB_CONFIG 
set SLICE_START_DTTM = <timestamp from Step 7> 
where PROD_FLG = 'CCB'
and TARGET_ENTITY_ID in (
select TARGET_ENTITY_ID from MDADM.B1_TARGET_ENTITY 
where ENTITY_NAME not in 

('CF_SA_BILLING','CF_PA','CF_PA_SNAP','CF_PAY_PLAN','CF_PAY_PLAN_SNAP'
,

'CD_BILL_CAN_RSN','CD_BILL_CYC_SCH','CD_BILL_DAY_IN_WIN',
'CD_BSEG_STATUS','CD_DAYS_LAST_FRZ_BS',
'CD_DAYS_TO_WIN_CLS','CD_INSTALLMENT_CNT','CD_MSRMT_TYPE',
'CD_PAY_METHOD','CD_PAY_PLAN_STATUS',
'CD_PAY_PLAN_TYPE','CD_PA_STATUS','CD_REC_CHARGE_AMOUNT'));

For the Arrears fact, ETL job alone, which is a snapshot fact, the timestamp should be 
updated to be on the first /or second date of the next month. For example, if the last sync 
timestamp in the step 7 is "12-NOV-2013 04:02:30", then the Arrears ETL job should have 
the timestamp as "01-DEC-2013 00:00:00".

Use the below query on the target database to update the timestamp on the ETL jobs. Derive 
the timestamp to be used based on the timestamp from the step 7.

update MDADM.B1_JOB_CONFIG 
set SLICE_START_DTTM = <First second of the next month after the 

timestamp> 
where PROD_FLG = 'CCB'
and TARGET_ENTITY_ID = (
select TARGET_ENTITY_ID from MDADM.B1_TARGET_ENTITY 
where ENTITY_NAME = 'CF_ARREARS');

Note: The above queries will not update the timestamp for the ELT jobs of the 
new Oracle Utilities Customer Care and Billing facts and dimensions. This is 
because these tables will have to be loaded from the start. So the default slice 
timestamp populated on these jobs will be left as is.

9. Follow the steps outlined in the Generating Security and Starting Oracle Data Integrator 
Schedule topic of the Oracle Utilities Analytics ELT Component based on Oracle 
Data Integrator Installation section below in this chapter.

10. Start jobs the Oracle Data Integrator ELT jobs using the Oracle Utilities Analytics 
Administration tool. 

Note: Refer to the Job Configuration section in the Appendix B of Oracle 
Utilities Analytics for Oracle Utilities Extractors and Schema and Oracle Utilities 
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Analytics Dashboards Administration Guide. The Enable Jobs page will help to 
mass enable the ELT jobs for a specific source product instance.

Phase 4: Upgrade the Oracle Business Intelligence Enterprise Edition 
Components

Perform all steps outlined in the section Oracle Utilities Analytics Dashboard Component 
Upgrade of this chapter. 

Upgrade Procedure
To upgrade to Oracle Utilities Analytics 2.5.0 users must upgrade to Oracle Utilities Advanced 
Spatial and Operational Analytics 2.4.0.4 if it is on different version of product.

This section describes the procedure to upgrade Oracle Utilities Analytics version 2.5.0:

• Oracle Utilities Analytics Database Component Upgrade

• Oracle Utilities Analytics ELT Component based on Oracle Data Integrator 
Installation 
(applicable only if you have installed Oracle Utilities Operational Device Management, or 
Oracle Utilities Customer Care and Billing).

• Oracle Utilities Analytics ETL Component based on Oracle Warehouse Builder 
Upgrade 
(applicable only if you have installed any one of the edge applications such as, Oracle Utilities 
Network Management System, Oracle Utilities Work and Asset Management, Oracle Utilities 
Mobile Workforce Management, or Oracle Utilities Meter Data Management).

• Oracle Utilities Analytics Dashboard Component Upgrade

• Oracle Utilities Analytics Admin Tool Component 
(applicable only if you use Oracle Data Integrator based ELT).

Important Note: If you are upgrading from previous release of Oracle Utilities 
Customer Care and Billing, you may have to follow the steps in a certain 
sequence. Refer to the section Upgrading Oracle Utilities Analytics for 
Oracle Utilities Customer Care and Billing for the exact steps for the 
upgrade.

Oracle Utilities Analytics Database Component Upgrade
This section describes the upgrade installation of the database. Upgrade the database to 
AL32UTF8 character set if database is not in AL32UTF8 character set. The following topics are 
discussed in this section:

• Upgrading Database Software Version

• Copying and Decompressing Install Media

• Creating Users and Tablespaces

• RELADM Schema Installation

• MDADM Schema Installation

• DWADM Schema Upgrade

• Upgrading the Oracle Database

• Spatial Configuration

• Generating Database Statistics
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Upgrading Database Software Version
It is recommended to upgrade database software and Oracle Warehouse Builder version to 
11.2.0.3, and not to delete the old Oracle home until all the upgrade steps are executed.

Copying and Decompressing Install Media
To copy and then decompress the install media, follow these steps:

1. Download the Oracle Utilities Analytics version 2.5.0 Oracle Database part (Oracle Utilities 
Analytics V2.5.0 Oracle Database Multiplatform.zip) from the Oracle Software Delivery 
Cloud (https://edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred to below as 
<TEMPDIR>). This directory must be located outside any current working Oracle Utilities 
application environment. All files that are placed in this directory as a part of the installation 
can be deleted after completing a successful installation.

3. Unzip Oracle Utilities Analytics V2.5.0 Oracle Database Multiplatform.zip to <TEMPDIR> 
using any zip utility.

4. Unzip the zip file <TEMPDIR>/OUA-V2.5.0-Database-Multiplatform.zip using any zip 
utility.

Creating Users and Tablespaces
The following are the steps to be followed for creating users and tablespaces required:

1. Ensure to create users in the database with the following names: DWADM, DWUSER, 
DWREAD, MDADM, RELADM, SPLADM, SPLUSER, SPLREAD, MASTER_REPO, 
WORK_REPO and DWSTAGE if these do not exist already, without giving specific roles.

2. Ensure to create roles with the following names: DW_USER, DW_READ, 
DW_REPLICATE, SPL_USER and SPL_READ roles if these do not exist already.

3. Connect to the sys user, execute the Usersgrants.sql in BI250/Scripts/Usersgrants.sql. This 
SQL will provide required grants to the users created above.

RELADM Schema Installation
The RELADM schema is a metadata schema that consists of database objects used for storing 
product version and component installation information.

This section describes the initial installation of RELADM schema. The process prompts you for 
the names of three database users:

• A user that owns the application schema. Provide value: RELADM.

• A user that has the read-write (select/update/insert/delete) privileges to the objects in the 
application schema. There is no need to provide any value here, just press Enter to proceed.

• A user with the read-only privileges to the objects in the application schema. There is no need 
to provide any value here, just press Enter to proceed.

The process also prompts you for the following:

• A database role that has the read-write (select/update/insert/delete) privileges to the objects 
in the application schema. There is no need to provide any value here, just press Enter to 
proceed.

• A database role with the read-only privileges to the objects in the application schema. There is 
no need to provide any value here, just press Enter to proceed.

• Location for jar files (the Jar files are bundled with the database package).

Java Home. For example: C:\Java\jdk1.6.0_18.
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Review Storage.par
The storage.par file (that comes with the product and is in location ..\BI250\RELADM\Install-
Upgrade) allocates all base tables and indexes to the default tablespace CISTS_01. If you decide to 
allocate some tables or indexes outside of the default tablespace, then this has to be reflected in 
the storage.par file by changing the tablespace name from the default value to a custom value, 
according to the format shown below:

Object Type:Object Name:Tablespace name:Parallel:Comments

Where Parallel defines the number of threads that the Oracle database server uses to access a table 
or to create an index. The default value is 1.

Note: If database does not have CISTS_01 tablespace, or RELADM user 
do not have quota on CISTS_01 tablespace, you must edit the tablespace 
name in Storage.par to tablespace name on which RELADM has quota.

Installing the RELADM Schema
Perform the following steps to install the RELADM schema:

Note: Ensure CDXDBI.exe (in step below) is run from a Window desktop that 
has the Oracle 11.2.0.3 32 bit client and Java Development Kit Version 6.0 
Update 20 or later. Ensure that tnsnames.ora file of the Oracle client is updated 
with the entry for target database to connect to the target database.

1. Run CDXDBI.exe from ..\BI250\RELADM\Install-Upgrade. Run the utility from 
command prompt. The utility prompts you to enter values for the following parameters:

• Name of the target database:<DB NAME>

• Password for the system user account in the database (in silent mode)

• Name of the owner of the Database Schema: RELADM

• Location of Java Home: <..\jdk1.6.0_20>

• Location of TUGBU Jar files: <..\BI250\RELADM\Jarfiles>

• Password for the user (in silent mode): <RELADM user password>

• Oracle user with the read-write privileges to the database schema: No input needed. 
Press Enter and continue.

• Oracle user with the read-only privileges to the database schema: No input needed. Press 
Enter and continue.

• Oracle database role with the read-write privileges to the database schema: No input 
needed. Press Enter and continue.

• Oracle database role with the read-only privileges to the database schema: No input 
needed. Press Enter and continue.

2. The utility creates schema and system data definitions.

If an error occurs while executing an SQL or another utility, it logs and displays the error 
message and allows you to re-execute the current step.

Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before 
using the database, generate the statistics for these new objects:

Connect to the sys user and execute the command: 

execute DBMS_STATS.GATHER_SCHEMA_STATS('RELADM');
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MDADM Schema Installation
The MDADM schema is a metadata schema that consists of database objects used for storing 
metadata of Oracle Utilities Analytics. For example ETL job execution status, target tables for 
ETL, Oracle GoldenGate configuration details, etc.

This section describes the initial installation of MDADM schema. The process prompts you for 
the names of three database users:

• A user that owns the application schema. Provide value: MDADM.

• A user that has the read-write (select/update/insert/delete) privileges to the objects in the 
application schema. There is no need to provide any value here, just press Enter to proceed.

• A user with the read-only privileges to the objects in the application schema. There is no need 
to provide any value here, just press Enter to proceed.

The process also prompts you for the following:

• A database role that has the read-write (select/update/insert/delete) privileges to the objects 
in the application schema. There is no need to provide any value here, just press Enter to 
proceed.

• A database role with the read-only privileges to the objects in the application schema. There is 
no need to provide any value here, just press Enter to proceed.

• Location for jar files (the Jar files are bundled with the database package).

 Java Home. For example: C:\Java\jdk1.6.0_18.

Review Storage.par
The storage.par file (that comes with the product and is in location ..\BI250\MDADM\Install-
Upgrade) allocates all base tables and indexes to the default tablespace CISTS_01. If you decide to 
allocate some tables or indexes outside of the default tablespace, then this has to be reflected in 
the storage.par file by changing the tablespace name from the default value to a custom value, 
according to the format shown below:

Object Type:Object Name:Tablespace name:Parallel:Comments

Where Parallel defines the number of threads that the Oracle database server uses to access a 
table, or to create an index. The default value is 1.

Note: If database does not have CISTS_01 tablespace, or MDADM user 
do not have quota on CISTS_01 tablespace, you must edit the tablespace 
name in Storage.par to tablespace name on which MDADM has quota.

Installing the MDADM Schema
Perform the following steps to install the MDADM schema:

Note: Ensure CDXDBI.exe (in step below) is run from a Window desktop 
that has the Oracle 11.2.0.3 32 bit client and Java Development Kit Version 6.0 
Update 20 or later. Ensure that tnsnames.ora file of the Oracle client is updated 
with the entry for the target database to connect to the target database.

1. Run CDXDBI.exe from ..\BI250\ MDADM\Install-Upgrade. Run the utility from 
command prompt. The utility prompts you to enter values for the following parameters:

• Name of the target database:<DB NAME>

• Password for the system user account in the database (in silent mode)

• Name of the owner of the Database Schema: MDADM

• Location of Java Home: <..\jdk1.6.0_20>

• Location of TUGBU Jar files: <..\BI250\MDADM\Jarfiles>

• Password for the user (in silent mode): <MDADM user password>
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• Oracle user with the read-write privileges to the database schema: No input needed. 
Press Enter and continue.

• Oracle user with the read-only privileges to the database schema: No input needed. Press 
Enter and continue.

• Oracle database role with the read-write privileges to the database schema: No input 
needed. Press Enter and continue.

• Oracle database role with the read-only privileges to the database schema: No input 
needed. Press Enter and continue.

2. The utility creates schema and system data definitions.

If an error occurs while executing an SQL or another utility, it logs and displays the error 
message and allows you to re-execute the current step.

Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before 
using the database, generate the statistics for these new objects:

Connect to the sys user and execute the command: 

execute DBMS_STATS.GATHER_SCHEMA_STATS('MDADM');

DWADM Schema Upgrade
The DWADM schema contains the star schema objects, such as facts and dimensions that contain 
all the data of the data warehouse.

This section describes how to upgrade an existing Oracle Utilities Analytics target schema to 
Oracle Utilities Analytics v2.5.0. The upgrade process prompts you for the names of three 
database users:

• A user who owns the application schema. For example, DWADM.

• A user with the read-write (select/update/insert/delete) privileges to the objects in the 
application schema. The application will access the database as this user. For example, 
DWUSER.

• A user with the read-only privileges to the objects in the application schema. For example, 
DWREAD.

The upgrade process also prompts you for the following:

• A database role that has the read-write (select/update/insert/delete) privileges to the objects 
in the application schema. The application will access the database as. For example, the 
DW_USER.

• A database role with the read-only privileges to the objects in the application schema. For 
example, DW_READ.

• Location for jar files. (The Jar files are bundled with the database package.).

Java Home. For example, C:\Java\jdk1.6.0_18

Review Storage.par
The storage.par file (that comes with the product and is in location ..\BI250\DWADM\Install- 
Upgrade) allocates all base tables and indexes to the default tablespace CISTS_01. If you decide to 
allocate some tables or indexes outside of the default tablespace, then this has to be reflected in 
the storage.par file by changing the tablespace name from the default value to a custom value, 
according to the format shown below:

Object Type:Object Name:Tablespace name:Parallel:Comments

Where Parallel defines the number of threads that the Oracle database server uses to access a 
table, or to create an index. The default value is 1.
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Note: If database does not have CISTS_01 tablespace, or DWADM user 
does not have quota on CISTS_01 tablespace, you must edit the 
tablespace name in Storage.par to tablespace name on which DWADM 
has quota.

Upgrading the Oracle Database
To upgrade the Oracle database, perform the following steps:

Note: Ensure CDXDBI.exe (in step below) is run from a Window desktop that 
has the Oracle 11.2.0.3 32 bit client and Java Development Kit Version 6.0 
Update 20 or later. Ensure that the tnsnames.ora file of the Oracle client is 
updated with the entry for target. 

1. Run CDXDBI.exe from..\BI250\DWADM\Install-Upgrade. Run this utility from the 
Command Prompt. The utility prompts you to enter values for the following parameters:

• Name of the target database:<DB NAME>

• Password for the SYSTEM user account in the database (in silent mode) 

• Name of the owner of the Database Schema: DWADM

• Location of Java Home: <..\jdk1.6.0_20>

• Location of TUGBU Jar files: <..\BI250\DWADM\Jarfiles> 

• Password for the user (in silent mode): <DWADM user password>

• Oracle user with read-write privileges to the Database Schema: DWUSER

• Oracle user with read-only privileges to the Database Schema: DWREAD

• Oracle database role with read-write privileges to the Database Schema: DW_USER 

• Oracle database role with read-only privileges to the Database Schema: DW_READ

2. If you chose to continue, CDXDBI first checks for the existence of each of the users 
specified and prompts for their password, default tablespace, and temporary tablespace if 
they do not exist.

3. After setting up roles and users, the utility continues upgrading schema and system data 
definitions. If an error occurs while executing an SQL or another utility, it logs and displays 
the error message and allows you to re-execute the current step.

Spatial Configuration
Note: See Spatial Configuration to configure spatial data if application is not 
already configured.

This section describes how to load spatial metadata in the USER_SDO* tables for Oracle 
Utilities Analytics. If spatial data is already configured in application, follow the steps below. 

Use the following procedure to load spatial metadata in the target database:

Loading Spatial Metadata in the Target Database

1. Create the dump_dir directory in the database and copy user_sdo.dmp file from ../B1250/ 
Spatial-Metadata folder to that location.

2. Import released spatial tables to the target database using the following command: 

impdp directory=dump_dir dumpfile=user_sdo.dmp logfile= 

impdp_user_sdo.log schemas=DWADM 
remap_tablespace=cists_01:<tablespace_name>

Note: Run this command from the database server.
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Note: Make sure to change the tablespace_name to the tablespace name on 
which DWADM has the quota. If the DWADM tablespace has quota on 
cists_01 tablespace, then exclude whole remap_tablespace clause from the 
command.

3. Review the impdp_user_sdo.log file to ensure the tables were imported successfully.

4. After importing the tables, run the following SQL scripts in the command prompt from ../
B1250/Spatial-Metadata folder:

• sqlplus dwadm/<dwadm user password>@database-name @copy_spatial_metadata.sql

• sqlplus dwadm/<dwadm user password>@database-name @clean_sdo_release_tbls.sql

5. Review the log files. 

Generating Database Statistics
During an install process, new database objects may be added to the target database. Before 
starting to use the database, generate the statistics for these new objects.

Oracle Utilities Analytics ELT Component based on Oracle Data Integrator 
Installation

Note 1: Ensure that the same Operating System (OS) user is used to install the 
Oracle Utilities Analytics ETL component that is used to install all the related 
software. Refer to section Prerequisite Software.

Note2: You must install the Oracle Utilities Analytics ELT component based 
on Oracle Data Integrator (ODI) only if you are using Oracle Utilities 
Operational Device Management or Oracle Utilities Customer Care and Billing 
as the source applications.

Note 3: Oracle Utilities Operational Device Management (ODM), or Oracle 
Utilities Customer Care and Billing (CC&B) application set up is a prerequisite 
in order to install Oracle Data Integrator based ELT component. The source 
applications should be setup with the required configurations before 
proceeding with the Oracle Data Integrator based ELT component installation 
in order to successfully extract data from them to Oracle Utilities Analytics.

Refer to the chapter Configuring Oracle Utilities Operational Device 
Management for Business Intelligence in Oracle Utilities Extractors and 
Schema for Oracle Utilities Operational Device Management Data Mapping Guide.

Refer to the chapter Configuring Oracle Utilities Customer Care and 
Billing for Business Intelligence in Oracle Utilities Extractors and Schema for 
Oracle Utilities Customer Care and Billing Data Mapping Guide.

This section describes how to install the ELT component of Oracle Utilities Analytics. The section 
includes the following:

• Oracle GoldenGate Setup

• Copying and Decompressing Install Media

• Setting Permissions for Cistab File in UNIX

• Oracle Utilities Analytics ELT Component based on Oracle Data Integrator Package 
Installation Steps

• Post-installation Tasks

• Generating Security and Starting Oracle Data Integrator Schedule
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Oracle GoldenGate Setup
Note 1: This section describes what setups are required in Oracle GoldenGate 
to work with Oracle Utilities Analytics. For installing Oracle GoldenGate, refer 
to its installation document.

Note 2: You should install the Oracle Utilities Analytics ELT component based 
on Oracle Data Integrator (ODI) only if you are using Oracle Utilities 
Operational Device Management, or Oracle Utilities Customer Care and Billing 
as the source application.

Download Oracle GoldenGate 11.2.1.0.5_2 from My Oracle Support (https://
support.oracle.com/).

Set up Oracle GoldenGate on the source and the target database servers. This section describes 
the following:

• Source Database Server GoldenGate Setup

• Target Database Server GoldenGate Setup

Source Database Server GoldenGate Setup
Perform the below steps for setting up the source database server: 

Setting up the Source Database GoldenGate Server

1. Create a directory on source database server.  
For example:  ../GoldenGateHome. This will be the Oracle GoldenGate home 
(OGG_Home) on the source database server.

Important Note: Make a note of this directory location; it will be used during 
Oracle Utilities Analytics installation.

2. Copy the GoldenGate software in the above created directory. 

3. Unzip the GoldenGate software. It extracts into a tar file:  
tar -xvof <tar file>

4. Open a Command window and set the source ORACLE_SID and ORACLE_HOME 
variables.

Set LD_LIBRARY_PATH using the following commands:

For Unix:

export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH

For Windows:

set LD_LIBRARY_PATH=%ORACLE_HOME%/lib:%LD_LIBRARY_PATH%

5. In the Command window, change directory to GoldenGate home directory and execute the 
command shown below:

For Unix:

./ggsci

For Windows:

ggsci

This opens the GoldenGate prompt.

6. On the GoldenGate prompt, execute the create SUBDIRS command.

7. On the GoldenGate prompt, execute the EDIT PARAMS mgr command. This command 
opens the editor.

8. Copy the below contents: 
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• PORT 7830

• DYNAMICPORTLIST 7830-7880

Note 1: Make sure the mentioned port range (7830-7880) is not in use. If they 
are in use, provide another available port range.

Note 2: Make a note of the range start and end ports numbers; it will be used 
during Oracle Utilities Analytics installation.

Note 3: Refer to Oracle GoldenGate documentation if you would like to 
configure other settings, such as Purge.

9. On the GoldenGate prompt, execute the start mgr command to start the GoldenGate 
manager process.

10. On the GoldenGate prompt, execute the info all - command to view the manager process is 
running. Exit GoldenGate by executing the exit command.             

11. Ensure that source database is in the archivelog mode.

12. Connect to the source database as sys user and execute alter database add supplemental 
log data (primary key) columns command.

13. Go to the Oracle GoldenGate home (OGG_Home) directory.

14. Connect to the database as sys user using SQL*Plus (OGG_Home should be the current 
directory while invoking SQL*Plus).

15. Create a new user, for example: ODM01SRC (this user is the Oracle GoldenGate owner) and 
make sure to assign a tablespace to this user, that is not assigned to any other user.

Important Note: Make a note of the GoldenGate Owner Username; it will be 
used during Oracle Utilities Analytics installation.

16. Execute Grant connect,resource,dba to <GoldenGate owner user created in above step>.

17. Connect to the database as sys user and create a user ODM01SRC (It is the GoldenGate 
owner) and make sure to assign tablespace that is not assigned to any other user.

For Oracle Utilities Customer Care and Billing source database, execute following 
grants:

Grant select on CISADM.F1_MST_CONFIG to < GoldenGate owner user created in 
above step>

Grant select on CISADM. F1_EXT_LOOKUP_VAL to < GoldenGate owner user 
created in above step>

Grant select on CISADM. F1_BKT_CONFIG to < GoldenGate owner user created in 
above step>

Grant select on CISADM. F1_BKT_CONFIG_VAL to < GoldenGate owner user 
created in above step>

For Oracle Utilities Operational Device Management source database, execute 
following grants:

Grant select on CISADM.F1_MST_CONFIG to < GoldenGate owner user created in 
above step>

Grant select on CISADM. F1_EXT_LOOKUP_VAL to < GoldenGate owner user 
created in above step>

Note: While executing the SQL commands in steps 17, 18 and 19, provide the 
GoldenGate owner user if prompted for.

18.  Run the command:

@marker_setup.sql
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19. Run the command:

@ddl_setup.sql
20. Run the command:

@role_setup.sql
21. Exit the SQL*Plus login and create a directory named diroby inside OGG_Home directory.

Target Database Server GoldenGate Setup
Perform the following steps to setup the target database server for GoldenGate: 

Setting Up the Target Database Server for GoldenGate

1. Create a directory on the target database server.  
For example: ../GoldenGateHome. This will be the Oracle GoldenGate home 
(OGG_Home) on the target Oracle Utilities Analytics database server.

Important Note: Make a note of this directory location; it will be used during 
Oracle Utilities Analytics installation.

2. Copy the GoldenGate software in the above created directory.

3. Unzip the GoldenGate Software. It will extract into a tar file: 
tar -xvof <tar file>

4. Open a Command window and set the target ORACLE_SID and ORACLE_HOME 
variables.

Set LD_LIBRARY_PATH using the following commands:

For Unix:

export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH

For Windows:

set LD_LIBRARY_PATH=%ORACLE_HOME%/lib:%LD_LIBRARY_PATH%

5. In the Command window, change directory to GoldenGate home directory and execute the 
command shown below:

For Unix:

./ggsci

For Windows:

ggsci

This opens the GoldenGate prompt.

6. On the GoldenGate prompt, execute the create SUBDIRS command.

7. On the GoldenGate prompt, execute the EDIT PARAMS mgr. It opens an editor.

8. Copy the below contents:

• PORT 7830

• DYNAMICPORTLIST 7830-7880

Note 1: Make sure the mentioned port range (7830-7880) is not in use. If they 
are in use, provide another available port range.

Note 2: Make a note of the range start and end ports numbers; it will be used 
during Oracle Utilities Analytics installation.

Note 3: Refer to Oracle GoldenGate documentation if you would like to 
configure other settings, such as Purge.
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9. On the GoldenGate prompt, execute the start mgr command to start the GoldenGate 
Manager process.

10. On the GoldenGate prompt, execute the info all -command to view the manager process is 
running.

11. Exit the GoldenGate login by executing the exit command and create a directory named 
diroby inside the OGG_Home directory.

Copying and Decompressing Install Media
The Oracle Utilities Analytics ETL component based on Oracle Utilities Analytics installation file 
is delivered in zip format for both UNIX and Windows platforms. If you plan to install multiple 
Oracle Utilities Analytics environments operated by different Oracle Utilities administrator user 
IDs, you must complete each of the following installation steps for each administrator user ID.

1. Download the Oracle Utilities Analytics version 2.5.0 ELT component based on Oracle Data 
Integrator part (Oracle Utilities Analytics V2.5.0 ETL component based on ODI 
Multiplatform.zip) the Oracle Software Delivery Cloud (https://edelivery.oracle.com).

2. Log into the database server host as the Oracle Utilities Analytics administrator user ID.

3. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred to below as 
<TEMPDIR>). This directory must be located outside any current working Oracle Utilities 
application environment. All files that are placed in this directory as a part of the installation 
can be deleted after completing a successful installation.

4. Unzip Oracle Utilities Analytics V2.5.0 ETL component based on ODI 
Multiplatform.zip to <TEMPDIR>.

5. Decompress the file BI.ODI.V2.5.0-MultiPlatform.jar as follows:

•   cd <TEMPDIR>

•  jar -xvf BI.ODI.V2.5.0-MultiPlatform.jar

Note: You should have Java JDK installed on the machine used to (un)jar the 
Oracle Utilities Analytics ELT component based on Oracle Data Integrator 
installation package. Install the JDK that is supported for the install on your 
platform to be able to use the jar command.

The Java packages are located at: http://java.sun.com/products/archive/index.html. A sub- 
directory named “BI.ODI.V2.5.0” is created. It contains the installation software for the Oracle 
Utilities Analytics ELT component based on Oracle Data Integrator.

Setting Permissions for Cistab File in UNIX
Every Oracle Utilities Analytics environment installed on a server must be registered in the /etc/
cistab file located on that server. On the UNIX servers, generally only the root user ID has write 
permissions to the /etc directory. Since the installation process is run by the Oracle Administrator 
User ID, this user ID may not be able to write to /etc/ cistab table.

The install utility checks permissions, and if it identifies a lack of necessary permissions, it 
generates a script in the <TEMPDIR>/ BI.ODI.V2.5.0 directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before 
continuing with the installation process. The script initializes the cistab file in /etc directory (if it is 
the first Oracle Utilities Analytics application environment on the server) and registers a new 
environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Analytics 
Administrator User ID, so that the next time a new environment is created by the same Oracle 
Utilities Analytics Administrator User ID, you do not need to run the generated script with the 
root user ID. Instead, the install utility itself proceeds with the registration.
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If you are re-installing an existing environment, only the validation of /etc/cistab entry is done by 
the install utility, no new registration occurs. The install utility interactively instructs you about 
every step that needs to occur in each specific case. If you plan to upgrade an existing 
environment, you must ensure to take a backup prior to the installation process. The installation 
utility does not create a backup of existing environment.

Oracle Utilities Analytics ELT Component based on Oracle Data Integrator 
Package Installation Steps

This section includes: 

• Prerequisites

• Installing Oracle Utilities Analytics ELT Component on the Oracle Data Integrator

• Environment Installation Options

• Environment Configurations

Prerequisites 
Before installing the Oracle Data Integrator package, ensure that you have already installed the 
below-mentioned software products. These software products should be installed on the database 
server: 

Also, note the locations of these software products:

• JDK 1.6.0_20 (JAVA_HOME) on the database server

• Oracle Database Home (ORACLE_HOME)

• WebLogic 10.3.6 (WL_HOME)

• Oracle Data Integrator 11.1.1.6 with Java EE Installation (ODI_HOME)

• Oracle GoldenGate 11.2.1.0.5_2 Software on the Source Database Server and the Target 
Database Server (OGG_HOME) 
Download the GoldenGate 11.2.10.5_2 software from My Oracle Support (https://
support.oracle.com/).

Now, follow the below instructions to install the Oracle Utilities Analytics ELT component based 
on Oracle Data Integrator.

Installing Oracle Utilities Analytics ELT Component on Oracle Data Integrator
Follow these steps to install the Oracle Utilities Analytics ELT component based on Oracle Data 
Integrator after performing the steps to deploy the ELT Component Objects as described in the 
section above:

1. Change to the <TEMPDIR>/ BI.ODI.V2.5.0 directory.

2. Set the ORACLE_CLIENT_HOME and PATH variables as Oracle Client Perl is required to 
run the installer.

3. Make sure the user with which Oracle Database Enterprise Edition 11.2.0.3 was installed and 
all other prerequisite software products were installed, is used to install the Oracle Utilities 
Analytics ELT component based on Oracle Data Integrator package.

4. Execute the following script for UNIX/Windows:

For UNIX:

Run the following commands:

• export ORACLE_CLIENT_HOME=<ORACLE_HOME> 

• export PERL_HOME=$ORACLE_CLIENT_HOME/perl 

• export PATH=$PATH:$PERL_HOME/bin
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• Run ksh ./install.sh

Note: Ensure that you have the required execute permission on install.sh.

For Windows: 

Run the following commands:

• set ORACLE_CLIENT_HOME=<ORACLE_HOME> 

• set  PERL_HOME=%ORACLE_CLIENT_HOME%\perl

• set  PATH=%PERL_HOME%\bin;%PATH% 

• Install.cmd

5. The Oracle Utilities Analytics specific menu is displayed.

6. Select each menu item to configure the values.  
For detailed description of the values, see Configuration Worksheet for ELT Component 
based on Oracle Data Integrator Installation.

Note: For parameter 'Target GoldenGate Shared Secret', follow the below 
instructions.

a. Go to GoldenGate prompt and run the command:

encrypt password <password of MDADM user>, encryptkey DEFAULT

b. Copy the encrypted password returned by the above command and provide it as the 
value for Target GoldenGate Shared Secret.

Environment Installation Options
1. Oracle Client Home Directory:

2. Environment Mount Point: 
Log Files Mount Point:        
Environment Name:        
Web Java Home Directory:

Configure all the following items to guarantee a successful installation.  
Choose the following options from the menu (1, 2 <P> Process, <X> Exit).

Environment Configurations
1. Environment Description 

Environment Description:

2. ODI Environment Configuration: 
WEBLOGIC HOME: 
ODI HOME: 
ODI SUPERVISOR USER: SUPERVISOR 
ODI SUPERVISOR Password: sunopsis123 
Target Database Name: 
Target Database Host:  
Target Database Port: 1521 
DWADM Schema Name: DWADM 
DWADM Schema Password: <DWADM Password> 
ODI Master Schema Name: MASTER_REPO 
ODI Master Schema Password: < MASTER_REPO Password> 
ODI Work Schema Name:  
ODI Work Schema Password: 
ODI Master Repository ID: 601 
ODI Work Repository ID: 602 
MDADM Schema Name: MDADM 
MDADM Schema Password: <MDADM Password>
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3. ODI Agent Configuration 
ODI Weblogic Agent Host: 
ODI Weblogic Agent Port:

4. Target GoldenGate Configuration 
Target GoldenGate Manager Port: 
Target GoldenGate Dynamic Minimum Port: 
Target GoldenGate Dynamic Maximum Port: 
Target GoldenGate Algorithm: 
Target GoldenGate Encryptkey: 
Target GoldenGate Shared Secret: 
Target Database Home: 
Target GoldenGate Home:

Configure the items in the above list to guarantee a successful installation. Choose the 
following options from the menu item: (1, 2, 3, 4 <P> Process, <X> Exit).

After finishing the parameter setup, proceed with the option P. 

Once the installation is completed successfully, execute the post-installation steps outlined in 
Post-installation Tasks, and then the steps outlined in the Starting ODI jobs.

Post-installation Tasks
The following are the sequential deployment steps to setup the successful deployment.

• Oracle Data Integrator Deployment

• RunviewGenerator (Global)

• Configure Source

• InitiateSetup

• RunviewGenerator (For Source Context)

• WebLogic Domain Creation for Oracle Data Integrator Agent

• Starting the WebLogic Admin Server

• Authenticating Oracle Data Integrator Supervisor User in WebLogic and Starting 
Managed Server

Oracle Data Integrator Deployment 
In the Oracle Data Integrator (ODI) Deployment step, the script creates the master and work 
repositories, and imports Oracle Data Integrator metadata: 

Run the following script 

For UNIX:

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run the ksh ./deployodi.sh. 

For Windows:

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.
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4. Run the deployodi.cmd.

Verify the log at the location: <SPLEBASE>/logs/system/deployodi.log.

RunviewGenerator (Global)
This step creates global views based on Oracle Data Integrator metadata.

For UNIX:

Perform the following steps:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run ksh ./ runviewGenerator.sh.

For Windows:

Perform the following steps:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run runviewGenerator.cmd.

Verify the log at the location: <SPLEBASE>/logs/system/deployodi.log. 

Configure Source
Note: This step inserts each source instance and instance name into 
b1_prod_instance table. This step has to be repeated for each source 
instance that will be used. 

This step also creates replication schema in the target database corresponding to each source 
application. $SPLEBASE/bin/obiu.properties file is read to assign the default tablespace to 
replication user.

By default this file has obiu.repository.default.tablespace = CISTS_01 entry where CISTS_01 is 
tablespace name. If you want to assign this tablespace as default tablespace to replication schema, 
make sure to create CISTS_01 tablespace in the target database if it does not exist.

Make sure to edit obiu.repository.default.tablespace parameter in $SPLEBASE/bin /
obiu.properties file to another tablespace name, which exists in the database and would be 
considered default tablespace to the replication schema.

This entry should be changed as follows:

obiu.repository.default.tablespace = <Name of tablespace to use>

For UNIX:

Perform the following steps:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin

4. Run configureSourceDB.cmd -c <Source instance> -u < Source Golden gate owner schema 
name> -p <Source Golden gate owner Schema password> -s <Source Application Schema> 
-r <Source Application Drill Back URL>.

For Windows:
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Perform the following steps:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin

4. Run configureSourceDB.cmd -c <Source instance> -u <Source Golden gate owner schema 
name> -p <Source Golden gate owner Schema password> -s <Source Application Schema> 
-r <Source Application Drill Back URL> 

where,

• Source instance = Name for the source instance being added

For Oracle Utilities Operational Device Management source application, the valid values are 
ODM1,ODM2……..ODM9. Provide any of these values which is already not configured. 
Make a note of these parameters; it will be used in next deployment steps.

For Oracle Utilities Customer Care & Billing application, the valid values are 
CCB1,CCB2…….CCB9. Provide any of these values which are already not configured.

• Source Schema User = <GoldenGate Owner created in Source database> For example: 
ODM01SRC

• Source Schema User Password = GoldenGate Owner password

• Source Application Schema = Source Application Schema (For example, CISADM)

• Source Application Drill Back URL = Source Application URL (http://<Host>:<Port>/
ouaf/)

This opens a source configuration menu shown as below. Select each menu item to configure the 
values.

For detailed description of the values, refer to the Configuration Worksheet for ELT 
Component based on Oracle Data Integrator Installation.

Note: For parameter 'Source GoldenGate Shared Secret', follow the below 
instructions.

a. Go to GoldenGate prompt and run the command:

encrypt password <password of source GoldenGate owner user>, 
encryptkey DEFAULT

b. Copy the encrypted password returned by the above command and provide it as the 
value for Source GoldenGate Shared Secret.

Source GoldenGate Configuration 
Source Instance Name: 
Source GoldenGate Manager Port: 
Source GoldenGate Dynamic Minimum Port: 
Source GoldenGate Dynamic Maximum Port:   
Source GoldenGate Algorithm: 
Source GoldenGate Encryptkey:  
Source GoldenGate Shared Secret: Source Database Name: 
Source Database Host:  
Source Database Port:  
Source Database Home:  
Source GoldenGate Home:

Each item in the above list should be configured for a successful install. Choose option (1, <P> 
Process, <X> Exit).

Once the parameter setup is completed, proceed with option P. 
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InitiateSetup
This step is run to reverse engineered source tables, set up the Journalizing Setup, and 
create the GoldenGate scripts. This step has to be repeated for each source instance 
configured in previous step.

For UNIX:

Perform the following steps:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run the ksh ./initiateSetup.sh -c <Source instance>.

Where Source instance = Instance name given to the source in configure source step above. 
For example: ODM1

5. In $SPLEBASE/GGScriptsGen, you will find a folder created starting with instance name.

For example: ODM1AA.

6.  Go to the folder that has name starting with the instance name.

For example: $SPLEBASE/GGScriptsGen/ODM1AA

Note: Before executing all the steps mentioned in ReadMe.txt as stated below, 
read the below statement carefully.

There is step in ReadMe.txt to start the initial load on the source database after 
executing them you should wait till those steps get completed. To know initial load gets 
completed on the source database, execute the below query in the source database after 
connecting to the source application ADM schema e.g., CISADM.

select * from CDC_SYNC_LOG;

If the COMPLETED_ON column is not null for the current model, then the initial data 
sync is complete.

The model name is the directory name, inside which ReadMe.txt is placed.

Refer to the ReadMe.txt generated in the above-mentioned directory for the detailed 
instructions on how to run the Oracle GoldenGate scripts.

Note: Ensure that ORACLE_SID and, ORACLE_HOME and LD_LIBRARY_PATH are 
set before running the Oracle GoldenGate scripts on both the source and the target database 
servers.

Note: During GoldenGate script execution, there may be error related to the 
B1_CHECKPOINT table. It can be ignored.

For Windows:

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run the initiateSetup.cmd.

Where Source instance = Instance name given to the source in configure Source step above. 
For example: ODM1

5. In %SPLEBASE%/GGScriptsGen directory, you will find the folder created starting with 
instance name. 
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For example, ODM1AA.

6. Go to the folder that has name starting with the instance name.

For example, go to %SPLEBASE%/GGScriptsGen/ODM1AA

Refer to the ReadMe.txt generated in the above mentioned directory for 
detailed instructions on how to run the Oracle GoldenGate scripts.

Note: Ensure that ORACLE_SID, ORACLE_HOME and 
LD_LIBRARY_PATH are set before running the Oracle GoldenGate scripts 
on both the source and target database servers.

Note: During GoldenGate script execution, there may be error related to the 
B1_CHECKPOINT table. It can be ignored.

RunviewGenerator (For Source Context)
This step creates the views for a given source instance. These views are used for replication. This 
step needs to be executed once for each source configured.

For UNIX:

Perform the following steps:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run runviewGenerator.sh -c <Source Instance>.

For Windows:

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run ruvviewGenerator.cmd -c <Source Instance>.

Where Source instance = Instance name given to the source in configure source step above. 
For example: ODM1

WebLogic Domain Creation for Oracle Data Integrator Agent
WebLogic Domain should be created for the WebLogic Agent (ODI Agent).

Follow the below steps to bring up WebLogic ODI Agent which is created in step 1 Oracle Data 
Integrator Deployment. 

1. Go to the installed location for ODI: <MW_HOME>/Oracle_ODI1\common\bin and 
then, run the below commands for Unix and Windows. Provide the masterschema and 
workschema provided in the configuration.

For UNIX:

• Run /Config.sh

For Windows:

• Run config.cmd
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2. Create a new WebLogic domain.

Select Next. 

3. Generate a domain configured automatically to support the following products, select 
checkboxes the below plugins mentioned. When you select these plugins, there are some 
automatic plugins that get selected.

• Oracle Enterprise Manager Plugin for Oracle Data Integrator -11.1.1.0

• Oracle Data Integrator - Console - 11.1.1.0

• Oracle Data Integrator Agent - 11.1.1.0

• Oracle Data Integrator - SDK Web Services - 11.1.1.0

Then, click Next to proceed.

4. Specify the Domain Name and Location.

Provide the name: odi_domain 

Location will be default.
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Click Next to proceed.

5. Configure Admin UserName and password for WebLogic. 
Provide the WebLogic password.

Click Next. 

6. Configure Server StartUp Mode and JDK.

Select Production Mode.

Provide the JDK 1.6.0_20.
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7. Configure JDBC Component Schema.  
Select the checkbox ODI Master Schema and provide the below details:

• DBMS/Service: Target Database Name

• Host Name: Database Serverhost

• Port: Database Port

• Schema Owner: MASTER_REPO

• Schema Password: MASTER_REPO Password

8. Deselect the checkbox ODI Master Schema. 

9. Select checkbox ODI Work Schema. Provide the below details:

• DBMS/Service: Target Database Name

• Host Name: Database Serverhost

• Port: Database Port

• Schema Owner: WORK_REPO

• Schema Password: WORK _REPO Password
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Then, click Next to proceed.

10. Test JDBC Component Schema by selecting Select All and Test Connections.

 

Then, select Next to proceed. 

11. On the Select Optional Configuration page, select the following checkboxes: 

• Administration Server 

• Managed Server, Clusters and Machines
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Select Next to proceed.

12. Configure the Administration server: 

Provide the listening port, which is not in use.

Select Next to proceed.

13. Configure the Managed Servers by providing the following details: 

Name: odi_server1

Listen Address: All Local Addresses

Port: <Provide the port>, which is configured in Menu configuration of installation> ODI 
Agent Configuration >ODI WebLogic Agent Port>.
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Configure Cluster.  
Click Next to proceed.

14. Configure Machines.  
Click Next to proceed

15. Assign Servers to Machines. 
Click Next to proceed.

16. Configuration Summary. 
Click Create to create the Domain ODI_DOMAIN.

17. After the domain is created, go to Domain Location, create boot.properties file for 
WebLogic login.

18. Create the <MW_HOME>/user_projects/domains/odi_domain/servers/AdminServer/
security folder if it was not created earlier.

19. Go to <MW_HOME>/user_projects/domains/odi_domain/servers/AdminServer/
security, then create boot.properties with below values:

username=weblogic

password=Weblogic password

20. Create the <MW_HOME>/user_projects/domains/odi_domain/servers/odi_server1/
security folder if it is not present.

21. Go to <MW_HOME>/user_projects/domains/odi_domain/servers/odi_server1/security, 
then create boot.properties with below values:

username=weblogic

password=Weblogic password
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Starting the WebLogic Admin Server 
Perform the following steps: 

1. In the command shell, change directory to the directory of the WLS Home -
<MW_HOME>/user_projects/domains/odi_domain/bin

2. Execute the startweblogic command.

For Unix:

• nohup ./ startWebLogic.sh > startWebLogic.log &

For Windows:

• Run startWebLogic.cmd.

Authenticating Oracle Data Integrator Supervisor User in WebLogic and Starting Managed 
Server

Perform the following steps: 

1. Go to <MW_HOME>/oracle_common/common/bin

2. Execute the following command:

For Unix:

./wlst.sh
For Windows:

wlst.cmd
3. To connect to the running Admin server, execute the following command:

 connect('<Weblogic User>','<Weblogic password>','t3://
<WEBLOGICHOST>:<WEBLOGIC ADMIN PORT')  

For example: connect('weblogic','weblogic123','t3://localhost:7001')

4. Execute the following command to add the correct credential store for Oracle Data 
Integrator Supervisor: 

createCred (map="oracle.odi.credmap", key="SUPERVISOR", 
user="SUPERVISOR", password="<SUPERVISOR Password>", desc="ODI 
SUPERVISOR Credential")

5. To exit WebLogic Scripting Tool (WLST), execute the exit() command.

To start managed server odi_server1

Perform the following steps: 

1. Change directory to WLS Home -<MW_HOME>/user_projects/domains/odi_domain/bin 
and execute the below commands:

For Unix:

nohup ./ startManagedWeblogic.sh  odi_server1 > StartManagedWeblogic.log &

For Windows:

Run StartManagedWeblogic.cmd odi_server1

2. From the Oracle Data Integrator (ODI) Designer, click Test icon to test connectivity of your 
configured Oracle Data Integrator Java EE agent. Click OK. 

3. Close the OracleDIAgent tab.
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Generating Security and Starting Oracle Data Integrator Schedule
Perform the following steps: 

1. Edit the database name with the name of your database in OraGenSec.bat and run it from 
BI250/DWADM/Security folder.

2. Log into the Oracle Data Integrator studio and navigate to Designer > Projects > Oracle 
Utilities BI > Configuration > Scheduler'Packages.

3.  Right-click B1_INITIAL_SETUP_PKG and execute.

4. Select context global and WLS_AGENT as logical agent, and then click OK. 

5.  Go to Operator and view the logs for successful execution of package.

6. In Oracle Data Integrator Studio, navigate to Designer > Projects >Oracle Utilities BI 
> Configuration > Scheduler > Packages > B1_RUN_ALL > Scenarios > 
B1_RUN_ALL Version 001 > Scheduling.

7. Right-click on Scheduling and select New Scheduling option.

8. Select context global, agent as WLS_AGENT and log level as 1.

9. To specify how often the scheduler should run, navigate to the Execution Cycle tab of the 
Scheduler and select the 'Many Times' radio button. Set the interval between repetitions.

10. Navigate to Topology > Agents > OracleDIAgent.

11. Right-click on OracleDIAgent and click on Update Schedule.

Oracle Utilities Analytics ETL Component based on Oracle Warehouse Builder 
Upgrade

This section describes the Oracle Warehouse Builder based ETL component installation: 

• Copying and Decompressing Install Media

• Setting Permissions for cistab File in UNIX

• Configuring and Upgrading the Oracle Warehouse Builder Workspace

• Upgrading the Oracle Utilities Analytics ETL Component based on Oracle 
Warehouse Builder Package

• Post Installation Tasks

Copying and Decompressing Install Media
The Oracle Utilities Analytics ETL component based on Oracle Warehouse Builder installation 
file is delivered in zip format for both UNIX and Windows platforms. If you plan to install 
multiple Oracle Utilities Analytics environments operated by different Oracle Utilities 
Administrator user IDs, you must complete each of the following installation steps for each 
Administrator user ID.

Perform the following Steps: 

1. Download the Oracle Utilities Analytics V2.5.0 ETL Component Based on Oracle 
Warehouse Builder part (Oracle Utilities Analytics V2.5.0 ETL Component Based on 
OWB Multiplatform.zip) from the Oracle Software Delivery Cloud (https://
edelivery.oracle.com).

2. Log into the database server host as the Oracle Utilities Analytics administrator user ID 
(default cases).

3. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred to below as 
<TEMPDIR>). This directory must be located outside any current working Oracle Utilities 
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application environment. All files that are placed in this directory can be deleted after 
successful installation.

4.  Unzip Oracle Utilities Analytics V2.5.0 ETL Component Based on OWB 
Multiplatform.zip to <TEMPDIR>.

5. Decompress the file BI.OWB.V2.5.0-MultiPlatform.jar as follows:

• cd <TEMPDIR>

• jar -xvf BI.OWB.V2.5.0-MultiPlatform.jar 

Note: You should have Java JDK installed on the machine used to (un)jar the 
Oracle Utilities Analytics ETL component based on Oracle Warehouse Builder 
installation package. Install the JDK that is supported for the install on your 
platform to be able to use the jar command. 
The Java packages are located at: http://java.sun.com/products/archive/
index.html. A sub-directory named "BI.OWB.V2.5.0" is created. It contains 
the installation software for the Oracle Utilities Analytics ETL component 
based on Oracle Warehouse Builder.

Setting Permissions for cistab File in UNIX
Every Oracle Utilities Analytics environment installed on a server must be registered in the /etc/
cistab file located on that server. On UNIX servers, generally only the root user ID has write 
permissions to the /etc directory. Since the installation process is run by the Oracle Administrator 
User ID, this user ID may not be able to write to /etc/ cistab table.

The install utility checks permissions and if it identifies a lack of the necessary permissions, it 
generates a script in the <TEMPDIR>/BI.OWB.V2.5.0 directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
Oracle Utilities Analytics application environment on the server) and registers a new environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Analytics 
Administrator User ID, so that the next time a new environment is created by the same Oracle 
Utilities Analytics Administrator User ID, there is no need to run the generated script with the 
root user ID. Instead, the install utility itself proceeds with the registration.

If you are reinstalling an existing environment, only the validation of /etc/cistab entry is done by 
the install utility. No new registration occurs. The install utility interactively gives instructions 
about every step in each specific case.

If you are planning to upgrade an existing environment, ensure that you have taken a backup prior 
to the initiating the installation process. The installation utility by itself does not create a backup of 
the existing environment.

Configuring and Upgrading the Oracle Warehouse Builder Workspace
This section describes how to configure the Oracle Warehouse Builder workspace. To upgrade to 
Oracle Utilities Analytics version v2.5.0, follow these steps: 

Upgrading to Oracle Utilities Analytics v2.5.0

1. Back up the database using the backup strategy employed at your site.

2. Modify the contents of <owb_home>/owb/bin/admin/Runtime.properties file from the 
following to the contents mentioned later.

property.RuntimePlatform.0.NativeExecution.FTP.security_constraint 
= DISABLED 
property.RuntimePlatform.0.NativeExecution.Shell.security_constraint = 
DISABLED 
property.RuntimePlatform.0.NativeExecution.SQLPlus.security_constraint 
=
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DISABLED To
property.RuntimePlatform.0.NativeExecution.FTP.security_constraint 

= NATIVE_JAVA
property.RuntimePlatform.0.NativeExecution.Shell.security_constrai

nt = NATIVE_JAVA
property.RuntimePlatform.0.NativeExecution.SQLPlus.security_constr

aint = NATIVE_JAVA

3. Connect to the OWBSYS user and execute <owb-home>/owb/rtp/sql/stop_service.sql.

4. Connect to the OWBSYS user and execute <owb-home>/owb/rtp/sql/start_service.sql.

5. Connect to the database with the sys user and execute the following procedures:

EXECUTE DBMS_NETWORK_ACL_ADMIN.drop_ACL('acl_for_owb_cc.xml');
Note: Before executing below procedures, modify <SMTP SERVER> and 
<SMTP PORT> to appropriate values.

EXECUTE DBMS_NETWORK_ACL_ADMIN.CREATE_ACL('acl_for_owb_cc.xml','A 
CL for Control Center','OWBSYS', TRUE, 'connect');

EXECUTE 
DBMS_NETWORK_ACL_ADMIN.ASSIGN_ACL('acl_for_owb_cc.xml',<SMPT SERVER>, 
<SMPT PORT>);

COMMIT;

6. Execute the following:

SELECT
acl,host, 

DECODE(DBMS_NETWORK_ACL_ADMIN.check_privilege_aclid(aclid,'OWBSYS', 
'connect'),1, 'GRANTED', 0, 'DENIED', NULL) privilege

FROM dba_network_acls ;

You will see the following:

/sys/acls/acl_for_owb_cc.xml

<SMPT SERVER> 
GRANTED

7. Connect to the database as BIREPOWN user and run spl_exec_wf_prc.sql. 
spl_exec_wf_prc.sql is located at../BI250/Scripts.

8. Connect to the DWADM schema and execute spl_oms_snapshot_pkg.sql. 
spl_oms_snapshot_pkg.sql is located at ../BI250/Scripts.

9. Connect to database with sys user and execute owb_grants_synonyms.sql located in ../
BI250/Scripts.

Upgrading the Oracle Utilities Analytics ETL Component based on Oracle 
Warehouse Builder Package

Before upgrading, verify that the steps in section Prerequisite Software for Oracle Utilities 
Analytics ETL Component based on Oracle Warehouse Builder are followed.

After performing the above steps, proceed with upgrading Oracle Utilities Analytics ETL 
component based on Oracle Warehouse Builder Package steps.

Perform the following: 

1. Change to <TEMPDIR>/BI.OWB.V2.5.0 directory.

2. Set the ORACLE_CLIENT_HOME and PATH variables as Oracle Client Perl is required to 
run the installer.
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3. Follow the below steps:

• Log into the server host where Oracle Utilities Analytics ETL component based on 
Oracle Warehouse Builder Package is installed.

• Connect to the Oracle Utilities Analytics database as sys user, and restart the database.

• Go to $ORACLE_HOME/owb/rtp/sql and execute stop_service.sql and 
start_service.sql after logging as OWBSYS user.

4. Take a back up of the previously installed Oracle Warehouse Builder Package environment.

5. Log into the previously installed Oracle Warehouse Builder Package environment. Perform 
the following: 

• Go to the installed environment location e.g cd /bi_oradata_01/QABlds/
BI_CANDIDATE_BLD

• cd etc

• Open ENVIRON.INI file and get the value of SPLENVIRON variable. It will look like 
SPLENVIRON=BI_CANDIDATE_BLD . Here BI_CANDIDATE_BLD is 
environment name

• cd ../bin

• . ./splenviron.sh -e <ENVIRONMENT NAME>  e.g ./splenviron.sh -e 
BI_CANDIDATE_BLD

• cd bin

6. Run ksh ./stopFileprocessordaemon.sh to stop the running file processor.

7. Open the new terminal/window and navigate to downloaded package.

Now, proceed with Oracle Utilities Analytics 2.5.0 install 

Go to change to the <TEMPDIR>/BI.OWB.V2.5.0.

8. Execute the following script on both UNIX and Windows: 

Make sure to provide the new Oracle Home path. This is the Oracle Home path after 
upgrading to Oracle Database server to version 11.2.0.3.

For UNIX:

• export ORACLE_CLIENT_HOME=<ORACLE_HOME> 

• export PERL_HOME=$ORACLE_CLIENT_HOME/perl 

• export PATH=$PATH:$PERL_HOME/bin

• Run ksh ./install.sh

For Windows:

• set ORACLE_CLIENT_HOME=<ORACLE_HOME> 

• set PERL_HOME=%ORACLE_CLIENT_HOME%\perl

• set PATH=%PERL_HOME%\bin;%PATH% 

• Run Install.cmd

Note: On UNIX, ensure that you have the proper execute permission on 
install.sh.

9. The Oracle Utilities Analytics specific menu appears.

10. Select each Menu item to configure the values.  
For detailed description of the values, see Configuration Worksheet for ETL Component 
based on Oracle Warehouse Builder Installation.
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11. After the configuring the values, press P to continue the installation.

Note: As the database server was upgraded to 11.2.0.3 as a part of the Oracle 
Utilities Analytics upgrade, the existing Oracle Warehouse Builder environment 
should not be used. This is because the Oracle Home would have changed after 
database server upgrade to 11.2.0.3 and the old Oracle Warehouse Builder 
environment will have the old value for Oracle Home. The new Oracle 
Warehouse Builder environment should be created and new Oracle Home 
details should be provided while configuring it.

Environment Installation Options
1. Oracle Client Home Directory: 

2. Environment Mount Point:  
Log Files Mount Point:  
Environment Name: 
Web Java Home Directory: 

Configure each item in the above list for successful installation. Choose the following options 
from the menu items: (1, 2 <P> Process, <X> Exit).

Environment Configuration
1. Environment Description 

Environment Description:

2. Database Configuration 
OWB WorkSpace Owner: 
OWB WorkSpace Owner Password:  
Database Name: 
Database Server: 
Database Port:

3. Design repository configuration 

OWB WorkSpace User: 
OWB Workspace user Password:  
OWB WorkSpace Name:  
DWADM SCHEMA NAME: 
DWADM SCHEMA Password: 
WORKFLOW MANAGER SCHEMA NAME:  
WORKFLOW MANAGER SCHEMA Password:

4. Database character set configuration  
Database Character set: AL32UTF8

5. Editing process flow configuration 
 Repository Operating System: 
Perl Compiler location: 
Data and control files location:  
Separator to be used: 
File Manager location:

6. Email configuration  
Email ID of Sender: 
Email ID for Reply-To address:  
Email ID of Receiver: 
SMTP server:  
SMTP server port:

7. Control Centre Configuration   
Repository Control Center Name:
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8. External data source configuration 
Path of the External Datasource: 
Path of the External Datasource LOG: 
File Processor Daemon Execution Switch: 
File Processor Extract Max Load: 
File Processor Scheduler Poll Duration:60

Configure each item in the above list for successful installation. Choose the following options 
from the menu items (1, 2, 3, 4, 5, 6, 7, 8 <P> Process, <X> Exit).

After completing the parameter setup steps, proceed with the option P. Write Configure file.

Once the install is completed successfully, you need to execute the post-upgrade steps as described 
in the section Post Installation Tasks.

Post Installation Tasks
Post-upgrade tasks involve the following:

• Cleanup Unused Oracle Warehouse Builder Objects from Oracle Warehouse Builder

• Deploying ETL Workflows on Oracle Warehouse Builder

Cleanup Unused Oracle Warehouse Builder Objects from Oracle Warehouse Builder
For UNIX:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run the ksh ./drop_unused_owb_objects.sh.

For Windows:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4.  Run the drop_unused_owb_objects.cmd.

Deploying ETL Workflows on Oracle Warehouse Builder
In UNIX, you may get a Java heap space error while importing the MDL file. To resolve this error 
you need to make changes in the OMBPlus.sh file, located at: $ORACLE_HOME/owb/bin/ 
unix/OMBPlus.sh.

In the following code, change the value -Xmx768M to -Xmx1024M, and then the -Dlimit value 
768M to 1024M.

$JAVAPATH/bin/java $JAVA64FLAG -Xms64M -Xmx768M $OPTS -Dlimit=768M 
- DORACLE_HOME=$ORACLE_HOME -DOWBCC_HOME=$ORACLE_HOME - 
DTCLLIBPATH="$TCLLIBPATH" - 
DMARATHON_RETRY_COUNT="$MARATHON_RETRY_COUNT" - 
DMARATHON_RETRY_INTERVAL="$MARATHON_RETRY_INTERVAL"

You need to make this value larger than 1024MB (1GB) depending on the size of the import: 
$CLASSPATH_LAUNCHER oracle.owb.scripting.OMBShell $*
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Perform the following tasks:

• Deploying Oracle Warehouse Builder Workflows

• Deploying Materialized Views

• Start File Processor

• Generating Security

• Generating Database Statistics

Deploying Oracle Warehouse Builder Workflows
This procedure needs to be performed if changes are made to the parallel settings on external 
tables, materialized views, or mappings on an existing installation and needs to be retained during 
the upgrade process.

Run the following command to generate a report on the parallel settings that is currently set in the 
customer repository on external tables, materialized views and mappings.

For UNIX:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment by executing the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run the ksh ./parallelSetup.sh analyze.

For Windows:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment by executing the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin. 

4. Run the parallelSetup.cmd analyze.

5. This generates the following files under <SPLEBASE>/etc folder. 

6. Review the above files for existing settings and make modifications if necessary. Once the 
files are reviewed, perform the following step to merge the existing settings with the default 
settings.

For UNIX:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment by executing the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run the ksh ./parallelSetup.sh merge.

For Windows:

1. Navigate to <Install_Dir>/bin directory.

1. Initialize the environment by executing the ./splenviron.cmd -e <envname> command.

2. cd %SPLEBASE%\bin.

3. Run parallelSetup.cmd merge.

4. Review the following files under <SPLEBASE>/etc and verify that the existing values have 
been merged correctly before proceeding:

cm-parallel-tables.txt  
cm-parallel-mvs.txt  
cm-parallel-maps.txt
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5. Below is the format of parallel*.txt to change the <Degree> of parallelism in above listed 
files: 

parallel-tables.txt file format: <Object_name>:<Degree> 
parallel-mvs.txt file format: <MV_Name>:<Fact_Table>:<Degree> 
parallel-maps.txt file format: <Object_name>:<Table_Name>:<Degree> 

For UNIX: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run the ksh ./Owbdeploy.sh.

For Windows:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run the owbdeploy.cmd.

Deploying Materialized Views
Run the following commands for deploying materialized views. 

For UNIX:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment by executing the ./splenviron.sh -e <envname> command.

3. Run the below script for upgrading the materialized views:

• cd $PLEBASE\bin

• Run the ksh ./upgradeViews.sh

For Windows:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment by executing the ./splenviron.cmd -e <envname> command.

3. Run the below script for upgrading the materialized views.

• cd %SPLEBASE%\bin

• Run upgradeViews.cmd

4. Once deployment is complete, remove the <SPLEBASE>/tmp content to ensure all the 
complete files are removed:

Start File Processor
For UNIX: 

cd $SPLEBASE/bin 

nohup ksh ./startFileprocessordaemon.sh >&1 & 

For Windows:

startFileprocessordaemon.cmd

Note: Go to <SPLEBASE>/logs/system to view the file processor log.
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Generating Security
Edit database-name with the name of your database in OraGenSec.bat after completing the 
Oracle Warehouse Builder deployment and run it from BI250/DWADM/Security folder.

Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before 
starting to use the database, generate the statistics for these new objects.

Oracle Utilities Analytics Dashboard Component Upgrade
This section describes the dashboard component installation and includes the following:

• Prerequisite to the Dashboard Component Upgrade

• Copying and Decompressing Install Media

• Setting Permissions for cistab File in UNIX

• Oracle Utilities Analytics Dashboard Package Upgrade Steps

• Merging the RPD Files

• Post-Upgrade Tasks

Prerequisite to the Dashboard Component Upgrade
The Oracle Utilities Analytics Dashboard component version 2.5.0 requires Oracle Business 
Intelligence Enterprise Edition version 11.1.1.7.1. Oracle Business Intelligence Enterprise Edition 
11.1.1.7.1 should be installed in a new Middleware Home before proceeding with Oracle Utilities 
Analytics Dashboard component upgrade. Refer to Oracle Business Intelligence Enterprise 
Edition documentation for details of installing 11.1.1.7.1.

Copying and Decompressing Install Media
The Oracle Utilities Analytics Dashboard component installation file is delivered in a zip format 
for both UNIX and Windows platforms. If you plan to install multiple Oracle Utilities Analytics 
environments operated by different Oracle Utilities Administrator user IDs, you must complete 
each of the following installation steps for each Administrator User ID.

1. Download the Oracle Utilities Analytics V2.5.0 Dashboard Component part (Oracle 
Utilities Analytics V2.5.0 Dashboard Component Multiplatform.zip) from the Oracle 
Software Delivery Cloud (https://edelivery.oracle.com).

2. Log into the application server host (where Oracle Business Intelligence Enterprise Edition 
11.1.1.7.1 software is installed) as the Oracle Utilities Analytics administrator user ID (default 
ceases).

3. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred as 
<TEMPDIR> in the step 3 below). This directory must be located outside any current 
working Oracle Utilities application environment. All files that are placed in this directory can 
be deleted after successful installation.

4. Unzip the Oracle Utilities Analytics V2.5.0 Dashboard Component Multiplatform.zip 
to <TEMPDIR>.

5. Decompress the file BI.OBIEE.V2.5.0-MultiPlatform.jar:

• cd <TEMPDIR>

• jar -xvf BI.OBIEE.V2.5.0-MultiPlatform.jar

Note: You should have Java JDK installed on the machine used to (un)jar the 
Oracle Utilities Analytics dashboard component installation package. Install the 
JDK that is supported for the install on your platform to be able to use the jar 
command.  
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The Java packages are located at: http://java.sun.com/products/archive/
index.html.

A sub-directory named “BI.OBIEE.V2.5.0” is created. It contains the 
installation software for the Oracle Utilities Analytics Dashboard component.

Setting Permissions for cistab File in UNIX
Note that every Oracle Utilities Analytics environment installed on a server must be registered in 
the /etc/cistab file located on that server.

On UNIX servers, generally only the root user ID has write permissions to the /etc directory. 
Since the installation process is run by the Oracle administrator user ID, this user ID may not be 
able to write to /etc/cistab table.

The install utility checks permissions and if it identifies a lack of the necessary permissions, it 
generates a script in the <TEMPDIR>/BI.OBIEE.V2.5.0 directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
Oracle Utilities Analytics application environment on the server) and registers a new environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Analytics 
administrator user ID, so that the next time a new environment is created by the same Oracle 
Utilities Analytics administrator user ID, you do not need to run the generated script with the root 
user ID. Instead, the install utility itself proceeds with the registration.

If you are reinstalling an existing environment, only the validation of /etc/cistab entry is done by 
the install utility. No new registration occurs. The install utility interactively gives instructions 
about every step in each specific case.

To upgrade an existing environment, it is recommended that a backup be taken before initiating 
the installation process. The installation utility by itself does not create a backup of the existing 
environment.

Oracle Utilities Analytics Dashboard Package Upgrade Steps
Before upgrading, verify that the steps in section Prerequisite Software for Oracle Utilities 
Analytics Dashboard Component are followed.

To upgrade the Oracle Utilities Analytics Dashboard package, follow these steps.

1. Change to the <TEMPDIR>/BI.OBIEE.V2.5.0 directory.

Perform the following steps: 

For UNIX:

• export ORACLE_CLIENT_HOME=<ORACLE_HOME> 

• export PERL_HOME=$ORACLE_CLIENT_HOME/perl 

• export PATH=$PATH:$PERL_HOME/bin

• Run install.sh.

Note: Ensure that you have the required execute permission on install.sh.

For Windows:

• set ORACLE_CLIENT_HOME=<ORACLE_HOME>

• set PERL_HOME=%ORACLE_CLIENT_HOME%\perl

• set PATH=%PERL_HOME%\bin;%PATH%

• Run install.cmd.

2. The Oracle Utilities Analytics specific menu appears. 
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3. Select the each menu item to configure the values.

For detailed description of the values, see Configuration Worksheet for 
Dashboard Component Installation.

Note: As the Oracle Business Intelligence Enterprise Edition version was 
changed to 11.1.1.7.1 as a part of the Oracle Utilities Analytics upgrade, the 
existing Oracle Utilities Analytics Dashboard package environment should not 
be used. A new Oracle Utilities Analytics Dashboard package environment 
should be created.

Environment Installation Options
1. Oracle Client Home Directory: 

2. Environment Mount Point:  
Log Files Mount Point:  
Environment Name: 
Web Java Home Directory: 

Configure each item in the above list for a successful installation. Choose the following options 
from the menu item: (1, 2 <P> Process, <X> Exit).

For detailed description of the values, see Configuration Worksheet for Dashboard 
Component Installation.

Environment Configuration
1. Environment Description 

Environment Description:

2. OBIEE Environment Configuration 
Oracle BI Instance Home:  
Oracle BI Home: 
Oracle BI Domain Home: 
Weblogic Domain Console User Name:  
Weblogic Domain Console Host:  
Weblogic Domain Console Port Number:

Target Database Details 
Target Database Name:  
Target Database Host: 
Target Database Port: 1521 
DWADM Schema Name: DWADM 
DWADM Schema Password:     

Configure each item in the above list for a successful installation. Choose the following options 
from the menu item (1, 2, 3 <P> Process, <X> Exit).

After completing the parameter setup, proceed with the option P. Write the Configure file.

Merging the RPD Files
If you have made custom changes to deployed RPD, follow the Oracle Business Intelligence 
Enterprise Edition documentation for merging.

Post-Upgrade Tasks
Post-upgrade tasks involve the following:

• Deploying the Repository (RPD) File

• Deploying the Web Catalog

• Configuring and Deploying MapViewer

• Deploying Write Back
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• Enabling Analytics Help

• Enabling Auto Complete Feature on Oracle Business Intelligence Enterprise Edition 
11.1.1.7.1

Deploying the Repository (RPD) File
If you have not made any changes to the deployed RPD, then take the RPD file from following 
location: <install_dir>/Reports/rpd/ UtilitiesBusinessAnalytics.rpd, where <install_dir> is the 
Oracle Utilities Analytics Dashboard Package installation directory.

If you have done merging, then take the merged RPD and make the required database changes.

This RPD file should be copied to the windows machine on which Oracle Business Intelligence 
Enterprise Edition 11.1.1.7.1 is installed.

Follow these steps to deploy the RPD file:

1. Oracle Business Intelligence Enterprise Edition 11.1.1.7.1 should be installed on the 
Windows machine before proceeding with the below steps.

2. Launch the Administration tool from the Start menu. 
Start > Programs > Oracle Business Intelligence > BI Administration

3. Open the RPD in offline mode by selecting File > Open > Offline...

4. Provide the RPD password. The default password is "oracle123".

5. Edit the Connection Pools shown below by double-clicking on them.
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6. In the Init Block Connection Pool group, enter the following: 

Datasource name = BI Database name

User name = DWREAD

Password = DWREAD User password

7. In the Init Block Pool - MDM group, provide the following (only for MDM): 

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

8. .In the Materialized Views Connection group, enter the following:

Datasource name = BI Database name

User name =DWREAD

Password = DWREAD User password 

9. In the MDM Database Connection group, provide the following (only for MDM): 

Data source name = MDM database name

User name = CISUSER

Password = CISUSER User password

10. In the ODIDEV Connection Pool group, provide the following: 

Data source name = BI database name

User name = DWUSER

Password = DWUSER User password

11. In the OUBI Database Connection group, provide the following: 

Data source name = BI database name

User name = DWREAD

Password = DWREAD User password
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12. Click Save. 

Note: Click Yes when you see the prompt 'Do you wish to check global consistency?' 
and ignore any warnings that appear after consistency check is complete.

13. Log into the Oracle Business Intelligence Enterprise Edition Enterprise Manager console.

14. Navigate to BI Instance > Coreapplication > Deployment.

15. Lock and edit. 
The repository text box will be enabled.

16. Browse to the modified rpd file and submit. 

17. Provide the RPD password "oracle123", and then click Apply.

18. Activate the changes and then restart Oracle Utilities Analytics services.

Note: All the above databases set in the connection pool should be updated in 
tnsnames.ora file in <OBIEE_INSTALL_DIR>/Oracle_BI1/network/
admin.

Deploying the Web Catalog
To deploy the web catalogs, follow these steps: 

1. Go to <Catalog location>/root/shared and delete all contents except any customized catalog 
files.

2. Go to <Catalog location>/root/system and remove spatialmetadata directory and 
spatialmetadata.atr file.

Note: Login to the Enterprise Manager, navigate to Coreapplication > 
Deployment >Repository for viewing the catalog location. At the bottom, 
you will see the catalog location.
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Deploying the Catalogs

To deploy the catalogs, follow these steps: 

For UNIX:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. ksh ./deploycatalog.sh.

5. Enter the physical catalogs location configured in the Enterprise Manager.  
Note: Login to the Enterprise Manager, navigate to Coreapplication > Deployment 
>Repository for viewing the catalog location. At the bottom, you will see the catalog 
location.

For Windows:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd  %SPLEBASE%\bin.

4. deploycatalog.cmd.

5. Enter the Physical Catalogs location configured in EM  
Note: Login to the Enterprise Manager, navigate to Coreapplication > Deployment 
>Repository for viewing the catalog location. At the bottom, you will see the catalog 
location.

Configuring and Deploying MapViewer
Configuring and deploying the MapViewer involves the following:

• Configuring MapViewer

• Modifying instanceconfig.xml

• Deploying Custom MapViewer

Configuring MapViewer

To configure Mapviewer, follow these steps: 

1. Log into the WebLogic console.

2. In the WebLogic console, create the 'MAP_DS' datasource.

3. Lock and edit.

4. Navigate to Services > Data Sources.

5. Select New > Generic Data Source and provide the following: 

Name = MAP_DS

JNDI Name = MAP_DS 

Database Type = oracle

6. Click Next.

7. Enter the following: 
Database Driver = XA thin database driver

8. Click Next.

9. Enter the following connection properties: 

• Database Name: BI Database Name 
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• Host Name: Database host 

• Port: Database port

• Database User Name: dwadm

• Password: dwadm password

10. Click Next, and then click Finish.

11. Click Activate Changes.

12. Update the mapViewerConfig file with below mentioned tags:

File location: <OBIEE_INSTALL_DIR>/Oracle_BI1/bifoundation/jee/

mapviewer.ear/web.war/WEB-INF/conf/ 

File: mapViewerConfig.xml

13. If there is a proxy used, insert the list of host names for all the third-party service providers in 
the security_config node.

<proxy_enabled_hosts>
elocation.oracle.com,maps.weatherbug.com,direct.weatherbug.com,api

.wxbug.net,de.tiles.weatherbug.com
</proxy_enabled_hosts>

14. Add the following ns_data_provider node:

<ns_data_provider id="obieeNsdp" 
class="com.oracle.utilities.birdseye.BirdseyeNSDP" />

15. Add the current map_tile_server with the following map_tile_server node:

<map_tile_server>
<tile_storage default_root_path="/mytilecache/"/>
</map_tile_server>

Modifying instanceconfig.xml

Update the instanceconfig.xml file after taking a backup.

The following are the examples of location of instanceconfig.xml file.

For UNIX:

<OBIEE_INSTALL_DIR>/instances/instance1/config/ 
OracleBIPresentationServicesComponent/coreapplication_obips1

For Windows:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentatio
nServicesCo mponent\coreapplication_obips1

Perform the following changes to instanceconfig.xml file:

1. Update the security node with the following values. If the security node is not present, add 
the following code before </Serverinstance>:

<Security>
<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
<HttpOnlyCookies>false</HttpOnlyCookies>
<CookieDomain />
<CookiePath>/</CookiePath>
</Security>
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2. Update the following <ServerInstance> element:

<LightWriteback>true</LightWriteback>
3. Add the following before the end tag </ServerInstance>:

<UI>
<DefaultStyle>oubi</DefaultStyle>
<DefaultSkin>oubi</DefaultSkin>
</UI>

4. Add the following lines in between the <ServerInstance> </ServerInstance> tags. 

<Prompts> 
<MaxDropDownValues>256</MaxDropDownValues> 
<AutoApplyDashboardPromptValues>true</

AutoApplyDashboardPromptValues> 
<AutoSearchPromptDialogBox>true</AutoSearchPromptDialogBox> 
<AutoCompletePromptDropDowns> 
<SupportAutoComplete>true</SupportAutoComplete> 
<CaseInsensitive>true</CaseInsensitive> 
<MatchingLevel>MatchAll</MatchingLevel> 
<ResultsLimit>50</ResultsLimit> 
</AutoCompletePromptDropDowns> 
</Prompts>

Deploying Custom MapViewer

To deploy the custom MapViewer, follow these steps: 

For UNIX: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run ksh ./deploymapviewer.sh.

5. Enter the WebLogic Domain Console Password. For example, weblogic123.

For Windows: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run deploymapviewer.cmd.

5. Enter WebLogic Domain Console Password. For example, weblogic123.

Perform the following steps after deploying the custom MapViewer:

1. Update the MapViewer configuration by navigating to MapViewer > Administration > 
Configuration. Login to Mapviewer at this location: http://
<HOST>:<MANAGERPORT>/mapviewer

2. Add the below content in the mapViewerConfig.xml with appropriate values:

<DB_HOST>,<DBNAME>,<DB_PORT>,<USER>,<PASSWORD>
<map_data_source name="MAPCONN" 
jdbc_host="<DB_HOST>" 
jdbc_sid="<BI Database Name>" jdbc_port="<DB_PORT>" 
jdbc_user="DWADM"
jdbc_password="<!DWADM PASSWORD>" 
jdbc_mode="thin"
number_of_mappers="32" 
allow_jdbc_theme_based_foi="true"
/>
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3. Click Save, and then restart.

Note: The above step has to be performed each time after running the 
deploymapviewer command.

Deploying Write Back
For deploying Write Black, perform the following steps:

For UNIX:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run ksh ./deploywriteback.sh.

For Windows:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%/bin.

4. Run deploywriteback.cmd.

Enabling Analytics Help
To enable the Analytics’ Help, perform these steps: 

1. Download Oracle Utilities Analytics for Oracle Utilities Extractors and Schema and Oracle Utilities 
Analytics Dashboards User's Guide from Oracle Software Delivery Cloud (https:// 
edelivery.oracle.com).

2. After downloading Oracle Utilities Analytics for Oracle Utilities Extractors and Schema and Oracle 
Utilities Analytics Dashboards User's Guide, change the name of the Help file to OUA Help.pdf.

3. Now, place the Help file in <install_dir>/Skin/res, where <install_dir> is the Oracle 
Utilities Analytics Dashboard Package installation directory.

4. Run the following commands: 

For UNIX: 
Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run ksh ./deployanalyticsear.sh.

5. Enter the WebLogic Domain Console password. For example, weblogic123.

For Windows:

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%/bin.

4. deployanalyticsear.cmd.

5. Enter the WebLogic Domain Console Password. For example, weblogic123.

6. Restart the Oracle Utilities Analytics core services.
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7.    Restart WebLogic and all Oracle Utilities Analytics services after the Oracle Business 
Intelligence Enterprise Edition deployment is completed.

8. Log into Analytics and navigate to Administration>Manage 
Privileges>WriteBack>Write Back to Database.

9. Click Denied:Authenticated User and select the permission Granted.

Enabling Auto Complete Feature on Oracle Business Intelligence Enterprise Edition 
11.1.1.7.1

To enable auto complete feature on Oracle Business Intelligence Enterprise Edition, perform the 
following steps: 

1. Restart the Oracle Business Intelligence Enterprise Edition admin server, managed server 
and opmn services. 

Note: Refer to Oracle Business Intelligence Enterprise Edition documentation 
for detailed instructions on how to start, stop admin server, managed server 
and opmn services.

2. Login to analytics (http://<Server>:<port>/analytics).

3. Click on the WebLogic User (top-most-right section of the page). 

4. From the drop down menu, select My Account. 

5. Set Prompt Auto Complete to ON, and click OK.

Oracle Utilities Analytics Admin Tool Component
This is only applicable for users installing Oracle Data Integrator based ELT. Oracle Utilities 
Analytics Admin tool is based on Oracle Application Express.

For detailed instructions on how to set up the Admin Tool, refer to the chapter Installing the 
Oracle Utilities Analytics Admin Tool for the complete details.

Also, refer to Oracle Utilities Analytics Administrator’s Guide for details. 

Checklist After the Installation
After the installation, perform the following steps: 

1. Verify the Install and Deploy logs.

• MDL Import Logs 
<INSTALL_DIR>/OWB/MetadataFiles/SPL-BI-Project_imp.log 
<INSTALL_DIR>/OWB/MetadataFiles/SPL-BI-Location_imp.log

• OWB Deploy Logs 
<INSTALL_DIR>/logs/system/log_OWBDeployment_YYYYMMDD_####.txt

• Custom Mapviewer deploy Logs 
INSTALL_DIR>/logs/system/mapviewerdeploy.sh.log

• WriteBack Logs 
<INSTALL_DIR>/logs/system/Writeback.log

• FileProcessorDaemon Logs 
<INSTALL_DIR>/bin/FileProcessorDaemon.log

2. Log into the Oracle Business Intelligence Enterprise Edition Analytics link. The 
Dashboard should display data with no errors.
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Chapter 7 
Demo Installation Procedure 

This chapter provides instructions for installing the demo database. 

Note: Demo installation does not support ETL functionality. ETL Job control 
dashboard accesses the Oracle Warehouse Builder and Oracle Data Integrator 
tables, and the demo dump does not have Oracle Warehouse Builder, or Oracle 
Data Integrator objects. Hence, the ETL dashboard is not supported in the 
demo installation. 

The chapter includes the following topics: 

• Oracle Utilities Analytics Demo Database Component Installation

• Oracle Utilities Analytics Dashboard Component Installation

• After the Installation

Oracle Utilities Analytics Demo Database Component Installation
This section describes how to install the demo component of Oracle Utilities Analytics. The 
section includes the following:

• Copying and Decompressing Install Media

• Database Creation and Dump File Import

• Security Configuration

• Spatial Configuration

Copying and Decompressing Install Media
To copy and decompress the install media, follow these steps:

1. Download the Oracle Utilities Analytics V2.5.0 Demo Data part (Oracle Utilities Analytics 
V2.5.0 Demo Data.zip) from the Oracle Software Delivery Cloud (https://
edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred to below as 
<TEMPDIR>). This directory must be located outside any current working Oracle Utilities 
application environment. All files that are placed in this directory as a part of the installation, 
can be deleted after completing a successful installation.

3. Unzip Oracle Utilities Analytics V2.5.0 Demo Data.zip to <TEMPDIR>. 
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Database Creation and Dump File Import
Ensure that Oracle Database Server Enterprise Edition 11.2.0.3 is already installed on the machine 
in order to create the database.

• Use the Database Configuration Assistant (DBCA) utility to create the database as shown in 
the section Database Creation Using DBCA.

Database Creation Using DBCA
Note: Refer to the Oracle database documentation to know more about the 
Database Configuration Assistant (DBCA).

For an initial installation database creation, it is recommended that you use the Database 
Configuration Assistant (DBCA) to create a data warehouse database with below-mentioned 
specifications:

1. Create a database with the AL32UTF8 character set. Set the open cursor limit to 3000 and 
processes to 1000 at the time of the database creation.

2. After database creation, set the query_rewrite_enabled parameter to “Force” and the 
query_rewrite_integrity parameter to “Trusted”.

To do this, connect to the sys user, and execute the following commands: 

alter system set query_rewrite_enabled=force;
alter system set query_rewrite_integrity=trusted;

3. Ensure to create users in the database with the following names: DWADM, DWUSER, 
DWREAD, MDADM, RELADM, SPLADM, SPLUSER, SPLREAD, MASTER_REPO, 
WORK_REPO and DWSTAGE if these do not exist already, without giving specific roles.

4. Ensure to create roles with the following names: DW_USER, DW_READ, 
DW_REPLICATE, SPL_USER and SPL_READ roles if these do not exist already.

5. Connect to the sys user, execute the Usersgrants.sql in BI250/Scripts/Usersgrants.sql. This 
SQL will provide required grants to the users created above.

Import the Demo dump
Perform the following steps to import the demo dump: 

1. Create the dump_dir directory in database.

2. You should also copy the exp_demo.dmp file to the dump_dir. Uncompress the 
exp_demo.dmp.gz file first to extract the exp_demo.dmp file. This file is in 
<TEMPDIR>\Demo directory.

3. Set the correct ORACLE_SID and ORACLE_HOME first, and then run the below 
command to import demo dump: 

impdp directory= dump_dir dumpfile= exp_demo.dmp logfile=    
exp_demo.log schemas=DWADM,RELADM,MDADM 
remap_tablespace=cists_01:<tablespace_name>

Note: Run this command from database server:

Note: Make sure to change the tablespace_name to the tablespace name on 
which DWADM, RELADM and MDADM have the quota. If DWADM, 
RELADM and MDADM users have quota on cists_01 tablespace, then exclude 
whole remap_tablespace clause from the command.

Note: If you get the following error messages, it is recommended to ignore:

ORA-31684: Object type USER:"MDADM" already exists
ORA-31684: Object type USER:"RELADM" already exists
ORA-31684: Object type USER:"DWADM" already exists
Demo Installation Procedure 7-119 
Oracle Utilities Analytics Installation Guide



ORA-39083: Object type OBJECT_GRANT failed to create with error:
ORA-01917: user or role 'CCB1REP' does not exist
Failing sql is:
GRANT EXECUTE ON "MDADM"."B1_TEXT_ARRAY" TO "CCB1REP"

ORA-39083: Object type OBJECT_GRANT failed to create with error:
ORA-01917: user or role 'CCB1REP' does not exist
Failing sql is:
GRANT SELECT ON "MDADM"."B1_PROD_INSTANCE" TO "CCB1REP"
Job "SYSTEM"."SYS_IMPORT_SCHEMA_01" completed with 5 error(s) 

4. Provide the system as the user and system user's password when prompted.

5. Connect to MDADM schema, and execute below commands

create public synonym B1_TARGET_ENTITY for B1_TARGET_ENTITY;
create public synonym B1_PROD_INSTANCE for B1_PROD_INSTANCE;
create public synonym B1_JOB_CONFIG for B1_JOB_CONFIG;

grant select on B1_TARGET_ENTITY to public;
grant select on B1_PROD_INSTANCE to public;
grant select on B1_JOB_CONFIG to public;

Security Configuration
For Security Configuration, perform the following steps: 

1. Navigate to the ..\BI250\DWADM\Security folder.

2. Edit the file OraGenSec.bat, which is in the same location, and replace the parameter 
database-name with the name of your database. This file is provided for your convenience 
and executes the Oragensec.exe utility based on the parameters passed into it.

Note: Ensure to run OraGenSec.bat from a Windows desktop that has the 
Oracle 11.2.0.3+32 bit client installed. Your database should already be listed in 
the local file tnsnames.ora.

The script executes as following:

oragensec -d DWADM,<DWADM password>,database_name -r 
DW_READ,DW_USER - a A -u DWUSER,DWREAD

3. Execute the edited OraGenSec.bat file from the command prompt.

Spatial Configuration
This section describes how to load spatial metadata in the USER_SDO* tables for Oracle Utilities 
Analytics. 

Use the following procedure to load spatial metadata in the target database:

1. Create the dump_dir directory in the database and copy the user_sdo.dmp file from ../
B1250/Spatial-Metadata folder to that location.

2. Import released spatial tables to the target database using the following command:

impdp directory=dump_dir dumpfile=user_sdo.dmp logfile=
impdp_user_sdo.log schemas=DWADM
remap_tablespace=cists_01:<tablespace_name>

Note: Run this command from database server.
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Note: Make sure to change the tablespace_name to tablespace name on which 
DWADM has the quota. If DWADM user have quota on cists_01 tablespace, 
then exclude whole remap_tablespace clause from command.

3. Review the impdp_user_sdo.log file to ensure the tables were imported successfully.

4. After importing the tables, run following SQL scripts from the ../B1250/Spatial-Metadata 
folder:

- sqlplus dwadm/<dwadm user password>@database-name @copy_spatial_metadata.sql

- sqlplus dwadm/<dwadm user password>@database-name @clean_sdo_release_tbls.sql

5. Review the log files.

Oracle Utilities Analytics Dashboard Component Installation
This section describes how to install the dashboard component of Oracle Utilities Analytics. The 
section includes the following:

• Copying and Decompressing Install Media

• Setting Permissions for cistab File in UNIX

• Oracle Utilities Analytics Demo Database Component Installation Dashboard 
Package Installation Steps

• Post-installation Tasks

Copying and Decompressing Install Media
The Oracle Utilities Analytics Dashboard Component installation file is delivered in the zip 
format for both UNIX and Windows platforms. If you plan to install multiple Oracle Utilities 
Analytics environments operated by different Oracle Utilities Administrator User IDs, you must 
complete each of the following installation steps for each Administrator User ID.

1. Download the Oracle Utilities Analytics V2.5.0 Dashboard Component part (Oracle 
Utilities Analytics V2.5.0 Dashboard Component Multiplatform.zip) from the Oracle 
Software Delivery Cloud (https://edelivery.oracle.com).

2. Log into the application server host (where Oracle Business Intelligence Enterprise Edition 
11.1.1.7.1 software is installed) as the Oracle Utilities Analytics Administrator user ID (default 
ceases).

3. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred as 
<TEMPDIR> in the step 4 below. This directory must be located outside any current 
working Oracle Utilities application environment. All files that are placed in this directory, can 
be deleted after successful installation.

4. Unzip the Oracle Utilities Analytics V2.5.0 Dashboard Component Multiplatform.zip 
to <TEMPDIR>

5. Decompress the file BI.OBIEE.V2.5.0-MultiPlatform.jar:

• cd <TEMPDIR>

• jar -xvf BI.OBIEE.V2.5.0-MultiPlatform.jar

You should have Java JDK installed on the machine used to (un)jar the Oracle Utilities Analytics 
dashboard component installation package. Install the JDK that is supported for the install on 
your platform to be able to use the jar command. 

The Java packages are located at: http://java.sun.com/products/archive/index.html

A sub-directory named “BI.OBIEE.V2.5.0” is created. It contains the installation software for the 
Oracle Utilities Analytics Dashboard component.
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Setting Permissions for cistab File in UNIX
Every Oracle Utilities Analytics environment installed on a server must be registered in the /etc/
cistab file located on that server. On UNIX servers, generally only the root user ID has the write 
permissions to the /etc directory. Since the installation process is run by the Oracle administrator 
User ID, this user ID may not be able to write to /etc/cistab table.

The install utility checks permissions and if it identifies a lack of the necessary permissions, it 
generates a script in the <TEMPDIR>/BI.OBIEE.V2.5.0 directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before 
continuing with the installation process. The script initializes the cistab file in /etc directory (if it is 
the first Oracle Utilities Analytics application environment on the server) and registers a new 
environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Analytics 
administrator User ID, so that the next time a new environment is created by the same Oracle 
Utilities Analytics Administrator User ID, you do not need to run the generated script with the 
root user ID. Instead, the install utility itself proceeds with the registration.

If you are reinstalling an existing environment, only the validation of /etc/cistab entry is done by 
the install utility, no new registration occurs. The install utility interactively instructs you about 
every step that needs to occur in each specific case.

If you plan to upgrade an existing environment, take a backup prior to the installation process. 
The installation utility does not create a backup of the existing environment.

Oracle Utilities Analytics Demo Database Component Installation Dashboard 
Package Installation Steps

Before you install verify that the steps mentioned in Prerequisite Software for Oracle Utilities 
Analytics Dashboard Component are followed. 

To install the Oracle Utilities Analytics Dashboard package, perform these steps. 

1. Change to the <TEMPDIR>/BI.OBIEE.V2.5.0 directory.

2. Set the ORACLE_CLIENT_HOME and PATH variables as Oracle Client Perl is required to 
run the installer.

3. Execute the following script: 
For UNIX: 
Perform the following steps: 

• export ORACLE_CLIENT_HOME=<oracle_client_home>

• export PERL_HOME=$ORACLE_CLIENT_HOME/perl

• export PATH=$PATH:$PERL_HOME/bin

• Run ksh ./install.sh

       For Windows: 
       Perform the following steps: 

• set ORACLE_CLIENT_HOME=<ORACLE_HOME>

• set PERL_HOME=%ORACLE_CLIENT_HOME%\perl

• set PATH=%PERL_HOME%\bin;%PATH%

• Run Install.cmd

Note: On UNIX, ensure that you have the proper execute permission on 
install.sh.

4. The Oracle Utilities Analytics specific menu appears.
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5. Select the each Menu Item to configure the values. For detailed description of the values, see 
Configuration Worksheet for Dashboard Component Installation.

Environment Installation Options 
1. Oracle Client Home Directory: 

2. Environment Mount Point:  
Log Files Mount Point:  
Environment Name:  
Web Java Home Directory: 

Configure each item in the above list for successful installation. Choose the following options 
from the menu item (1, 2 <P> Process, <X> Exit).

Note: For detailed description of these values, see Configuration Worksheet 
for Dashboard Component Installation.

Environment Configuration 
1. Environment Description 

Environment Description:

2. OBIEE Environment Configuration 
Oracle BI Instance Home: 
Oracle BI Home: 
Oracle BI Domain Home: 
Weblogic Domain Console User Name: 
Weblogic Domain Console Host: 
Weblogic Domain Console Port Number

3. Target Database Details 
Target Database Name:   
Target Database Host:   
Target Database Port: 1521 
DWADM Schema Name: DWADM 
DWADM Schema Password:                            

Configure each item in the above list for a successful installation. Choose the following 
options from the menu item (1, 2, 3 <P> Process, <X> Exit).

When you are finished with the parameter setup, proceed with option P. Write to the Configure 
file.

Once installation is successful, execute the post-installation steps as described in the section Post-
installation Tasks.

Post-installation Tasks
Following topics are discussed in this section: 

• Deploying Repository (RPD) File

• Deploying the Web Catalog

• Configuring and Deploying MapViewer

• Deploying Write Back

• Enabling Analytics Help

• Enabling Auto Complete feature on Oracle Business Intelligence Enterprise Edition 
11.1.7.1
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Deploying Repository (RPD) File
The RPD file is located at: <install_dir>/Reports/rpd/UtilitiesBusinessAnalytics.rpd, where 
<install_dir> is the Oracle Utilities Analytics Dashboard Package installation directory.

This RPD file should be copied to the Windows machine on which Oracle Business Intelligence 
Enterprise Edition 11.1.1.7.1 is installed.

To deploy the RPD file, perform these steps:

1. Oracle Business Intelligence Enterprise Edition 11.1.1.7.1 should have been installed on the 
Windows machine before proceeding with the steps below.

2. Launch the Administration tool from the Start menu from the Windows machine. This is 
only available in the Windows.

Start > Programs > Oracle Business Intelligence > BI Administration.

3. Open the RPD in the offline mode by selecting File > Open > Offline...

4. Provide the RPD password. The default password is “oracle123”.

.

5. Edit the connection pools shown below by double clicking on them.

6. In the Init Block Connection Pool group, enter the following:

Datasource name = BI Database name

User name = DWREAD
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Password = DWREAD User password

7. In the Init Block Pool - MDM group, provide the following (only for MDM):

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

8. In the MDM Database Connection group, provide the following (only for MDM):

Data source name = MDM database name

User name = CISUSER

Password = CISUSER User password

9. In the Materialized Views Connection group, enter the following:

 Datasource name = BI Database name

User name =DWREAD

Password = DWREAD User password

10. In the ODIDEV Connection Pool group, provide the following:

Data source name = BI database name

User name = DWUSER

Password = DWUSER User password

11. In the OUBI Database Connection group, provide the following:

Data source name = BI database name

User name = DWREAD

Password = DWREAD User password
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12. Click Save.

Note: Click Yes when you see the prompt 'Do you wish to check global 
consistency?' and ignore any warnings that appear after consistency check is 
complete.

13. Log into the OBIEE Enterprise Manager console.

14. Navigate to BI Instance >Coreapplication>Deployment.

15. Lock and edit.

The repository text box is enabled.

16. Browse to the modified rpd file and submit. 

17. Provide the RPD password “oracle123”. Click Apply.

18. Activate the changes, and then restart the Oracle Utilities Analytics services.

Note: All the above databases set in the connection pool should be updated in 
the tnsnames.ora file in <OBIEE_INSTALL_DIR>/Oracle_BI1/network/
admin.

Deploying the Web Catalog
To deploy the catalogs, follow these steps:

1. Go to <Catalog location>/root/shared and delete all contents except any customized catalog 
files.

2. Go to <Catalog location>/root/system and remove spatialmetadata directory and 
spatialmetadata.atr file.

Note: Login to the Enterprise Manager, navigate to Coreapplication > 
Deployment >Repository for viewing the catalog location. At the bottom, 
you will see the catalog location.

For UNIX:

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. ksh ./deploycatalog.sh.

5. Enter the physical catalogs location configured in the Enterprise Manager. 

Note: Login to the Enterprise Manager, navigate to Coreapplication > 
Deployment >Repository for viewing the catalog location. At the bottom, 
you will see catalog location.

For Windows:

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd  %SPLEBASE%\bin.

4. deploycatalog.cmd.

5. Enter the Physical Catalogs location configured in the Enterprise Manager.
Demo Installation Procedure 7-126 
Oracle Utilities Analytics Installation Guide



Note: Login to the Enterprise Manager, navigate to Coreapplication > 
Deployment >Repository for viewing the catalog location. At the bottom, 
you will see the catalog location.

Configuring and Deploying MapViewer
Configuring and deploying the MapViewer involves the following:

• Configuring MapViewer

• Modify instanceconfig.xml

• Deploying Custom MapViewer

Configuring MapViewer
To configure and deploy the MapViewer, perform the following steps: 

1. Login to the WebLogic console.

2. In the WebLogic console, create the 'MAP_DS' datasource.

3. Lock and edit.

4. Navigate to Services < Data Sources.

5. Select New > Generic Data Source and provide the following:

Name = MAP_DS

JNDI Name = MAP_DS

Database Type = oracle

6. Click Next.

7. Enter the following:

Database Driver = XA thin database driver

8. Click Next.

9. Enter the following Connection properties:

Database Name:BI Database Name

Host Name:Database host

Port:Database port

Database User Name:dwadm

Password:dwadm password

10. Click Next, and then click Finish.

11. Click Activate Changes.

12. Update the mapViewerConfig file with below mentioned tags:

File location: <OBIEE_INSTALL_DIR>/Oracle_BI1/bifoundation/jee/mapviewer.ear/
web.war/WEB-INF/conf/

File: mapViewerConfig.xml

13. If there is proxy used, insert the list of host names for all the third-party service providers in 
the security_config node.

<proxy_enabled_hosts>
elocation.oracle.com,maps.weatherbug.com,direct.weatherbug.com,api

.wxbug.net,de.tiles.weatherbug.com
</proxy_enabled_hosts>
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14. Add the following ns_data_provider node:

<ns_data_provider id="obieeNsdp"
class="com.oracle.utilities.birdseye.BirdseyeNSDP" />

15. Add the current map_tile_server with the following map_tile_server node:

<map_tile_server>
<tile_storage default_root_path="/mytilecache/"/>
</map_tile_server>

Modify instanceconfig.xml
Update the instanceconfig.xml file after taking a backup.

The following are the examples of location of instanceconfig.xml file.

For UNIX:

<OBIEE_INSTALL_DIR>/instances/instance1/config/ 
OracleBIPresentationServicesComponent/coreapplication_obips1
For Windows:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentatio
nServicesCo mponent\coreapplication_obips1

Perform the following changes to instanceconfig.xml file:

1. Update the security node with the following values. If the security node is not present, add 
the following code before </Serverinstance>:

<Security>
<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
<HttpOnlyCookies>false</HttpOnlyCookies>
<CookieDomain />
<CookiePath>/</CookiePath>
</Security>

2. Update the following <ServerInstance> element:

<LightWriteback>true</LightWriteback>

3. Add the following before the end tag </ServerInstance>:

<UI>
<DefaultStyle>oubi</DefaultStyle>
<DefaultSkin>oubi</DefaultSkin>
</UI>

4. Add the following lines in between the <ServerInstance> </ServerInstance> tags: 

<Prompts> 
<MaxDropDownValues>256</MaxDropDownValues> 
<AutoApplyDashboardPromptValues>true</

AutoApplyDashboardPromptValues> 
<AutoSearchPromptDialogBox>true</AutoSearchPromptDialogBox> 
<AutoCompletePromptDropDowns> 
<SupportAutoComplete>true</SupportAutoComplete> 
<CaseInsensitive>true</CaseInsensitive> 
<MatchingLevel>MatchAll</MatchingLevel> 
<ResultsLimit>50</ResultsLimit> 
</AutoCompletePromptDropDowns> 
</Prompts>
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Deploying Custom MapViewer
To deploy the custom MapViewer, follow these steps:

For Unix:

• cd $SPLEBASE/bin.

• ksh ./deploymapviewer.sh.

• Enter the WebLogic Domain Console Password. For example, weblogic123.

For Windows:

• cd %SPLEBASE%\bin.

• deploymapviewer.cmd.

• Enter the WebLogic Domain Console Password. For example, weblogic123.

Perform the following steps after deploying the custom MapViewer:

1. Update the MapViewer configuration by navigating to MapViewer > Administration > 
Configuration.

2. Add the below content in the mapViewerConfig.xml with appropriate values:

<DB_HOST>,<DBNAME>,<DB_PORT>,<USER>,<PASSWORD>
<map_data_source name="MAPCONN"
jdbc_host="<DB_HOST>"
jdbc_sid="<BI Database Name>"
jdbc_port="<DB_PORT>"
jdbc_user="DWADM"
jdbc_password="<DWADM PASSWORD>"
jdbc_mode="thin"
number_of_mappers="32"
allow_jdbc_theme_based_foi="true"
/>

3. Click Save, and then restart.

Note: The above step has to be performed every time you run the 
deploymapviewer command.

Deploying Write Back
To deploy Write Black, perform the following:

For UNIX:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. ksh ./deploywriteback.sh.

For Windows:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%/bin.

4. deploywriteback.cmd.
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Enabling Analytics Help
To enable the Analytics' help, follow these steps:

1. Download Oracle Utilities Analytics for Oracle Utilities Extractors and Schema and Oracle Utilities 
Analytics Dashboards User's Guide from Oracle Software Delivery Cloud (https:// 
edelivery.oracle.com).

2. After downloading Oracle Utilities Analytics for Oracle Utilities Extractors and Schema and Oracle 
Utilities Analytics Dashboards User's Guide, change the name of the Help file to OUA Help.pdf.  
Now, place the Help file in <install_dir>/Skin/res, where <install_dir> is the Oracle 
Utilities Analytics Dashboard Package installation directory.

3. Run the following commands:

For UNIX:

• cd $SPLEBASE/bin.

• ksh ./deployanalyticsear.sh.

• Enter the WebLogic Domain Console Password. For example, weblogic123.

For Windows:

• cd %SPLEBASE%/bin.

• deployanalyticsear.cmd.

• Enter the WebLogic Domain Console Password. For example, weblogic123.

4. Restart the Oracle Utilities Analytics core services.

5. Restart WebLogic and all Oracle Utilities Analytics services after the Oracle Business 
Intelligence Enterprise Edition deployment is completed.

6. Login to Analytics and navigate to Administration > Manage Privileges > Write Back > 
Write Back to Database.

7. Click Denied:Authenticated User and select the permission Granted.

Enabling Auto Complete feature on Oracle Business Intelligence Enterprise 
Edition 11.1.7.1

Perform the following steps: 

1. Restart the Oracle Business Intelligence Enterprise Edition admin server, managed server 
and opmn services.

Note: Refer to Oracle Business Intelligence Enterprise Edition documentation 
for detailed instructions on how to start, stop the admin server, managed server 
and opmn services.

2. Log into the Analytics: http://<Server>:<port>/analytics.

3. Click on the WebLogic User (top-right pane of page). 

4. From the drop-down menu, select My Account. 

5. Set the prompt Auto Complete to ON. and click OK.

After the Installation 
After the installation, perform the following: 

1. Verify Install and Deploy Logs.

• Custom Mapviewer deploy logs:

<INSTALL_DIR>/logs/system/mapviewerdeploy.sh.log
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• WriteBack logs:

<INSTALL_DIR>/logs/system/Writeback.log

2. Log into the Oracle Business Intelligence Enterprise Edition Analytics link that is 
pointing to the demo database. The dashboard should display the data with no errors.
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Chapter 8 
Configuring Your Applications

This chapter provides instructions for configuring additional applications for use with Oracle 
Utilities Analytics. It covers the following topics:

• Spatial Configuration

• Oracle Business Intelligence Enterprise Edition (OBIEE) Configuration

Spatial Configuration
This section contains information related to configuring Oracle Utilities Outage Analytics and 
how to set up the spatial data and its corresponding metadata. The mapping between the spatial 
columns and the dimensional columns, such as State from Address dimension would be defined in 
the map metadata that is available as a part of the WebCatalog. Using the spatial data and the map 
metadata, users can view the transactional data on the map view.

As an example, steps to setup the data for United States (US) are mentioned below: 

• Installing US State Spatial Data

• Installing US City Spatial Data

• Installing US Zip Code Spatial Data

• Installing US County Spatial Data

• Configuring Oracle Utilities Network Management System Device Spatial Data

• Loading Spatial Metadata

• Improving Performance by Prefetching Map Tiles

Installing US State Spatial Data
The spatial data can be loaded from various sources. One of the approaches is to use the world 
sample data given by NAVTEQ. There is a pointer to the data set from the Oracle Utilities 
Analytic’s OTN (Oracle Technology Network) page for downloading partner data:

http://www.oracle.com/technetwork/database-options/spatialandgraph/downloads/index.html

There are various versions of the world sample dataset. These instructions assume that you are 
using the version with a world_sample2010.dmp file. If you have a different version, then these 
instructions may not work and you should refer to the README.txt included in the downloaded 
world_sample.zip file.

These instructions also assume that the sample data will be loaded into the DWADM account, 
used for the data warehouse. If you want to follow the instructions in the world sample README 
These instructions also assume that the sample data will be loaded into the DWADM account, 
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used for the data warehouse. If you want to follow the instructions in the world sample 
ReadMe.txt file instead, then the data will be loaded into a WORLD_SAMPLE account, and the 
steps will need to be changed to use that account instead of DWADM.

Use the following procedure to install the world sample data.

1. Create a work directory on your machine for the data, and change directory to the new 
directory. For example: 

mkdir NAVTEQ 
cd NAVTEQ

2. Unzip the world_sample.zip file you downloaded to the new directory. For example: 

unzip world_sample.zip 

3. Connect to SQLPLUS using the DWADM, and remove the old tables (if present). For 
example: 

sqlplus dwadm/dwadm@database @cln_sample_data.sql 

4. Import the world sample dump file into the DWADM account. For example: 

imp dwadm/dwadm@database file=world_sample2010.dmp 
 log=world_sample.log full=y

5. After importing the world sample dump file, create the MapViewer Spatial metadata using 
the following Insert statements: 

sqlplus  dwadm/dwadm@database
INSERT INTO user_sdo_maps SELECT * FROM sdo_maps;
INSERT INTO user_sdo_themes SELECT * FROM sdo_themes;
INSERT INTO user_sdo_styles SELECT * FROM sdo_styles;
INSERT INTO user_sdo_cached_maps SELECT * FROM sdo_cached_maps;

6. Create the State spatial table and metadata are used by the default themes present in the 
Oracle Utilities Analytics metadata. This assumes that the eLocation website is being used as 
the base map. If some other base map is used, then the transform parameter will need to 
specify the SRID of the base map being used.

sqlplus  dwadm/dwadm@database
create table q1_states54004 (

      feature_id number,
      feature_name varchar2(255),
      area_id number,
      name_langcode varchar2(35),
      feature_type varchar2(30),
      country_code_3 varchar2(5),
      geometry SDO_GEOMETRY,
      carto_id number(10,0));

insert into q1_states54004
select null, name, null, lang_code, feature_type,

       ISO_COUNTRY_CODE, sdo_cs.transform(geometry, 54004), 
       carto_id

FROM wom_area
WHERE feature_type = 909996

  and iso_country_code = 'USA';

INSERT INTO user_sdo_geom_metadata
VALUES ( 'Q1_STATES54004','GEOMETRY',
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)), 54004);
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create index q1_STATES54004_sdx 
    on q1_STATES54004(geometry) 
    indextype is mdsys.spatial_index;

Installing US City Spatial Data
US City shape data is available in the world sample dataset, however, only the three hundred 
largest cities are available there. To find additional sample data for each US State from the US 
Census Bureau, visit and search within the Census site:

http://www.census.gov/

The following steps can be used to load the sample data for the state of Ohio, and similar steps 
can be followed to load city data for other US states.

1. Click the Ohio zip code in the Shapefile format and download the zt39_d00_shp.zip file to 
the NAVTEQ directory created in the previous procedure. 

2. Unzip or decompress the pl39_d00_shp.zip file to the NAVTEQ directory. 

3. Download standalone MapBuilder from this location:  
http://www.oracle.com/technetwork/middleware/mapviewer/downloads/index-
100641.html 

4. Start MapBuilder. This is installed when MapViewer is installed. On windows it can be 
started by running:  
java -jar mapbuilder.jar 

Refer to the MapViewer documentation for instructions on installing and running 
MapBuilder from this location: 
http://www.oracle.com/technetwork/middleware/mapviewer/documentation/index.html  

5. If a connection is not created, then select File -> New Connection, and create a connection 
to the DWADM account in the Oracle Utilities Analytics Data Warehouse database. 

6. Select Tools -> Import Shapefile, and click Next. 

7. Click Shapefile. 

8. Browse to the C:\NAVTEQ directory, select the pl39_d00_shp.shp file, and click Open. 

9. Click Next. 

Note: Ensure that the name of the geometry table is set to pl39_d00. If this is 
not the desired name for the spatial table, then the select statement below will 
need to be changed to use the entered name. 

10. Ensure the Create Predefined Theme box is unchecked, and click Next. 

11. Review the summary information and click Finish. 
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12. Create the Q1_CITY54004 table using the following SQL statement. This assumes that the 
eLocation website is being used as the base map. If some other base map is used, then the 
transform parameter will need to specify the SRID of the base map being used.

sqlplus  dwadm/dwadm@database
create table Q1_CITY54004 as
select upper(name) FEATURE_NAME,

       sdo_cs.transform(geometry, 54004) geometry,
       'OHIO' state

From pl39_d00
Where lsad_trans in ( 'city', 'village' );

INSERT INTO user_sdo_geom_metadata
VALUES ( 'Q1_CITY54004','GEOMETRY',
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)), 54004);

create index Q1_CITY54004_sdx 
    on Q1_CITY54004 (geometry) 
    indextype is mdsys.spatial_index;

UPDATE q1_city54004
  SET geometry = SDO_UTIL.RECTIFY_GEOMETRY(geometry, .05);

Installing US Zip Code Spatial Data
Sample shape files for US Zip Code Areas can be found at the following location:

http://www.census.gov/

The following steps can be used to load the sample data for the state of Ohio, and similar steps 
can be followed to load zip code data for other US states.

1. Click the Ohio Zip Code in Shapefile format and download the zt39_d00_shp.zip file to 
the NAVTEQ directory created in the previous procedure. 

2. Unzip the zt39_d00_shp.zip file to the NAVTEQ directory. 

3. Start the MapBuilder. This is installed when MapViewer is installed. 
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Refer to the MapViewer documentation for instructions on installing and 
running MapBuilder.

4. If a connection is not created, then select File > New Connection, and create a connection 
to the DWADM account in the Oracle Utilities Analytics Data Warehouse database. 

5. Point Tools > Import Shapefile, and click Next. 

6. Click Shapefile. 

7. Navigate to the C:\NAVTEQ directory, select the zt39_d00.shp file, and click Open. 

8. Click Next. 

Note: Ensure the name of the geometry table is set to ZT39_D00. If this is not 
the desired name for the spatial table, then the Select statement below will need 
to be changed to use the entered name.  

9. Ensure the Create Predefined Theme box is unchecked, and click Next. 

10. Review the summary information and click Finish. 

11. Create the Q1_USZIP54004 table using the following SQL statement. This assumes that the 
eLocation website is being used as the base map. If some other base map is used, then the 
transform parameter will need to specify the SRID of the base map being used.

sqlplus  dwadm/dwadm@database

create table q1_USZIP54004 as

select zcta ZCTA5CE,
       sdo_cs.transform(geometry, 54004) geom

From ZT39_D00;

INSERT INTO user_sdo_geom_metadata
VALUES ( 'Q1_USZIP54004','GEOM',
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)), 54004);

create index q1_USZIP54004_sdx 
    on q1_USZIP54004 (geom) 
    indextype is mdsys.spatial_index;

UPDATE q1_uszip54004
  SET geom = SDO_UTIL.RECTIFY_GEOMETRY(geom, .05);

Installing US County Spatial Data
Sample shape files for US Counties can be found at the following location:

 http://www.census.gov/

The following steps can be used to load the sample data for the state of Ohio, and similar steps 
can be followed to load county data for other US states.

1. Click on the Ohio County in the Shapefile format and download the co39_d00_shp.zip file 
to the NAVTEQ directory created in the previous procedure. 

2. Unzip the co39_d00_shp.zip file to the NAVTEQ directory. 

3. Start the MapBuilder. This is installed when MapViewer is installed.

Note: Refer to MapViewer documentation for instructions on installing and 
running MapBuilder.

4. If a connection is not created, then select File > New Connection, and create a connection 
to the DWADM account in the Oracle Utilities Analytics Data Warehouse database. 
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5. Select Tools > Import Shapefile, and click Next. 

6. Click Shapefile. 

7. Browse to the C:\NAVTEQ directory, select the co39_d00_shp.shp file, and click Open. 

8. Click Next. 

Note: Ensure the name of the geometry table is set to CO39_D00. If this is 
not the desired name for the spatial table, then the select statement below will 
need to be changed to use the entered name.

9. Ensure the Create Predefined Theme box is unchecked, and click Next. 

10. Review the summary information, and click Finish. 

11. Create the Q1_COUNTY54004 table using the following SQL statement. This assumes that 
the eLocation website is being used as the base map. If some other base map is used, then the 
transform parameter will need to specify the SRID of the base map being used.

sqlplus  dwadm/dwadm@database

create table q1_COUNTY54004 as
select name FEATURE_NAME,

       sdo_cs.transform(geometry, 54004) geometry,
       'OHIO' state

From CO39_D00;

INSERT INTO user_sdo_geom_metadata
VALUES ( 'Q1_COUNTY54004','GEOMETRY',
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)), 54004);

create index q1_COUNTY54004_sdx 
    on q1_county54004 (geometry) 
    indextype is mdsys.spatial_index;
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UPDATE q1_county54004
  SET geometry = SDO_UTIL.RECTIFY_GEOMETRY(geometry, .05);

Note: No predefined reports make use of the county data, so if county spatial 
reports are desired, the Q1_COUNTY_54004 theme will need to be used in 
new requests and maps.

Configuring Oracle Utilities Network Management System Device Spatial Data
To implement the Oracle Utilities Network Management System Network Model on the spatial 
analytics, Oracle Utilities Analytics reports need Oracle Utilities Network Management System 
geometry data. The steps from this section are required to view data in spatial reports of Oracle 
Utilities Outage Analytics. There are several ways that the geometry data in the 
DIAGRAM_OBJECTS NMS device table can be accessed by the Oracle Utilities Analytics 
Mapping reports. 

This section describes the following methods:

• Replicating the DIAGRAM_OBJECTS Table

• Accessing the Oracle Utilities Network Management System Spatial Data Using a 
Database Link

Replicating the DIAGRAM_OBJECTS Table
The easiest option is to replicate the DIAGRAM_OBJECTS table into the Oracle Utilities 
Analytics database. If this is done, then after replicating the DIAGRAM_OBJECTS table, the 
following steps will setup the Oracle Utilities Analytics dashboards to use the data in this 
replicated table.

1. Create the required spatial metadata:

INSERT INTO user_sdo_geom_metadata 
VALUES ( 'DIAGRAM_OBJECTS','LL_GEOMETRY',

MDSYS.SDO_DIM_ARRAY(
        SDO_DIM_ELEMENT('X', -20037508, 20037508, .05),
        SDO_DIM_ELEMENT('Y', -45884542, 45884542, .05)
), 54004);

2. Ensure that the spatial index is created on the LL_GEOMETRY column. The 
LL_GEOMETRY column by default stores spatial data using SRID 54004, so this will work 
without changes with the eLocation base map:

create index q1_DIAGRAM_OBJECTS_sdx 
    on diagram_objects (ll_geometry) 
    indextype is mdsys.spatial_index;

3. In MapBuilder, use duplicate to create a copy of the B1_THEME_DIAGRAMOBJ_54004 
geometry theme, with the following settings:

• New Name: Q1_THEME_DIAGRAMOBJ_54004

• Target Database: OUA Database

• Base Table: DIAGRAM_OBJECTS

• Spatial Column: LL_GEOMETRY

Once DIAGRAM_OBJECTS table is replicated to the Oracle Utilities Analytics database, follow 
the below steps to create Q1_DIAGRAM_OBJECTS_54004 table:

1. Connect to the DWADM schema of Oracle Utilities Analytics database and execute "create 
table Q1_DIAGRAM_OBJECTS_54004 as select * from DIAGRAM_OBJECTS;"
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2. INSERT INTO user_sdo_geom_metadata 
VALUES ( 'Q1_DIAGRAM_OBJECTS_54004','LL_GEOMETRY', 
MDSYS.SDO_DIM_ARRAY(SDO_DIM_ELEMENT('X', -20037508, 20037508, 
.05),SDO_DIM_ELEMENT('Y', -45884542, 45884542, .05)), 54004);

3. Create index q1_DIAGRAM_OBJECTS_sdx_54004 on Q1_DIAGRAM_OBJECTS_54004 
(ll_geometry) indextype is mdsys.spatial_index;

Accessing the Oracle Utilities Network Management System Spatial Data 
Using a Database Link

If it is not possible to replicate the DIAGRAM_OBJECTS table, and no existing Oracle Utilities 
Network Management System geometry theme can be used, then it is possible to access the 
DIAGRAM_OBJECTS table in the Oracle Utilities Analytics database using a database link. 

To access the DIAGRAM_OBJECTS table in the Oracle Utilities Analytics database using a 
database link:

1. Create a database link in the Oracle Utilities Analytics database pointing to the Oracle Utilities 
Network Management System database.

2. Create a synonym DIAGRAM_OBJECTS for the DIAGRAM_OBJECTS table in the Oracle 
Utilities Network Management System database.

3. Update the mapViewerConfig.xml to add another datasource, pointing to the Oracle 
Utilities Network Management System database, just like the Oracle Utilities Analytics 
datasource was added earlier in the install documentation.

4. Restart WebLogic to make the Oracle Utilities Network Management System database 
available.

5. Create the required spatial metadata in the Oracle Utilities Analytics database:

INSERT INTO user_sdo_geom_metadata 
VALUES ( 'DIAGRAM_OBJECTS','LL_GEOMETRY',

MDSYS.SDO_DIM_ARRAY(
   MDSYS.SDO_DIM_ELEMENT('LONGITUDE',-180,180,0.05),
   MDSYS.SDO_DIM_ELEMENT('LATITUDE',-90,90,0.05)
), 54004);

6. In MapBuilder, use duplicate to create a copy of the B1_THEME_DIAGRAMOBJ_54004 
geometry theme, with the following settings:

• New Name: Q1_THEME_DIAGRAMOBJ_54004

• Target Database: OUA Database

• Base Table: DIAGRAM_OBJECTS

• Spatial Column: LL_GEOMETRY

Loading Spatial Metadata
This section describes how to load spatial metadata in USER_SDO* tables for Oracle Utilities 
Advanced Spatial Operational Analytics. 

Use the following procedure to load spatial metadata in the target database.

1. Create the dump_dir directory in database and copy user_sdo.dmp file from ../B1250/
Spatial-Metadata folder to that location. 

2. Import released spatial tables to the target database using following command:

impdp directory=dump_dir dumpfile=user_sdo.dmp logfile=  
   impdp_user_sdo.log  schemas=DWADM

remap_tablespace=cists_01:<tablespace_name>
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Note: Run this command from database server:

Note: Make sure to change the tablespace_name to the tablespace name on 
which DWADM has the quota. If the DWADM tablespace has quota on 
cists_01 tablespace, then exclude whole remap_tablespace clause from the 
command.

3. Review the impdp_user_sdo.log file to ensure the tables were imported successfully.

4. After importing the tables, run following SQL scripts from the ../B1250/Spatial-Metadata 
folder:

 - sqlplus dwadm/<dwadm user password>@database-name 
@copy_spatial_metadata.sql

- sqlplus dwadm/<dwadm user password>@database-name 
@clean_sdo_release_tbls.sql

5. Review the log files.

Flushing Map Cache
Before you can begin using the modified base map, you must flush the map cache as follows:

1. In the MapViewer Console, click Admin in the top-right corner of the page and log into the 
Admin Console page.

2. Click Management, select Manage MapViewer, and then select Datasources.

3. Click Purge cached metadata.

4. To verify the map changes, go to the Map zone that references the modified base map.

5.  Delete the 'cacheduserinfo' files in the following path to remove any cache:

<OBIEE_INSTALL_DIR>\instances\instance2\bifoundation\OracleBIPresentationServi
cesComponent\coreapplication_obips1\catalog\SampleAppLite\root\users\weblogic2
\_prefs

Improving Performance by Prefetching Map Tiles 
Rendering map tiles dynamically can affect system performance. To avoid this, you should 
consider prefetching tiles by issuing an admin request to MapViewer on a non-production server 
or when the server is not under load. When MapViewer receives a prefetching request, it issues 
many concurrent map tile requests to itself, which are basically XML map requests, and stores 
them in the cache. This improves the system’s performance as the images are readily available.

Follow the following procedure to prefetch map tiles.

1. In the MapViewer console, click Admin in the top-right corner of the page and log into the 
Admin Console page.

2. In the Admin Console page, click Manage Map Tile Layers.

3. Click Manage to display the list of existing map tiles.

4. Select the required map tile and click View map/Manage Tiles.

The Prefetching wizard opens:
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5. Enter the X, Y coordinates of the center of the map, the SRID and zoom level, and click 
Show Map. 

To prefetch map images, enter the latitude and longitude values. You need to know the 
latitude and longitude values of the center of the location in interest. The SRID is a unique 
value used to identify the coordinate system used in a GIS application. The SRID used is 
8307. 

The X and Y axis used in the following example is for Canton, Ohio:

6. When you see the map, turn on the Area Selection tool and select the area on the map for 
which you want to prefetch the tiles.

7. Select one or more zoom-levels for which you want to prefetch the tiles.

8. Under Tile Operations, click on Prefetch Tiles.

This process will take some time, depending upon the hardware configuration of the system and 
the amount of data to be prefetched. To check the current status of the operation, click Refresh 
under the Operation Status. The status will change to “Finished” when the operation is done.
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Oracle Business Intelligence Enterprise Edition (OBIEE) Configu-
ration

This section contains information about configuring Oracle Business Intelligence Enterprise 
Edition (OBIEE) for use with Oracle Utilities Advance Spatial and Operational Analytics. 
Following topics are discussed: 

• Setting Up and Configuring User Security

• Managing Content in the Presentation Catalog

Setting Up and Configuring User Security
Note: Refer to the Configuring User Security section in Oracle Utilities 
Analytics for Oracle Utilities Extractors and Schema and Oracle Utilities Analytics 
Dashboards Administration Guide for details on configuring user security.

Managing Content in the Presentation Catalog
Oracle Utilities Analytics v2.5.0 Presentation Catalog has a different folder for each of the 
analytics.

The following folders are available on the Shared Folders:

• About

• Administration

• Common

• Credit & Collections Analytics

• Customer analytics

• Distribution Analytics

• Meter Data Analytics

• Mobile Workforce Analytics

• Outage Analytics

• Revenue Analytics

• Shared Objects

• Work & Asset Analytics

• Operational Device Analytics

Note: For more information on User Security and Managing Catalog objects, 
refer to Oracle Business Intelligence Presentation Services Administration Guide.

Managing Folders and Content 
New folders can be created you if new answers or modifications to existing ones are needed.

To create new folders (or Development Folders), log onto the Presentation Services as an 
Administrator and access:

Catalog -> New Folder

Once a new folder is created, set the following values:

• Properties

• Name 
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• Delete

• Permissions

• Copy/Move

You can save new answers onto the development folders, thereby leaving the out-of-box folders as 
is. Once the answer is created, the report is written and unit testing is complete, the request can be 
moved to the common folder.

Default folders are loaded during the install of Oracle Business Intelligence Enterprise Edition. 
These folders, such as 00 Overview, 01 Ranks & Toppers, or 02 History & Benching, can be 
removed from view by navigating to catalog, and then deleting the dashboards that you do not 
want displayed from the list.

Editing Names and Descriptions of Objects 
To edit names and descriptions of objects, log on to the Presentation Services as an 
administrator and access the following:

Catalog > Shared Folders
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Chapter 9 
Installing the Oracle Utilities Analytics Admin 

Tool

Oracle Utilities Analytics Admin tool is a Oracle Application Express (APEX) based 
configuration tool that can be used to configure Oracle Utilities Analytics.

This chapter describes how to install the Admin tool for the Oracle Data Integrator (ODI) 
configuration and change the default password of the Admin user.

• Installing Admin Tool

• Changing the Default Password of Admin User

Installing Admin Tool
Perform the steps below to install Apex run time and deploy the Admin tool for Oracle Data 
Integrator configuration: 

1. Download apex_4.2.1.zip file from: 
http://www.oracle.com/technology/products/database/application_express/
download.html

2. Unzip apex_4.2.1.zip to the directory <APEX_UNZIPPEDPATH> and copy to the 
database server.

3. Change the directory to <APEX_UNZIPPEDPATH>/apex after unzipping apex_4.2.1.zip 
file.

4. Logon using sqlplus as sys user and run the SQL file apxrtins.sql with the parameters as 
shown below:

@apxrtins <Tablespace Name for apex> <Tablespace Name for apex> 
<Temporary tablespace name> /i/

5. Change the password of admin account by running the following SQL command: 

@apxchpwd

6. Restart the database.

7. Configure the embedded PL/SQL gateway - logon as sys user and run. 

@apex_epg_config  <APEX_UNZIPPEDPATH>

8. Unlock the anonymous account: 

ALTER USER ANONYMOUS ACCOUNT UNLOCK;
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9. Start the XML DB run:

EXEC DBMS_XDB.SETHTTPPORT(<not in use port>);

e.g EXEC DBMS_XDB.SETHTTPPORT(8080);

10. Verify using: 

SELECT DBMS_XDB.GETHTTPPORT FROM DUAL;

11. Import the Admin tool for Oracle Data Integrator configuration:

• Oracle Utilities Analytics V2.5.0 ETL Component Based on ODI Multiplatform.zip file 
has a folder called AdminTool.

• Unzip this file and copy the AdminTool directory contents.

• Create the ../AdminTool directory on the database server and copy the contents of the 
AdminTool directory (from the zip file) to this directory.

• Go to the ../AdminTool directory, i.e., cd ../AdminTool

• Connect as system user and execute the following scripts:

• Create workspace and configure users: 

• @CreateAppWorkspace.sql

• Import application: 

• @DeployAdminApp.sql

• Deploy supporting objects:

• @DeploySupportingObjects.sql

12. The Admin tool for Oracle Data Integrator configuration can be accessed using the URL 
http://<hostname>:8080/apex/f?p=104

The username to access the Admin tool is Admin. The default password is 
Admin_123. 

Note: For a complete description of the Admin tool, refer to Oracle Utilities 
Analytics for Oracle Utilities Extractors and Schema and Oracle Utilities Analytics 
Dashboards Administration Guide.

Changing the Default Password of Admin User
The following APEX API can be used to change the password of admin user. This script should 
be run after connecting to the database as user SYSTEM.

The string 'New password' should be replaced with the new password for admin account before 
running the script. 

begin
  

wwv_flow_api.set_security_group_id(p_security_group_id=>nvl(wwv_flow_a
pplication_install.get_workspace_id,2090606133849294));

end;
/

begin
apex_util.edit_user(
p_user_id      => '2090514487849294',
p_user_name => 'ADMIN',
p_web_password => 'New password',
p_new_password => 'New password'
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);
end;
/

commit;
/

Important Note: It is strongly recommended that you should the default 
password after logging in.
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Appendix A
Data Warehouse Implementation Guidelines

This chapter provides guidelines for implementing the data warehouse setup for Oracle Utilities 
Analytics. 

The following sections are discussed in detail:

• Init.ora Settings

• Oracle Partitioning

Init.ora Settings
Internal performance testing for a large Business Intelligence (BI) database installation has 
identified the following parameter settings that resulted in a fast load and materialized view refresh 
for a fact table with over 100,000,000 records.

Note: The settings mentioned in the below table were noticed for an Oracle 
10.2 database running on an IBM AIX 5.2 machine with 8 CPUs and 15 GB of 
memory; hence, some of these values may not apply for different hardware or 
software settings.

Parameter Value

db_file_multiblock_read_count 32

db_cache_size 0M

shared_pool_size 0M

large_pool_size 0M

Java_pool_size 0M

parallel_max_servers 8

parallel_execution_message_size 65535

log_buffer 64554432

Pga_aggregate_target 2000M

query_rewrite_enabled FORCE

query_rewrite_integrity TRUSTED

session_cached_cursors 60
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Oracle Partitioning
As the primary keys for all tables are sequential, it is possible to partition any table based on the 
primary key field. However, the fact tables should be partitioned based on one of the Date Keys 
present in the table. Some of the date keys are optional; hence, it is important to pick a date key 
field that will always have a non-zero value.

Note: As the Recent fact table needs to be purged daily, it does not require to 
be partitioned. Also, partitioning should be done only when materialized views 
do not prove sufficient enough to achieve the desired performance. 

For details on partitioning, refer to Oracle Utilities Analytics for Oracle Utilities Extractors and Schema 
and Oracle Utilities Analytics Dashboards Administration Guide.

optimizer_index_caching 80

optimizer_index_cost_adj 30

Sga_max_size 4000M

Sga_target 2000M

shared_pool_reserved_size 64M

workarea_size_policy AUTO

db_writer_processes 8

timed_statistics False

cursor_space_for_time True

Disk_asynch_io True

Parameter Value
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Appendix B
Installation Menu Functionality

This chapter provides functionality details regarding installation menu for installing the Oracle 
Utilities Analytics application. 

The following sections are discussed here:

• Installation Menu Functionality Overview

• Installation Menu Functionality Details

Installation Menu Functionality Overview
The main configuration menu is structured so that the related variables and/or options are 
grouped together and are associated by a menu item number. To access a particular group of 
variables and options, enter the menu item number associated with that group. Each option within 
a group is displayed in turn on the screen along with a prompt so that you can type the desired 
value for the option, if it is not the same as the default or current value.

When performing the initial installation, you need to go through all menu options. The menu 
options may have a default value, a list of the valid values, and a validation check.

On each option prompt, you can keep the current value by simply leaving the input line empty. In 
order to erase a variable value, enter a single dot ("."). The leading spaces are trimmed out on each 
values that are entered.

Note: While working with the menu, you will notice the following:

• Valid Values [ALFANUM]: This indicates you will need to enter an alphanumeric value in 
the prompt.

• Valid Values [NUM]: This indicates you will need to enter an numeric value in the prompt.

When all the menu options are set, type <P> at the main menu prompt option. The option values 
selected throughout the configuration are saved. 

During this processing, the global variables are validated and the configuration file 
<SPLEBASE>/etc/ENVIRON.INI is created or updated. This file contains all the variables 
entered and calculated. These are required by the next part of the installation process.

To exit the configuration utility without saving any of the values entered, type <X> and click 
Enter. 
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Installation Menu Functionality Details
The Environment Installation Utility requires that Oracle Client Home is set in the path for the 
user performing the installation. Prior to running the installation utility, you must review the 
supported platforms document to ensure that you have all the required third-party software 
installed at your end. In the Installation menu if the variables are set prior to execution, then these 
variable values will be defaulted by the installation utility during installation.

When installation completes successfully, the values will be written to an ENVIRON.INI file. 
When splenviron.sh / cmd is executed, it reads from the ENVIRON.INI file to set the 
environment variables.

In the worksheets, there are three different types of values given:

• Default Values: Values, which can be defaulted while running the installation utility.

• Security Values: Values, which should be changed when in production.

• Example Values: Values, which can be used for a default installation.

Note: The production environment should not be run with default values.

Refer to Server Administration Guide for additional information about configuring these values.

When you enter passwords, you cannot see password characters on the screen as they are entered 
in the silent mode. The passwords are encrypted when the values are entered by a user.

Install the Oracle client software specified in the Chapter 3: System Requirements and 
Supported Platforms prior to running any installation utilities. 

The following prompt appears when executing the installation utility:

Enter Oracle Client Home Directory (<ENTER> quit):

Note: If the environmental variable ORACLE_CLIENT_HOME is set, then 
the install script validates the variable. If it passes the validation, you will not be 
prompted for it. This is needed in order to run Perl installation utilities.
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Appendix C
Installation and Configuration Worksheets

This chapter provides the installation and configuration worksheets for Oracle Utilities Analytics. 

Following topics are discussed: 

• Configuration Worksheet for ETL Component based on Oracle Warehouse Builder 
Installation

• Configuration Worksheet for ELT Component based on Oracle Data Integrator 
Installation

• Configuration Worksheet for Dashboard Component Installation

Configuration Worksheet for ETL Component based on Oracle 
Warehouse Builder Installation

Environment installation options are as shown in the section below:

• Environment Installation Options

• Environment Configuration Options

Environment Installation Options

Menu Option Name Used In 
Documentation Usage

Customer 
Install 
Value

Oracle Client 
Home Directory

ORACLE_CLIENT_H 
OME

The home directory of the 
Oracle client. The 
application uses the Perl 
included under this Oracle 
client.

Example Location:
/oracle/client/product/
11.2.0.3
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Environment 
Mount Point

<SPLDIR> The mount point into 
which the application is 
installed. 
The local directory where 
the components are to be 
installed.

For example:
/OUA for UNIX and 
C:\OUA for Windows 

This mount point must 
exist and the 
Administrator User ID 
must be able to write to 
this directory. (This is the 
user ID, created 
specifically to administer 
the environments; the 
installation sets 
permissions on all 
subdirectories installed 
under this directory).

See <SPLENVIRON> 
below for more 
information on how this 
mount point is used.

Log File Mount 
Point

<SPLDIROUT> A mount point that 
contains any application 
output or application logs. 

For example, the value is /
OUA/sploutput for 
UNIX installation or 
C:\OUA\sploutput for 
Windows

Environment 
Name

<SPLENVIRON> A descriptive name to be 
used as both a directory 
name under the mount 
point
<SPLDIR> and an 
environment descriptor. 
This value typically 
identifies the purpose of 
the environment. 

For example, DEV01 or 
CONV

Menu Option Name Used In 
Documentation Usage

Customer 
Install 
Value
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Environment Configuration Options
Following topics are discussed in this section: 

• Environment Description

• Database Configuration

• Design Repository Configuration

• EMAIL Configuration

• Control Center Configuration

• External Data Source Configuration

Environment Description
 

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Environment 
Description

DESC This is the text field 
to describe the 
purpose of the 
environment.

Database Configuration

Web Java Home 
Directory

JAVA_HOME The location on the disk 
where Java 1.6 is installed. 

For example,
$ORACLE_BI_HOME/
jdk

Menu Option Name Used In 
Documentation Usage

Customer 
Install 
Value

Menu Option Name Used In 
Documentation Usage Customer 

Install Value

OWB WorkSpace 
Owner

OWB_WS_OWNER Oracle Warehouse Builder 
workspace owner created 
in the section Creating 
and Configuring Oracle 
Warehouse Builder 
Workspace for an Initial 
Installation.

BIREPOWN
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Design Repository Configuration

OWB WorkSpace 
Owner Password

OWB_WS_OWNER_
PASS

Oracle Warehouse Builder 
workspace owner 
password created in the 
section Creating and 
Configuring Oracle 
Warehouse Builder 
Workspace for an Initial 
Installation.

The password to login to 
Oracle warehouse Builder 
design center.

This is a security value.

BIREPOWN 
user password

Database Name OBIEE_DBNAME The name of the database 
instance that the 
application is connecting 
to.

BI Database 
Name

Database Server OBIEE_DBSERVER The host name of the 
server where database 
resides.

BI Database 
Server

Database Port OBIEE_DBPORT The database port number 
on the database server 
used for connecting to the 
database.

BI Database 
PORT

Menu Option Name Used In 
Documentation Usage Customer 

Install Value

Menu Option Name Used In 
Documentation Usage Customer 

Install Value

OWB WorkSpace 
User

OWB_WS_USER Oracle Warehouse Builder 
workspace user created in the 
section Creating and 
Configuring Oracle 
Warehouse Builder 
Workspace for an Initial 
Installation.

The User to login to Oracle 
Warehouse Builder design 
control center.

BIREPO
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Database Character Set Configuration

Menu Option Name Used In 
Documentation Usage Customer 

Install Value

Database Character set DBCS The database character 
set to used to create the 
database.

AL32UTF8

OWB Workspace 
user Password

OWB_WS_PASS Oracle Warehouse Builder 
workspace User Password 
created in the section 
Creating and Configuring 
Oracle Warehouse Builder 
Workspace for an Initial 
Installation.

The password to login to 
Oracle Warehouse Builder 
design control center.

This is a security value.

BIREPO user 
password

OWB WorkSpace 
Name

OWB_WS_NAM
E

The name of the workspace 
created using the Repository 
Assistant.

SPLBIREP

DWADM 
SCHEMA NAME

DWADM_SCHE
MA

The user ID to register OWB 
locations.

DWADM

DWADM 
SCHEMA 
Password

DWADM_PASS The password to register 
OWB locations.

DWADM user 
password

WORKFLOW 
MANAGER 
SCHEMA NAME

OWFMGR_SCHE
MA

The user ID to register OWB 
locations.

OWFMGR

WORKFLOW 
MANAGER 
SCHEMA 
Password

OWFMGR_PASS The password to register 
OWB locations.

OWFMGR 
user password

Menu Option Name Used In 
Documentation Usage Customer 

Install Value
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Editing Process Flow Configuration

Menu Option Name Used In 
Documentation Usage

Customer 
Install 
Value

Repository Operating 
System

REPOPSYS The database operating 
system. 

For example, Win or 
Linux (any other 
platform)

The valid values are as 
listed: 
Win: windows
Linux: for any non 
windows platforms

Perl Compiler location PERLCMD The Perl compiler set in 
the database. 

For example:
/usr/bin/perl

<ORACLE
_HOME>
/perl/bin/
perl

Data and control files 
location

CTLFOLDER The data and the control 
file extracts location, 
where flat files placed to 
pickup by the file 
processor.

For example: user 
location

Separator to be used FILESEP The separator to be used 
for Oracle Warehouse 
Builder deployment, 
where database resides.

For example: Win '\\' 
and for Linux '/

For Unix: 
Use ‘ /’

For 
Windows: 
Use ‘\\’

File Manager location FILEMGR The File Manager 
location on the database 
server. Copy the 
splfilemanager.plx file 
from BI250/Scripts 
directory to this 
location.
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EMAIL Configuration

Menu Option Name Used In 
Documentation Usage Customer 

Install Value

Email ID of Sender EMAILIDSEN The Email ID of the 
sender to be configured in 
Oracle Warehouse Builder 
while in deployment

For example: 
OWB@oracle.com

Email ID for Reply-
To address

EMAILIDRPL The Email ID of the 
Reply TO to be 
configured in Oracle 
Warehouse Builder while 
in deployment.

Email ID of 
Receiver

EMAILIDREC The Email ID of the 
Receiver to be configured 
in Oracle Warehouse 
Builder while in 
deployment.

SMTP server SMTPSRV The host name of the 
server where SMTP 
Service configured.

SMTP server port SMTPPORT The port number on the 
server where SMTP 
Service configured.

Control Center Configuration

Menu Option Name Used In 
Documentation Usage Customer 

Install Value

Repository 
Control Center 
Name

CCNAME The Oracle Warehouse 
Builder Repository Control 
Center to be created or used 
to deploy the Oracle 
Warehouse Builder objects.

External Data Source Configuration

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Path of the External 
Datasource

EXTERNAMEDS The path of the 
extracts location.

Must be the same as 
the value of 'Data 
and control files 
location'.
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Configuration Worksheet for ELT Component based on Oracle 
Data Integrator Installation

Environment installation options are as shown in the section below:

• Environment Installation Options

• Environment Configuration Options

Environment Installation Options

Path of the External 
Datasource LOG

EXTERNAMEDS_
LOG

The path of the 
extracts log location.

Must be same as the 
value of 'Data and 
control files 
location'.

File Processor 
Daemon Execution 
Switch

FPDEXECUTION
_SWITH

The file processor 
execution switch.

1

File Processor 
Extract Max Load

FPDEXTRACT_M
AXLOAD

The file processor 
to pick up the 
extractor to load.

5

File Processor 
Scheduler Poll 
Duration

SCHEDULER_PO
LL_DURATION

The file processor 
scheduler poll 
duration.

60

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Menu Option Name Used in 
Documentation Usage Customer 

Install Value

Oracle Client 
Home Directory

ORACLE_CLIEN
T_HOME

The home directory of the 
Oracle client. The application 
uses the Perl included under 
this Oracle client. The user 
used to install the Oracle client 
should be used to install ELT 
component based on Oracle 
Data Integrator.
Example Location: 
/oracle/client/product/
11.2.0.3
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Environment Configuration Options
Following options are discussed in this section: 

• Environment Description

• Oracle Data Integrator Environment Configuration

• Oracle Data Integrator Agent Configuration

• Target GoldenGate Configuration

Environment 
Mount Point

<SPLDIR> The mount point into which 
the application is installed.
The Local directory where 
components to be installed.
For example:/OUA for UNIX 
and C:\OUA for Windows
This mount point must exist 
and the administrator user ID 
must be able to write to this 
directory. (This is the user ID, 
created specifically to 
administer the environments; 
the installation sets 
permissions on all 
subdirectories installed under 
this directory.
See <SPLENVIRON> below 
for more information on how 
this mount point is used.

Log Files Mount 
Point

<SPLDIROUT> A mount point that contains 
any application output or 
application logs.
For example, the value is / 
OUA/sploutput for the UNIX 
installation, or 
C:\OUA\sploutput for the 
Windows

Environment 
Name

<SPLENVIRON> A descriptive name to be used 
as both a directory name under 
the mount point.
<SPLDIR> and an 
environment descriptor. This 
value typically identifies the 
purpose of the environment. 
For example, DEV01 or 
CONV

Web Java Home
Directory

JAVA_HOME The location on the disk where 
Java 1.6 is installed.
For example: 
$ORACLE_BI_HOME/jdk

Menu Option Name Used in 
Documentation Usage Customer 

Install Value
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• Source GoldenGate Configuration

Environment Description
Environment description details are as shown in the table below:

Menu 
Option 

Name Used in 
Documentation

Usage  Customer 
Install Value

Environment 
Description

DESC This is a free form text field to 
describe the purpose of the 
environment.

Oracle Data Integrator Environment Configuration
Oracle Data Integrator environment configuration description details are as shown in the table 
below:

Menu Option Name Used in 
Documentation

Usage  Customer 
Install Value

WEBLOGIC 
HOME

WLS_HOME The directory where 
WebLogic to be used for 
Oracle Data Integrator 
has been installed.
For example: 
/WLS_HOME/ 
wlserver_10.3

ODI HOME ODI_HOME The directory where 
Oracle Data Integrator 
(ODI) has been installed.

ODI 
SUPERVISOR  
USER

ODI_SUP_USER For example:  
/WLS_HOME/
Oracle_DI1

SUPERVISOR

 ODI 
SUPERVISOR 
Password

                 
ODI_SUP_PASS
WORD

Oracle Data Integrator 
Supervisor password.

SUPERVISOR 
user password

Target Database 
Name

OBIEE_DBNAM
E

The name of the database 
instance from which the 
application connects to. 

Target Database 
Host

OBIEE_DBSERV
ER

The host name of the 
server where the database 
resides.

Target Database 
Port

OBIEE_DBPOR
T

The database port number 
on the database server 
used for connecting to the 
database.

DWADM Schema 
Name

DWADM_SCHE
MA

The Target Schema User 
for the facts and the 
dimensions present.

DWADM
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Oracle Data Integrator Agent Configuration

DWADM Schema 
Password

DWADM_PASS The password for 
DWADM.

DWADM user 
password

ODI Master 
Schema Name

ODI_MASTER 
_SCHEMA

The Oracle Data 
Integrator Master Schema 
user where the Oracle 
Data Integrator master 
repository is created. 

MASTER_REP
O

ODI Master 
Schema Password

ODI_MASTER_ 
SCHEMA_PASS

The Oracle Data 
Integrator Master Schema 
user password. 

MASTER_REP
O user password

ODI Work Schema 
Name

ODI_WORK 
_SCHEMA

The Oracle Data 
Integrator Work Schema 
User where the Oracle 
Data Integrator Work 
Repository is get created.
The default WORK 
REPO is OBIU.

WORK_REPO

ODI Work Schema 
Password

ODI_WORK_ 
SCHEMA_PASS

Oracle Data Integrator 
Work Schema User 
Password. 

WORK_REPO 
user password

ODI Master 
Repository ID

ODI_MASTER_R
EPO_ID

Oracle Data Integrator 
Master Repository ID.
The default value is 601.

ODI Work 
Repository ID

ODI_WORK_RE
PO_ID

Oracle Data Integrator 
Work Repository ID 
The default value is 602.

MDADM Schema 
Name

MDADM_SCHE
MA

The metadata user MDADM

MDADM Schema 
Password

MDADM_Pass The password for 
MDADM.

MDADM user 
password

Menu Option Name Used in 
Documentation

Usage  Customer 
Install Value

Menu 
Option 

Name Used in 
Documentation

Usage  Customer 
Install Value

ODI 
WebLogic   
Agent Host

ODI_AGENT_HOST The host on which 
Oracle Data Integrator 
WebLogic Domain is 
created.

Database host 
name
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Target GoldenGate Configuration

ODI 
WebLogic 
Agent port

ODI_AGENT_PORT The port on which 
Oracle Data Integrator 
WebLogic agent is 
configured to run. This 
is the port of Oracle 
Data Integrator 
WebLogic Managed 
Server Port. 

Provide available 
port and make 
sure to use the 
same port while 
creating Oracle 
Data Integrator 
managed server.

Menu 
Option 

Name Used in 
Documentation

Usage  Customer 
Install Value

Menu Option Name Used in 
Documentation

Usage  Customer Install 
Value

Target 
GoldenGate 
Manager Port

TRG_GG_MGR_PORT The port number 
on which Oracle 
GoldenGate 
Manager is 
running on the 
target database 
server.

Target 
GoldenGate 
Dynamic 
Minimum Port

TRG_GG_DYN_PORT_M
IN

This is the 
dynamic minimum 
port configured in 
Oracle 
GoldenGate on 
the target database 
server.

Provide the start 
range value set for 
the target 
GoldenGate 
manager process.

Target 
GoldenGate 
Dynamic 
Maximum 
Port.

TRG_GG_DYN_PORT_M
AX

This is the 
dynamic maximum 
port configured in 
Oracle 
GoldenGate on 
the target database 
server.

Provide the end 
range value set for 
the target 
GoldenGate 
manager process.

Target 
GoldenGate 
Algorithm

TRG_GG_ALGORITHM This is the 
algorithm 
configured in 
Oracle 
GoldenGate on 
the target database 
server. The default 
value is 1. 
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Target 
GoldenGate 
Encryptkey

TRG_GG_ENCRYPTKEY This is the Encrypt 
Key configured in 
Oracle 
GoldenGate on 
the target database 
server. The default 
value is 
“DEFAULT”.

Target 
GoldenGate 
Shared Secret

TRG_GG_ 
SHARED_SECRET

This is shared 
secret key 
configured in 
Oracle 
GoldenGate on 
the target database 
server. The default 
value is 
"DEFAULT”.

Go to the 
GoldenGate prompt 
and run the 
command: encrypt 
password <password 
of MDADM user>, 
encryptkey 
DEFAULT 
Provide the result of 
above command to 
this menu item.

Target 
Database 
Home

TRG_DB_HOME This is database 
home is installed 
location on the 
target database 
server.
For example: 
/u00/oracle/app/
oracle/product/
11.2.0/dbhome_1 

Target 
GoldenGate 
Home

TRG_GG_HOME This is the 
GoldenGate 
installed location 
on the target 
database server.
For example:  
opt/local/
ggs_11.2.1.0.5_2

Menu Option Name Used in 
Documentation

Usage  Customer Install 
Value
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Source GoldenGate Configuration

Menu Option Name Used in 
Documentation

Usage  Customer Install 
Value

Source 
Instance 
Name

SRC_INST_NAME The source from 
which data has to 
be extracted.

The valid values 
are 
ODM1,ODM2...O
DM9 for Oracle 
Utilities 
Operational 
Device 
Management 
application and 
CCB1,CCB2...CC
B9 for Oracle 
Utilities Customer 
Care and Billing 
source application. 
Provide the same 
value that is passed 
to -c option while 
running 
configureSourcedb 
script.

Source 
GoldenGate 
Manager Port

SRC_GG_MGR_PORT The port number 
on which Oracle 
GoldenGate 
Manager is 
running on the 
source database 
server.

Source 
GoldenGate 
Dynamic 
Minimum Port

SRC_GG_DYN_PORT_M
IN

This is the 
dynamic minimum 
port configured in 
Oracle 
GoldenGate on 
the source 
database server.

Provide the start 
range value set for 
the source 
GoldenGate 
manager process.

Source 
GoldenGate 
Dynamic 
Maximum 
Port.

SRC_GG_DYN_MAX_PO
RT

This is the 
dynamic maximum 
port configured in 
Oracle 
GoldenGate on 
the source 
database server.

Provide the end 
range value set for 
the source 
GoldenGate 
manager process.
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Source 
GoldenGate 
Algorithm

SRC_GG_ALGORITHM This is the 
algorithm 
configured in 
Oracle 
GoldenGate on 
source database 
server. The default 
value is 1. 

Source 
GoldenGate 
Encryptkey

SRC_GG_ENCRYPTKEY This is the Encrypt 
Key configured in 
Oracle 
GoldenGate on 
the source 
database server. 
The default value 
is “DEFAULT”.

Source 
GoldenGate 
Shared Secret

SRC_GG_ 
SHARED_SECRET

This is shared 
secret key 
configured in 
Oracle 
GoldenGate on 
the source 
database server. 
The default value 
is “DEFAULT”.

Go to the 
GoldenGate 
prompt and run 
the command: 
encrypt password 
<password of 
source golden gate 
owner user>, 
encryptkey 
DEFAULT 
Provide the result 
of above 
command to this 
menu item.

Source 
Database 
Name

SRC_DB_NAME This is the source 
database name, 
where Oracle Data 
Integrator 
connects to reverse 
engineer the 
source tables.

Source 
Database Host

SRC_DB_HOST This is source 
database server 
host.

Source 
Database Port

SRC_DB_PORT This is source 
database port.

Source 
Database 
Home

SRC_GG_DB_HOME This is the source 
database home 
installed location.

Source 
GoldenGate 
Home

SRC_GG_HOME This is the Oracle 
GoldenGate 
installed location.

Menu Option Name Used in 
Documentation

Usage  Customer Install 
Value
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Configuration Worksheet for Dashboard Component Installation
Following topics are included here: 

• Oracle Business Intelligence Enterprise Edition Environment Configuration 
Options

• Oracle Business Intelligence Enterprise Edition Environment Configuration 
Options

• Target Database Details

Environment Installation Options

Menu Option Name Used In 
Documentation Usage

Customer 
Install 
Value

Oracle Client 
Home 
Directory

ORACLE_CLIENT_H 
OME

The home directory of the 
Oracle client. The application 
uses the Perl included under this 
Oracle client.

Example location:
<ORACLE_BI_HOME>/
Oracle_BI1

Environment 
Mount Point

<SPLDIR> The mount point into which the 
application is installed. 

For example:
/OUA for UNIX and C:\OUA 
for Windows 

This mount point must exist 
and the administrator user ID 
must be able to write to this 
directory. (This is the user ID, 
created specifically to administer 
the environments; the 
installation sets permissions on 
all subdirectories installed under 
this directory).

See <SPLENVIRON> below 
for more information on how 
this mount point is used.

Log File 
Mount Point

<SPLDIROUT> A mount point contains any 
application output or 
application logs. 

For example, the value is /
OUA/sploutput for UNIX 
installation or 
C:\OUA\sploutput for 
Windows
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Oracle Business Intelligence Enterprise Edition Environment Configuration 
Options 

Environment 
Name

<SPLENVIRON> A descriptive name to be used 
as both a directory name under 
the mount point <SPLDIR> 
and an environment descriptor. 
This value typically identifies the 
purpose of the environment. 

For example, DEV01 or CONV

Web Java 
Home 
Directory

JAVA_HOME The location on the disk where 
Java 1.6 is installed. 

For example:
$ORACLE_BI_HOME/jdk

Menu Option Name Used In 
Documentation Usage

Customer 
Install 
Value

Menu Option Name Used In 
Documentation Usage

Custome
r Install 
Value

Oracle BI 
Instance Home

ORACLE_INSTANCE The location on the disk 
where Oracle Business 
Intelligence Enterprise 
Edition software is installed 
instance home.

Example location for Oracle 
Database:
/orasw/Middleware/
instances/instance1

Oracle BI Home ORACLE_BI_HOME The location on the disk 
where Oracle Business 
Intelligence Enterprise 
Edition software is installed 
Oracle_BI Home.

Example location for Oracle 
Database:
/orasw/Middleware/ 
Oracle_BI1
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Target Database Details
Target database details are as listed in the below table: 

Oracle BI 
Domain Home

DOMAIN_HOME The location on the disk 
where Oracle Business 
Intelligence Enterprise 
Edition software is installed 
Oracle_BI home.

Example location for Oracle 
Domain home:
/orasw/Middleware/ 
user_projects/domains/ 
bifoundation_domain

WebLogic 
Domain Console 
User Name

WLS_EM_USER WebLogic domain login user 
name.

You will be prompted for the 
password after installation.

WebLogic 
Domain Console 
Host

WLS_EM_HOST The host name on which the 
web application server resides.

Default value: <current server 
name>

WebLogic 
Domain Console 
Port Number

WLS_EM_PORT A unique port number within 
the system that is assigned to 
the HTTP port. This is the 
port number that is used as a 
part of the client URL request 
to connect to the host.
This is Oracle Business 
Intelligence Enterprise 
Edition WebLogic console 
admin port number.

Example value: 7001

Menu Option Name Used In 
Documentation Usage

Custome
r Install 
Value

Menu Option Name Used In 
Documentation Usage

Customer 
Install 
Value

Target Database Name OBIEE_DBNAME The name of the target 
database

Target Database Host OBIEE_DBSERVER The host on which 
database is created.
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Target Database Port OBIEE_DBPORT This is the target 
database port.

DWADM Schema 
Name

DWADM_SCHEMA The schema name of 
the star schema.

DWADM

DWADM Schema 
Password

DWADM_PASS The password for 
DWADM

DWADM 
user 
password

Menu Option Name Used In 
Documentation Usage

Customer 
Install 
Value
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Appendix D
Additional Resources

Contacting Oracle Support
To contact Oracle support, visit the Oracle Support website at:

http://www.oracle.com/support/index.html



Appendix E
License and Copyright Notices

This chapter describes about licensing and optional features, including:

• Oracle Warehouse Builder Licensing and Optional Features

• Oracle Warehouse Builder Licensing and Optional Features

• Disabling the Optional Features in Oracle Warehouse Builder

• Oracle GoldenGate Licensing

Oracle Database Licensing and Optional Features
With Oracle Utilities Analytics release 2.5.0, the Standard Edition of Oracle database is now 
supported. Currently, this support is only for the customers using those Extractors and Schema 
products, which are based on Oracle Data Integrator (ODI) based extraction, and includes:

• Oracle Utilities Operational Device Management Extractors and Schema

• Oracle Utilities Customer Care and Billing Extractors and Schema

However, Oracle recommends to use the Enterprise Edition of Oracle database for 
performance and scalability reasons, as the Oracle Utilities Analytics data warehouse is expected to 
handle large volumes of data. Oracle Utilities Analytics also supports the Oracle Partitioning 
feature, which is an extra cost option on the top of the Oracle Database Enterprise Edition. Using 
this feature, it is also recommended for the efficient data storage and retrieval by the Oracle 
Utilities Analytics product.

By default, the Enterprise Edition and the Partitioning features are turned off in the Oracle 
Utilities Analytics product. Once the appropriate licenses have been purchased, these features can 
be turned on in the Global Configuration settings using the Oracle Utilities Analytics 
Administration tool described in the Appendix B of Oracle Utilities Analytics for Oracle Utilities 
Extractors and Schema and Oracle Utilities Analytics Dashboards Administration Guide.

Oracle Warehouse Builder Licensing and Optional Features
Oracle Warehouse Builder (OWB) provides various optional features, which are not included in 
the basic Extraction, Transformation, and Loading (ETL) feature group. The basic ETL feature 
group is included in the Oracle Database Enterprise Edition license. Hence, there is no additional 
license cost required to use, or install the basic features. The standard ETL processes included in 
Oracle Utilities Analytics (OUA) uses only the features that are included in the basic ETL feature 
group.

In addition, the Oracle Warehouse Builder Code Generator does not create any code that requires 
the use of optional Oracle Warehouse Builder features. Hence, any additional Extraction, 
Transformation, and Loading (ETL) code created by an implementation using the Oracle 
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Warehouse Builder Code Generator does not require any additional Oracle Warehouse Builder 
license costs. However, if Oracle Warehouse Builder is used to create other ETL code outside of 
the Oracle Warehouse Builder Code Generator, then using some of these optional features may 
require additional Oracle Warehouse Builder licenses. 

Disabling the Optional Features in Oracle Warehouse Builder
In order to ensure that optional features are not used, Oracle Warehouse Builder (OWB) provides 
a means to disable the use of optional features. After starting the Warehouse Builder Repository 
Assistant, choose the “Manage optional features” operation, as shown in the following image.

After entering the password for the OWBSYS user, deselect all of the licensed option names on 
the Enable Optional Features page.
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Once the options are deselected, the new selections will take effect for any new connections to 
Oracle Warehouse Builder, and if options are used that are not available, an error dialog is 
displayed. 

Note: For further details regarding the feature groups and licensing of Oracle 
Warehouse Builder, visit the Oracle Warehouse Builder page on the Oracle 
Technology Network (OTN) at this location: 

http://www.oracle.com/technetwork/developer-tools/warehouse

Oracle GoldenGate Licensing
The GoldenGate license purchased along with Oracle Utilities Analytics 2.5.0, can be used to 
replicate additional tables from the any of the source systems products whose ELT processes are 
based on Oracle Data Integrator (ODI), which includes:

• Oracle Utilities Operational Device Management

• Oracle Utilities Customer Care and Billing

For any other usage of the Oracle Golden Gate product, you need to purchase a full license of the 
Oracle GoldenGate product. Please contact Oracle Support for the details.
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